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C H A P T E R  1
Cisco Unified Communications System Test

• Cisco Unified Communications System Test, page 1

• Cisco Unified Communications System Test for Japan, page 2

• Acronyms, page 3

Cisco Unified Communications System Test
Cisco Unified Communications System Test, an integral part of the Enterprise Voice Solution Management
is a program that validates and tests specified systems-level solution for the various products and platforms
in the Cisco Unified Communications System.

Cisco Unified Communications System Test, the systems integration layer, ensures that the Unified
Communications components delivered across the various engineering teams when combined, improves the
Unified Communications System software quality. This is achieved by testing the various components.

The requirements for Cisco Unified Communications System Test is derived based on the following:

• Popular customer scenarios

• Input from various Business Units, fields and Cisco Services

The test bed architecture is built based on the Solution Reference Network Design (SRND), cross-section of
product deployment models etc. The different types of testing carried out as part of Cisco Unified
Communications System Test are:

• Interoperability/Compatibility

• Functionality

• Availability/Reliability/Stability

• Performance/Scalability/Capacity

• Usability/Serviceability

• Special focus area - CAP (Customer Assurance Program)/Technical Assistance Center (TAC)

• Security
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Cisco Unified Communications System Test for Japan
Cisco Unified Communications System Test for Japan, in turn is an add-on testing at the solution level, where
the requirements gathered are specific to Japanese usage and market. The requirements are derived based on
the following:

• Customer found defects in selected UC products

• High priority cases that are covered by the Cisco Unified Communications System Test team

• Inputs from SEs, TAC team of Cisco Japan

The test execution is carried out on selected UC products, which affect the Japanese segment and that are
prioritized by SEs of the Cisco Japan team. Japanese specific equivalents, such as Japanese locale, ISDN
Switch type being NTT, JPNP for Numbering Plan are implemented.

The objective of Cisco Unified Communications System Test for Japan is to run a sub-set of system testing
that is not covered by Cisco Unified Communications System Test and implement equivalents with Japanese
environment such as Japanese OS, localized application, select Cisco Compatible Products, and third party
equipment.

In this Cisco Unified Communications System Test release for Japan, the following components are tested.

• Cisco Unified Communications Manager

• Cisco TelePresence Video Communication Server

• Cisco TelePresence Video Communication Server Expressway

• Cisco Jabber for iPhone and iPad

• Cisco Jabber for Android

• Cisco Jabber for Windows

• Cisco Jabber for Mac

• Cisco Unified Border Element

• Cisco Unified Survivable Remote Site Telephony

• Cisco Unified Communications Manager IM and Presence

• Cisco Unity Connection

• Cisco Unified Attendant Console

• Cisco UC Integration ™ for Microsoft Lync

• Cisco Virtualization Experience Media Engine for Windows

• Cisco TelePresence Multipoint Control Unit

• Cisco TelePresence Management Suite

• Cisco TelePresence Conductor

• Cisco TelePresence Server 7010

• Cisco TelePresence Server on VM
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• Cisco Jabber Guest

• Cisco Collaboration Expressway

• Cisco Prime Collaboration

• Upgrade

Acronyms
DescriptionAcronym

Automated Alternate RoutingAAR

Automatic Call DistributionACD

Alternate Contact NumberACN

Automatic Gain ControlAGC

Audible Message Waiting IndicatorAMWI

Alternate Network Address TranslationANAT

Adaptive Security ApplianceASA

American Standard Code for Information InterchangeASCII

Analog Telephone AdapterATA

Bulk Administration ToolBAT

Busy Lamp FieldBLF

Certificate AuthorityCA

CDR Analysis and ReportingCAR

Channel Associated SignalingCAS

Call Control DiscoveryCCD

Cisco Desktop AdministratorCDA

Cisco Discovery ProtocolCDP

Call Detail RecordCDR

Caller Entered DigitsCED

Call Forward AllCFA

Call Forward BusyCFB

Customer Found DefectCFD

Call Forward No AnswerCFNA

Call Forward No CoverageCFNC
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DescriptionAcronym

Call Forward UnregisteredCFUR

Cisco Unified IP CommunicatorCIPC

Cisco Jabber for AndroidCJA

Cisco Jabber for iPhoneCJI

Cisco Jabber for MacCJM

Cisco Jabber for iPadCJIPad

Cisco Jabber for WindowsCJW

Command Line InterfaceCLI

Calling Line IdentificationCLID

Client Matter CodeCMC

Cisco Unified Communications Manager ExpressCME

Clustering over WANCoW

Cisco Prime CollaborationCPC

Client Services FrameworkCSF

Calling Search SpaceCSS

Computer Telephony InterfaceCTI

Computer Telephony IntegrationCTI

Certificate Trust ListCTL

Cisco Unified Attendant ConsoleCUAC

Cisco Unified Border ElementCUBE

Cisco Unity ConnectionCUC

Cisco UC Integration ™ for Microsoft LyncCUCI-Lync

Cisco Unified Communications ManagerCUCM

Cisco Unified Communications Manager IM and PresenceCUCM IM and Presence

Cisco Unified PresenceCUP

Cisco Unified Personal CommunicatorCUPC

Device and Credential RepositoryDCR

Dynamic Host Configuration ProtocolDHCP

Direct In-Ward DialingDID

Directory NumberDN

Do Not DisturbDND
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DescriptionAcronym

Delayed OfferDO

Digital Private Network Signaling SystemDPNSS

Disaster Recovery SystemDRS

Differentiated Services Code PointDSCP

Device Work CenterDWC

Extended Display Identification DataEDID

Enterprise License ManagerELM

Extension MobilityEM

Extension Mobility Cross ClusterEMCC

Early OfferEO

Cisco Enhanced Survivable Remote Site TelephonyE-SRST

Forced Authorization CodeFAC

Foreign Exchange OfficeFXO

Foreign Exchange StationFXS

Graphical User InterfaceGUI

GatewayGW

High AvailabilityHA

High DefinitionHD

Historical ReportingHR

Hyper Text Markup LanguageHTML

Hosted Virtual DesktopHVD

Inter Cluster TrunkICT

Identity ProviderIdP

Instant MessagingIM

IP Phone MessengerIPPM

IP Service Level AgreementsIPSLA

Integrated Services Digital NetworkISDN

Indian Standard TimeIST

Initial Trust ListITL

Key Expansion ModuleKEM

Log Collection CenterLCC
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DescriptionAcronym

Lightweight Directory Access ProtocolLDAP

Malicious Caller IDMCID

Media Convergence ServerMCS

Multipoint Control UnitMCU

MultiDimensional eXpressionsMDX

Media Gateway Control ProtocolMGCP

Multilevel Precedence and PreemptionMLPP

Music On HoldMOH

Media Resource Group ListMRGL

Managed Service ProviderMSP

Message Waiting IndicatorMWI

Network Interface and Configuration EngineNICE

Non Linear ProcessingNLP

New Technology LAN Manager version 2NTLMv2

Network Time ProtocolNTP

Operations ManagerOM

On Screen DisplayOSD

Product Authorization KeyPAK

Personal Communication AssistantPCA

Prime Collaboration DeploymentPCD

PC over IPPCoIP

Peer Firmware SharingPFS

Personal Identification NumberPIN

Picture in PicturePiP

Plain Old Telephony SystemPOTS

Primary Rate InterfacePRI

Provisioning Northbound InterfaceProvisioning - NBI

Problem Reporting ToolPRT

Public Switched Telephone NetworkPSTN

Quality Report ToolQRT

Q-Signaling protocolQSIG
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DescriptionAcronym

Really Simple SyndicationRSS

Real Time Control ProtocolRTCP

Real Time Monitoring ToolRTMT

Realtime Transport ProtocolRTP

Security Assertion Markup LanguageSAML

Skinny Client Control ProtocolSCCP

Standard DefinitionSD

Service Enabling PlatformSEP

Session Initiation ProtocolSIP

Small and Midsize BusinessSMB

Cisco Unified Survivable Remote Site TelephonySRST

Secure ShellSSH

Secure Socket LayerSSL

Single Sign OnSSO

Technical Assistant CenterTAC

Transmission Control ProtocolTCP

Transport Layer SecurityTLS

TelePresence Management SuiteTMS

The New PhoneTNP

Trust Relay PointTRP

TelePresence ServerTS

Telephony User InterfaceTUI

Unified Computing SystemUCS

User Datagram ProtocolUDP

User Data ServiceUDS

Unified Messaging GatewayUMG

Uniform Resource IdentifierURI

Coordinated Universal TimeUTC

Cisco TelePresence Video Communication ServerVCS

Virtual Desktop InfrastructureVDI

Voice GatewayVGW
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DescriptionAcronym

Voice Mail NotificationVMN

View Mail for OutlookVMO

Voice over IPVoIP

Voice Profile for Instant MessagingVPIM

Virtual Private NetworkVPN

Video SLA Assessment AgentVSAA

TelePresence Server on VMVTS

Virtualization Experience Media EngineVXME

Wide Area NetworkWAN

Wireless FidelityWi-Fi

Wireless LAN ControllerWLC

Extensive Application Programming InterfacexAPI

Extensible Markup LanguageXML
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C H A P T E R  2
Test Topology and Environment Matrix

• Test Topology, page 10

• Environment Matrix, page 12

• Open Caveats, page 16

• What's New?, page 17
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Test Topology
Figure 1: Topology in Use
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Upgrade

Figure 2: Topology in Use
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Environment Matrix
VersionComponentApplications

10.5.2.10000-5VersionCisco Unified Communications
Manager

Call Control

10.5.2.1000-1Locale

3-1-9.JPDial Plan

10.5VersionCiscoUnified Survivable Remote
Site Telephony (SRST)

15.4.3 M1IOS

9.0.6VersionCisco Unified SRST Manager

X8.2.2VersionCisco TelePresence Video
Communication Server
Expressway (VCS) X7.2_LanguagePacks_BETALocale

X8.2.2VersionCisco TelePresence Video
Communication Server (VCS
Expressway) X7.2_LanguagePacks_BETALocale

X8.2.2VersionCisco Expressway-C

X7.2_LanguagePacks_BETALocale

X8.2.2VersionCisco Expressway-E

X7.2_LanguagePacks_BETALocale

10.5.1.10-3VersionCisco Unified Attendant ConsoleApplications

10.5.2.10000-9VersionCisco Unified Communications
Manager IM and Presence
Service 10.5.2.1000-1Locale

10.5.2.10000-5VersionCisco Unity ConnectionVoice Mail and
Unified Messaging

10.5.2.1-1Locale
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VersionComponentApplications

9-4-1-3SIPCisco Unified IP Phone
6921/41/61

End Point

9-4-1-3SR1SCCP

9-4-1-3Cisco Unified IP Phone 6945

10-2-1-12Cisco IP Phone 7821/41/61

9-4-2-1SCisco Unified IP Phone
7942/62/75

1-4-5-3Cisco UnifiedWireless IP Phone
792X

9-3-3-5Cisco Unified IP Conference
Phone 8831

10-2-2-16Cisco IP Phone 8841/8851/8861

9-4-2-8Cisco Unified IP Phone
8941/8945

9-4-2-13Cisco Unified IP Phone
9951/9971

10-3-1KK0-174Cisco Desktop Collaboration
Experience DX650

1-1-0-006Cisco ATA 190 Analog
Telephone Adaptor

9.7(4) ES1Cisco UC Integration™ for
Microsoft Lync

TC 7.2.1EX60 - Cisco TelePresence
System EX60

TC 7.2.1EX90 - Cisco TelePresence
System EX90

TC 7.2.1SX20 - Cisco TelePresence SX20
Quick Set

TC 7.2.1SX80-Cisco TelePresence SX80
Codec

TC 7.2.1SX10-Cisco TelePresence SX10
Quick Set

TC 7.2.1C90 - Cisco TelePresence System
Integrator Package C90

TX6.1.5.1(2)500-32 – Cisco TelePresence
System 500 (32)

TX6.1.5.1(2)TX9000 - Cisco TelePresence
System TX9000
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VersionComponentApplications

MX200-G2- Cisco TelePresence
MX200-G2

TC 7.2.1

TC 7.2.1MX300-G2- Cisco TelePresence
MX300-G2

10.6.0.896VersionCisco Prime Collaboration
Provisioning

Cisco Prime
Collaboration

10.6.0.56891VersionCisco Prime Collaboration
Assurance

2.1(1a)UCSC-C24-M3SCisco C-series ServerUpgrade

ESXi 5.1ESXi host on
Blade Server

Hypervisor

MCS 7845 H2HardwareCisco Unified Communications
Manager

MCS 7845 I2HardwareCisco Unity Connection

MCS 7835 I2HardwareCisco Unified Presence

15.4(3)TIOSVoice Gateway 2951

Voice Gateway 2921

15.0.2-SE 5Cisco 3750Access Switch

15.4.3 M1IOSISR Gateways (3945e, 3925e,
3945, 2921)

Communications
Infrastructure

3.13.0SIOSISR 4451-X

15.4.3 M1Cisco Unified Border Element
for ISR

15.0.2-SE 5Cisco 3750 PoE Switch

ESXi 5.1.0VCenter Server

5.2(2 a)M9500MDS Switch

14.5VersionCisco TelePresenceManagement
Suite - TMS

TelePresence

4.5 (1.45)VersionMCU 4510 & 5310 - Cisco
TelePresence MCU

MCU_4-3_UI_and_audio_JPN.packageLocale

4.0 (2.8)VersionCisco TelePresence Server on
VM

XC2.4.1VersionCisco TelePresence Conductor

4.0(2.8)VersionCisco TelePresence Server 7010
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VersionComponentApplications

7-0-250-0Wireless LAN Controller 4404Wireless and
Mobility

15.2AutonomousWireless Access Point 1142

12.4LightweightWireless Access Point 3502

10.5.1.194255Cisco Jabber for Mac

10.6.0.47088Cisco Jabber for Windows

10.6.0.196647VersionCisco Jabber for iPhone and iPad

Apple iOS 8.1 (12B411)iPhone 5

Apple iOS 8.1 (12B410)iPad

10.6.0.195947VersionCisco Jabber for Android

Android OS 4.0.3Galaxy SII

Android OS 4.4.2Galaxy S4

Android OS 4.4.2Xperia Z1

10.5VersionCisco Jabber Guest

Windows OS 7Windows

Mac OS 10.9.4Mac

Apple iOS 8.1 (12B411)iPhone 5

Apple iOS 8.1 (12B410)iPad

10.5VersionCisco VXME for Windows

2.1(2a)Cisco UCS
6140

Fabric Interconnect PRIMARYUCS

2.1(2a)Cisco UCS
6140

Fabric Interconnect
SUBORDINATE

2.1(2a)Cisco UCS
6140

Fabric Cluster

ESXi 5.1.0Blade
Server-1

ESXi Host

ESXi 5.1.0C-Series
Server
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VersionComponentApplications

Windows 7-SP1 (Japanese)Windows
7-SP1

Operating SystemClient

Windows 8/8.1 (Japanese)Windows
8/8.1

10.9.4Mac

IE 11 (Supported Japanese
language)

IEBrowser

Firefox 29.0.1, Firefox ESR 24, 31
(Supported Japanese language)

Mozilla

Chrome 35 (Supported Japanese
language)

Chrome

2013Microsoft Lync Client

Windows Server 2008 (R2
Enterprise - Japanese)

Microsoft Windows ServerServer

Windows Server 2012

2013Microsoft Exchange Server

2013Microsoft Lync Server

10.0.1.10000-95Cisco MediaSense

2.5.1.28.BCisco WebEx Meetings Server

10.5.2.94Cisco Jabber Guest Server

Open Caveats
TitleDefect ID

Cisco Unified Communications Manager

Handset light strip is blinking continuously when phone is unregisteredCSCur54662

Cisco TelePresence Video Communication Server

'Provisioning' becomes Junk Characters after language change in SX10CSCur60996

Mismatch in count of languages in Remote usage, Touch UI andWeb GUICSCur60216

Last frame to freeze a call to an EX90 from Cisco Jabber GuestCSCur60272

Truncate caller name between jabber guest and TP callCSCur59459

Upgrade

Migration Failure for CUCM 6.1.5 using PCD 10.5.1CSCur58310
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What's New?
Cisco ATA 190 Analog Telephone Adapter:

The Cisco ATA 190 Analog Telephone Adaptor is a handset-to-Ethernet adaptor that turns traditional telephone
devices into IP devices. It is a low-density analog telephone adapter that connects analog devices to an IP
network. The ATA 190 supports two voice ports, each with its own independent telephone number. It has one
RJ45 port that provides access to an Ethernet network.

Cisco IP Phone 8841, 8851 and 8861:

The Cisco IP Phone 8800 Series delivers easy-to-use, highly secure voice communications. New ergonomic
hardware and software have been designed for ease of use and superior quality voice communications. Navigate
menus more easily with a five-way navigation wheel. Recognize displayed content simply under a variety of
lighting conditions with five-inch, widescreen, backlit, high-resolution displays.

Cisco Virtualization Experience Media Engine for Windows:

With the Cisco Virtualization Experience Media Engine (VXME) for Windows software, users can place and
receive calls with their Cisco Unified Communications clients in a virtual environment. The Cisco Virtualization
Experience Media Engine software runs on the endpoint, and the Cisco Unified Communications client and
Cisco VXME Utilities runs on the Microsoft Windows Hosted Virtual Desktop (HVD), in the data center. To
reduce latency and to enhance media quality, Cisco Virtualization Experience Media Engine streams media
between the endpoints without going through the Hosted Virtual Desktops.

Cisco Jabber Guest:

Cisco Jabber Guest lets you invite them in through your website or mobile application to interact with contact
center agents, remote experts, and other people via video and tour visually through products and services. No
more requesting a chat and then waiting for a callback. Jabber Guest gives people instant interaction as well
as information. It's a good way to make browsers into buyers. With Cisco Jabber Guest, you can expand your
business reach and reduce costs through more intimate and effective customer interactions. Offer simple,
lightweight browser and mobile video calls to customers, partners, and associates, as well as corporate users.

Cisco TelePresence SX10 Quickset:

The SX10 Quick Set is a codec-in-camera unit that easily turns any flat panel into a video collaboration
solution. It is designed to outfit any small room or huddle space with business-quality video, priced to scale
at about the cost of a PC. The SX10 sits at the entry level of our product portfolio, designed to help SMBs
adopt video or for scaled deployment in the enterprise. It offers Business-quality video, Simple and elegant
cabling system that connects through a single-cable system for both power and Ethernet connectivity. It
supports high-definition video with up to 1080p30 resolution.

Cisco TelePresence MX200-G2:

The Cisco TelePresence MX200 G2 makes it easy to put high definition video collaboration within reach for
everyone at your organization. It delivers ready-to-use simplicity and high quality performance at value pricing
so decisions can be made faster and be more productive and innovative. The MX200 G2 is a value product
within the MX Series of collaboration room endpoints. It features a sleek, streamlined industrial design that
blends aesthetics, functionality and ease of use at a great value . New features such as dual display and an
embedded four-wayMultiSite conferencing option deliver more power and flexibility. The Cisco TelePresence
MX200 G2 is a part of a complete collaboration ecosystem that offers high-quality, easy-to-use TelePresence
experiences Offers flexible camera features: Cisco TelePresence PrecisionHDCamera with pan, tilt, and zoom
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helps ensure optimal framing and video clarity. Its dedicated presets provide flexibility and easy viewing for
any type of meeting.

Email Notification

The Email Notification feature sends email notifications to the administrator regarding certain task events.
You can choose whether to have emails sent for all standard task events (such as when task is scheduled,
started, successful, paused, failed and canceled), or only for task errors. Emails will be sent for all types of
tasks: cluster discovery, upgrade, migration, switch version, restart, fresh install, readdress.
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C H A P T E R  3
Test Results Summary

• Cisco Unified Communications Manager, page 19

• Cisco TelePresence Video Communication Server, page 24

• Cisco Jabber for iPhone and iPad, page 51

• Cisco Jabber for Android, page 57

• Cisco Jabber for Windows, page 60

• Cisco Jabber for Mac, page 61

• Cisco Unified Survivable Remote Site Telephony , page 64

• Cisco Unity Connection, page 66

• Cisco Virtualization Experience Media Engine for Windows, page 67

• Cisco TelePresence Multipoint Control Unit, page 69

• Cisco TelePresence Management Suite, page 74

• Cisco TelePresence Conductor, page 77

• Cisco TelePresence Server, page 87

• Cisco Jabber Guest, page 91

• Cisco Collaboration Expressway, page 98

• Cisco Prime Collaboration, page 109

• Cisco Unified Communication System Upgrade / Migration Test, page 144

• Regression, page 158

• Related Documentation, page 160

Cisco Unified Communications Manager
DefectsStatusCall Component flowDescriptionTitleLogical ID
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PassedIP Phone -> Unified
CM1 ->MGCPGW ->
Unified CM1 ->
Analog Phone

Verify whether
the call is
establishing
from IP Phone
toAnalog Phone
successfully.

Make call from
IP Phone to
Analog Phone.

UCJ10.6S.CUCM.G.63

PassedIP Phone -> Unified
CM1 -> ICT -> MGCP
GW->Unified CM2 ->
Analog Phone

Verify whether
the call is
establishing
from IP Phone
toAnalog Phone
successfully.

Make call from
IP Phone to
Analog Phone
via ICT trunk.

UCJ10.6S.CUCM.G.65

PassedIP Phone A -> Unified
CM 1 -> IP Phone B ->
MGCP GW -> Unified
CM 2 -> Analog
Phone.

Verify whether
the call is
establishing
from IP Phone
toAnalog Phone
successfully.

Make call from
IP Phone A to
IP Phone B then
IP Phone A calls
Analog Phone
within the site.

UCJ10.6S.CUCM.G.71

PassedAnalog Phone ->
UnifiedCM1 ->MGCP
GW -> IP Phone A , IP
Phone B -> Unified
CM1-> MGCP GW ->
IP Phone A

Verify whether
the call back is
established
between Analog
Phone and IP
Phone
successfully.

Call back
feature for IP
Phone toAnalog
Phone.

UCJ10.6S.CUCM.G.80

PassedAnalog Phone ->
UnifiedCM1 ->MGCP
GW -> IP Phone A ->
Unified CM1 -> IP
Phone B

Verify whether
the call forward
busy is
established
between Analog
Phone and IP
Phone
successfully.

Call forward
busy feature for
IP Phone and
Analog Phone.

UCJ10.6S.CUCM.G.81

PassedAnalog Phone ->
UnifiedCM1 ->MGCP
GW -> IP Phone A ->
Unified CM1 -> IP
Phone B

Verify whether
the call join is
established
between Analog
Phone and IP
Phone
successfully.

Call join feature
for IP Phone
and Analog
Phone.

UCJ10.6S.CUCM.G.82

PassedIP Phone -> Unified
CM1 ->MGCPGW ->
Analog Phone

Verify whether
the speed dial is
established for
IP Phone to
make a call to
Analog Phone
successfully.

Speed dial
feature for IP
Phone to make
call for Analog
Phone.

UCJ10.6S.CUCM.G.83
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PassedAnalog Phone ->
UnifiedCM1 ->MGCP
GW -> IP Phone B

Verify whether
the call transfer
is established
between Analog
Phone and IP
Phone
successfully.

Call transfer
feature from IP
Phone toAnalog
Phone.

UCJ10.6S.CUCM.G.85

PassedIP Phone -> Unified
CM1 -> SIP -> MGCP
GW->Unified CM2 ->
Analog Phone

Verify whether
the call is
establishing
from IP Phone
toAnalog Phone
successfully.

Make call from
IP Phone to
Analog Phone
via SIP trunk

UCJ10.6S.CUCM.G.64

PassedIP Phone A -> Unified
CM1 -> IP Phone B

Verify whether
the call is hold
and resume from
IP Phone-A to
IP Phone-B
successfully.

Make call from
IP Phone-A to
IP Phone-B to
put the call on
hold and resume
the call.

UCJ10.6S.CUCM.G.128

PassedIP Phone A -> Unified
CM1 -> SIP -> Unified
CM2 -> IP Phone-B

Verify whether
the call is hold
and resume from
IP Phone-A to
IP Phone-B via
SIP trunk
successfully.

Make call from
IP Phone-A to
IP Phone-B to
put the call on
hold and resume
the call via SIP
trunk.

UCJ10.6S.CUCM.G.130

PassedIP Phone A -> Unified
CM1 -> ICT ->Unified
CM2 -> IP Phone B

Verify whether
the call is hold
and resume from
IP Phone-A to
IP Phone-B via
ICT trunk
successfully.

Make call from
IP Phone-A to
IP Phone-B to
put the call on
hold and resume
the call via ICT
trunk.

UCJ10.6S.CUCM.G.131

PassedIP Phone A -> Unified
CM1 -> IP Phone B ->
Unified CM1 -> IP
Phone C

Verify whether
the IP Phone-A
call is hold by IP
Phone-C
successfully.

Check the call
transfer feature
for IP Phone
press the hold
softkey to put
the call on hold
and resume the
call.

UCJ10.6S.CUCM.G.137
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PassedIP Phone A -> Unified
CM1 -> IP Phone B ->
Unified CM1 -> IP
Phone C

Verify whether
the IP Phone-A
call is hold and
resume by IP
Phone-C
successfully.

Make the
conference call
between IP
Phone-A, B and
C then IP
Phone-C press
the hold and
resume.

UCJ10.6S.CUCM.G.153

PassedIP Phone A -> Unified
CM1 -> SIP -> IP
Phone B -> Unified
CM1 -> IP Phone C

Verify whether
the IP Phone-A
call is hold and
resume by IP
Phone-C
successfully.

Make the
conference call
between IP
Phone-A, B and
C then IP
Phone-C press
the hold and
resume via sip
trunk.

UCJ10.6S.CUCM.G.154

PassedIP Phone A -> Unified
CM1 -> ICT -> IP
Phone B -> Unified
CM2 -> IP Phone C

Verify whether
the IP Phone-A
call is hold and
resume by IP
Phone-C via sip
trunk
successfully.

Check the call
forward feature
and press the
hold softkey to
put the call on
hold and resume
the call via ICT
trunk.

UCJ10.6S.CUCM.G.147

PassedIP Phone A -> Unified
CM1 -> SIP -> Unified
CM2 -> IP Phone B

Verify whether
the call is
established from
IP Phone-A to
IP Phone-B
successfully.

Make a call IP
Phone-A to IP
Phone-B via sip
trunk by
registering the
two IP Phones
in secondary
server.

UCJ10.6S.CUCM.G.165

PassedIP Phone A -> Unified
CM1 -> Unified CM2
-> IP Phone B

Verify whether
the call is hold
and resume from
IP Phone-A to
IP Phone-B via
PSTN trunk
successfully.

Make call from
IP Phone-A to
IP Phone-B to
put the call on
hold and resume
the call via
PSTN trunk.

UCJ10.6S.CUCM.G.132

PassedIP Phone A -> Unified
CM1 -> SIP -> IP
Phone B -> Unified
CM2 -> IP Phone C

Verify whether
the IP Phone-A
call is hold and
resume by IP
Phone-C via sip
trunk
successfully.

Check the call
forward feature
and press the
hold softkey to
put the call on
hold and resume
the call via sip
trunk.

UCJ10.6S.CUCM.G.146
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PassedIP Phone A -> Unified
CM -> IP Phone B ->
Unified CM -> IP
Phone C

Verify whether
the call is
established from
IP Phone-A to
IP Phone-B and
IP Phone-A to
IP Phone-C
successfully.

Check whether
the conference
is established
between the IP
Phones when it
is registered in
the secondary
server.

UCJ10.6S.CUCM.G.174

PassedIP Phone A -> Unified
CM -> ATA 190

Verify whether
call made to
ATA 190 when
line1 and line2
of ATA is in
shared line is
successful

Make a call to
ATA 190 when
line1 and line2
of ATA is in
shared line

UCJ10.6S.CUCM.G.501

PassedATA 190 -> Unified
CM -> IP Phone A

Verify whether
call made from
line1of ATA
190 to other IP
Phone, when
line1 and line2
of ATA is in
shared line is
successful

Make a call
from line1 of
ATA 190 to
other IP Phone,
when line1 and
line2 of ATA is
in shared line

UCJ10.6S.CUCM.G.502

PassedIP Phone A -> Unified
CM -> ATA 190

Verify whether
speed dial to
ATA 190 from
IP Phone A is
successful

Speed dial to
ATA 190 from
IP Phone A

UCJ10.6S.CUCM.G.503

PassedIP Phone A -> Unified
CM -> ATA 190 ->
Unified CM -> IP
Phone B

Verify whether
call forward all
from ATA 190
to other IP
Phone are
successful

Call Forward
All from ATA
190 to other IP
Phones

UCJ10.6S.CUCM.G.504

PassedIP Phone A -> Unified
CM -> ATA 190 ->
Unified CM -> IP
Phone B -> Unified
CM -> ATA 190 -> IP
Phone C

Verify whether
call forward
busy from ATA
190 to other IP
Phone are
successful

Call Forward
busy from ATA
190 to other IP
Phones

UCJ10.6S.CUCM.G.505

PassedIP Phone A -> Unified
CM -> ATA 190 ->
Unified CM -> IP
Phone B

Verify whether
call forward no
answer from
ATA 190 to
other IP Phone
are successful

Call Forward no
answer from
ATA 190 to
other IP Phones

UCJ10.6S.CUCM.G.506
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PassedIP Phone A -> Unified
CM -> ATA 190
(Line1) -> Unified CM
-> ATA 190 (Line 2)

Verify whether
call forward all
from line1 of
ATA 190 to
line2 of ATA
190 is successful

Call Forward
All from line1
of ATA 190 to
line2 of ATA
190

UCJ10.6S.CUCM.G.507

PassedIP Phone A -> Unified
CM -> ATA 190
(Line1) -> Unified CM
-> IP Phone B -> ATA
190 (Line 1) -> Unified
CM -> ATA 190
(Line2)

Verify whether
call forward
busy from line1
of ATA 190 to
line2 of ATA
190 is successful

Call Forward
Busy from line1
of ATA 190 to
line2 of ATA
190

UCJ10.6S.CUCM.G.508

PassedIP Phone A -> Unified
CM -> ATA 190
(Line1) -> Unified CM
-> ATA 190 (Line 2)

Verify whether
call forward no
answer from
line1 of ATA
190 to line2 of
ATA 190 is
successful

Call Forward
No Answer
from line1 of
ATA 190 to
line2 of ATA
190

UCJ10.6S.CUCM.G.509

PassedNAVerify whether
there is an icon
or picture of
ATA 190
available in the
Unified CM
Self-Care portal

ATA 190 icon
or picture in
Self-Care portal

UCJ10.6S.CUCM.G.510

CSCur54662FailedNAVerify whether
the Handset
light strip of
88xx phones are
not blinking
continuously
while pressing
the volume up
or down key and
when phone
remains
unregistered

Function of
handset light
strip in 88xx IP
Phones when
phone is
unregistered

UCJ10.6S.CUCM.G.95

Cisco TelePresence Video Communication Server
DefectsStatusCall Component

Flow
DescriptionTitleLogical ID
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PassedSX80
Codec(H.323) ->
Cisco VCS Control
A -> Cisco VCS
Expressway ->
Cisco VCS Control
B -> EX90(H.323)

Verify whether the
video call from Cisco
TelePresence SX80
Codec registered as
H.323 in Cisco
TelePresence Video
Communication
Server Control A to
Cisco TelePresence
System EX90
registered as H.323 in
Cisco TelePresence
Video
Communication
Server Control B via
Cisco TelePresence
Video
Communication
Server Expressway
works successfully

Making
H.323 call
from SX80
Codec to
EX90 via
Cisco VCS
Expressway

UCJ10.6S.VCS.G.001

PassedSX80 Codec ->
Cisco VCS Control
A -> Cisco VCS
Expressway ->
Cisco VCS Control
B -> EX90

Verify whether the
video call from Cisco
TelePresence SX80
Codec registered as
SIP in Cisco
TelePresence Video
Communication
Server Control A to
Cisco TelePresence
System EX90
registered as SIP in
Cisco TelePresence
Video
Communication
Server Control B via
Cisco TelePresence
Video
Communication
Server Expressway
works successfully

Making SIP
call from
SX80 Codec
to EX90 via
Cisco VCS
Expressway

UCJ10.6S.VCS.G.002
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PassedSX80
Codec(H.323) ->
Cisco VCS Control
A -> Cisco VCS
Expressway ->
Cisco VCS Control
B -> EX90(H.323)
SX80
Codec(H.323) ->
Add participant ->
Cisco VCS Control
A -> Cisco VCS
Expressway ->
Cisco VCS Control
B -> EX60(H.323)

Verify whether
multisite conference
between Cisco
TelePresence SX80
Codec registered as
H.323 in Cisco
TelePresence Video
Communication
Server Control A,
Cisco TelePresence
System EX90 and
Cisco TelePresence
System EX60 which
are registered as
H.323 in Cisco
TelePresence Video
Communication
Server Control B via
Cisco TelePresence
Video
Communication
Server Expressway
works successfully

Multisite
conference
call from
SX80 Codec
registered as
H.323 via
Cisco VCS
Expressway

UCJ10.6S.VCS.G.003

PassedSX80 Codec ->
Cisco VCS Control
A -> Cisco VCS
Expressway ->
Cisco VCS Control
B -> EX90
SX80 Codec ->
Add participant ->
Cisco VCS Control
A -> Cisco VCS
Expressway ->
Cisco VCS Control
B -> EX60

Verify whether
multisite conference
between Cisco
TelePresence SX80
Codec registered as
SIP in Cisco
TelePresence Video
Communication
Server Control A,
Cisco TelePresence
System EX90 and
Cisco TelePresence
System EX60 which
are registered as SIP
in Cisco TelePresence
Video
Communication
Server Control B via
Cisco TelePresence
Video
Communication
Server Expressway
works successfully

Multisite
conference
call from
SX80 Codec
registered as
SIP via Cisco
VCS
Expressway

UCJ10.6S.VCS.G.004
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PassedSX80 Codec
(H.323) -> Cisco
VCS Control A ->
Cisco VCS
Expressway ->
Cisco VCS Control
B -> EX90 (H.323)
-> Hold/Resume

Verify whether hold
and resume for the
video call from Cisco
TelePresence SX80
Codec registered as
H.323 in Cisco
TelePresence Video
Communication
Server Control A to
Cisco TelePresence
System EX90
registered as H.323 in
Cisco TelePresence
Video
Communication
Server Control B via
Cisco TelePresence
Video
Communication
Server Expressway
works successfully

Hold/Resume
H.323 call
from SX80
Codec to
EX90 via
Cisco VCS
Expressway

UCJ10.6S.VCS.G.005

PassedSX80 Codec ->
Cisco VCS Control
A -> Cisco VCS
Expressway ->
Cisco VCS Control
B -> EX90 ->
Hold/Resume

Verify whether hold
and resume for the
video call from Cisco
TelePresence SX80
Codec registered as
SIP in Cisco
TelePresence Video
Communication
Server Control A to
Cisco TelePresence
System EX90
registered as SIP in
Cisco TelePresence
Video
Communication
Server Control B via
Cisco TelePresence
Video
Communication
Server Expressway
works successfully

Hold/Resume
SIP call from
SX80 Codec
to EX90 via
Cisco VCS
Expressway

UCJ10.6S.VCS.G.006
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PassedSX80
Codec(H.323) ->
Cisco VCS Control
A -> Cisco VCS
Expressway ->
Cisco VCS Control
B -> EX90(H.323)
SX80
Codec(H.323) ->
Add participant ->
Cisco VCS Control
A -> Cisco VCS
Expressway ->
Cisco VCS Control
B -> EX60(H.323)
-> Hold/Resume

Verify whether
Hold/Resume for a
multisite conference
between Cisco
TelePresence SX80
Codec registered as
H.323 in Cisco
TelePresence Video
Communication
Server Control A,
Cisco TelePresence
System EX90 and
Cisco TelePresence
System EX60 which
are registered as
H.323 in Cisco
TelePresence Video
Communication
Server Control B via
Cisco TelePresence
Video
Communication
Server Expressway
works successfully

Hold/Resume
Multisite
conference
call from
SX80 Codec
registered as
H.323 via
Cisco VCS
Expressway

UCJ10.6S.VCS.G.007

PassedSX80 Codec ->
Cisco VCS Control
A -> Cisco VCS
Expressway ->
Cisco VCS Control
B -> EX90
SX80 Codec ->
Add participant ->
Cisco VCS Control
A -> Cisco VCS
Expressway ->
Cisco VCS Control
B -> EX60 ->
Hold/Resume

Verify whether
Hold/Resume for a
multisite conference
between Cisco
TelePresence SX80
Codec registered as
SIP in Cisco
TelePresence Video
Communication
Server Control A ,
Cisco TelePresence
System EX90 and
Cisco TelePresence
System EX60 which
are registered as SIP
in Cisco TelePresence
Video
Communication
Server Control B via
Cisco TelePresence
Video
Communication
Server Expressway
works successfully

Hold/Resume
Multisite
conference
call from
SX80 Codec
registered as
SIP via Cisco
VCS
Expressway

UCJ10.6S.VCS.G.008
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PassedSX80 Codec ->
Cisco VCS Control
A -> Cisco VCS
Expressway ->
Cisco VCS Control
B -> EX60
SX80 Codec ->
Transfer -> Cisco
VCS Control A ->
Cisco VCS
Expressway ->
Cisco VCS Control
B -> EX90

Verify whether the
call transfer from
Cisco TelePresence
SX80 Codec
registered as SIP in
Cisco TelePresence
Video
Communication
Server Control A to
Cisco TelePresence
System EX90
registered as SIP in
Cisco TelePresence
Video
Communication
Server Control B via
Cisco TelePresence
Video
Communication
Server Expressway
works successfully

Call transfer
from SX80
Codec to
EX90 via
Cisco VCS
Expressway

UCJ10.6S.VCS.G.009

PassedSX80
Codec(H.323) ->
Cisco VCS Control
A -> Cisco VCS
Expressway ->
Cisco VCS Control
B -> EX90(H.323)
SX80
Codec(H.323) ->
Hold and Place a
new call -> Cisco
VCS Control A ->
Cisco VCS
Expressway ->
Cisco VCS Control
B -> EX60(H.323)

Verify whether Cisco
TelePresence SX80
Codec registered as
H.323 in Cisco
TelePresence Video
Communication
Server Control A can
hold the call with
Cisco TelePresence
System EX90
registered as H.323 in
Cisco TelePresence
Video
Communication
Server Control B and
place a new call to
Cisco TelePresence
System EX60
registered as H.323 in
Cisco TelePresence
Video
Communication
Server Control B via
Cisco TelePresence
Video
Communication
Server Expressway

Holding
current call
and placing
new call from
SX80 Codec
registered as
H.323 via
Cisco VCS
Expressway

UCJ10.6S.VCS.G.010
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PassedSX80 Codec
(H.323) -> Cisco
VCS Control A ->
Cisco VCS
Expressway ->
Cisco VCS Control
B -> EX90 (H.323)
SX80 Codec
(H.323) -> Hold
and Place a new
call -> Cisco VCS
Control A -> Cisco
VCS Expressway
-> Cisco VCS
Control B -> EX60
(H.323)

Verify whether Cisco
TelePresence SX80
Codec registered as
SIP in Cisco
TelePresence Video
Communication
Server Control A can
hold the call with
Cisco TelePresence
System EX90
registered as SIP in
Cisco TelePresence
Video
Communication
Server Control B and
place a new call to
Cisco TelePresence
System EX60
registered as SIP in
Cisco TelePresence
Video
Communication
Server Control B via
Cisco TelePresence
Video
Communication
Server Expressway

Holding
current call
and placing a
new call from
SX80 Codec
registered as
SIP via Cisco
VCS
Expressway

UCJ10.6S.VCS.G.011

PassedSX80
Codec(H.323) ->
Cisco VCS Control
A -> Cisco VCS
Expressway ->
Cisco VCS Control
B -> EX90(H.323)
-> Presentation
sharing

Verify whether the
presentation is shared
from Cisco
TelePresence SX80
Codec registered as
H.323 in Cisco
TelePresence Video
Communication
Server Control A to
Cisco TelePresence
System EX90
registered as H.323 in
Cisco TelePresence
Video
Communication
Server Control B via
Cisco TelePresence
Video
Communication
Server Expressway
works successfully

Presentation
sharing
between
SX80 Codec
and EX90
registered as
H.323 via
Cisco VCS
Expressway

UCJ10.6S.VCS.G.012
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PassedSX80 Codec ->
Cisco VCS Control
A -> Cisco VCS
Expressway ->
Cisco VCS Control
B -> EX90 ->
Presentation
sharing

Verify whether the
presentation is shared
from Cisco
TelePresence SX80
Codec registered as
SIP in Cisco
TelePresence Video
Communication
Server Control A to
Cisco TelePresence
System EX90
registered as SIP in
Cisco TelePresence
Video
Communication
Server Control B via
Cisco TelePresence
Video
Communication
Server Expressway
works successfully

Presentation
sharing
between
SX80 Codec
and EX90
registered as
SIP via Cisco
VCS
Expressway

UCJ10.6S.VCS.G.013

PassedSX80
Codec(H.323) ->
Cisco VCS Control
A -> Cisco VCS
Expressway ->
Cisco VCS Control
B -> EX90(H.323)
SX80
Codec(H.323) ->
Add participant ->
Cisco VCS Control
A -> Cisco VCS
Expressway ->
Cisco VCS Control
B -> EX60(H.323)
-> Presentation
sharing

Verify whether
presentation sharing
in Cisco TelePresence
SX80 Codec
registered as H.323 in
Cisco TelePresence
Video
Communication
Server Control A
during multisite
conference with Cisco
TelePresence System
EX90 and Cisco
TelePresence System
EX60 which are
registered as H.323 in
Cisco TelePresence
Video
Communication
Server Control B via
Cisco TelePresence
Video
Communication
Server Expressway
works successfully

Multisite
conference
call from
SX80 Codec
registered as
H.323 and
presentation
sharing via
Cisco VCS
Expressway

UCJ10.6S.VCS.G.014
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PassedSX80 Codec ->
Cisco VCS Control
A -> Cisco VCS
Expressway ->
Cisco VCS Control
B -> EX90
SX80 Codec ->
Add participant ->
Cisco VCS Control
A -> Cisco VCS
Expressway ->
Cisco VCS Control
B -> EX60 ->
Presentation
sharing

Verify whether
presentation sharing
in Cisco TelePresence
SX80 Codec
registered as SIP in
Cisco TelePresence
Video
Communication
Server Control A
during multisite
conference with Cisco
TelePresence System
EX90 and Cisco
TelePresence System
EX60 which are
registered as SIP in
Cisco TelePresence
Video
Communication
Server Control B via
Cisco TelePresence
Video
Communication
Server Expressway
works successfully

Multisite
conference
call from
SX80 Codec
registered as
SIP and
presentation
sharing via
Cisco VCS
Expressway

UCJ10.6S.VCS.G.015

PassedNAVerify whether the
EDID(Extended
Display Identification
Data) information of
Cisco TelePresence
System EX60 is
displayed using the
command 'xStatus
Video Output' in xAPI

Showing
EDID
information
about EX60
display

UCJ10.6S.VCS.G.016

PassedNAVerify whether the
EDID(Extended
Display Identification
Data) information of
Cisco TelePresence
SX80 Codec is
displayed using the
command 'xStatus
Video Output' in xAPI

Showing
EDID
information
about SX80
Codec display

UCJ10.6S.VCS.G.017
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Passed500-32 -> Unified
CM ->SX80Codec
->Hold/Transfer ->
Unified CM ->
TX9000

Verify whether the
consultative call
transfer from Cisco
TelePresence SX80
Codec registered with
Cisco Unified
Communications
Manager to Cisco
TelePresence TX9000
works successfully

Consultative
call transfer
from SX80
Codec
registered
with Unified
CM to
TX9000

UCJ10.6S.VCS.G.018

Passed500-32 -> Unified
CM ->SIP
Trunk->Cisco
VCS-> SX80
Codec ->
Hold/Transfer->
Cisco VCS -> SIP
Trunk -> Unified
CM -> TX9000

Verify whether the
consultative call
transfer from Cisco
TelePresence SX80
Codec registered with
Cisco TelePresence
Video
Communication
Server to Cisco
TelePresence TX9000
registered with Cisco
Unified
Communications
Manager works
successfully

Consultative
call transfer
from SX80
Codec
registered
with Cisco
VCS to
TX9000

UCJ10.6S.VCS.G.019

Passed500-32 -> Unified
CM ->SX80Codec
-> Add -> Unified
CM -> TX9000 &
EX60->Video
Conference

Verify whether
multisite conference
with four participants
in Cisco TelePresence
SX80 Codec
registered with Cisco
Unified
Communications
Manager

Making
multisite
conference
with four
participants in
SX80 Codec
registered
with Unified
CM

UCJ10.6S.VCS.G.020

Passed500-32 -> Unified
CM -> SIP Trunk
-> Cisco VCS ->
SX80 Codec ->
Add ->Cisco VCS
-> SIP Trunk->
Unified CM ->
TX9000&EX60->
Video Conference

Verify whether
multisite conference
with four participants
in Cisco TelePresence
SX80 Codec
registered with Cisco
TelePresence Video
Communication
Server

Making
multisite
conference
with four
participants in
SX80 Codec
registered
with Cisco
VCS

UCJ10.6S.VCS.G.021
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PassedSX80 Codec ->
Cisco VCS ->
EX90 SX80 Codec
-> Add participant
-> Cisco VCS ->
EX60 ->
Hold/Resume

Verify whether hold
and resume is working
successfully during
multisite conference
between Cisco
TelePresence SX80
Codec ,Cisco
TelePresence System
EX90 and Cisco
TelePresence System
EX60 when all are
registered in Cisco
TelePresence Video
Communication
Server

Hold/Resume
multisite
conference
call from
SX80 Codec

UCJ10.6S.VCS.G.022

PassedSX80
Codec(H.323) ->
Cisco VCS ->
EX90(H.323) ->
Presentation
sharing

Verify whether the
presentation is shared
from Cisco
TelePresence SX80
Codec to Cisco
TelePresence EX90
successfully when
both are registered as
H.323 in Cisco
TelePresence Video
Communication
Server

Making
H.323 call
from SX80
Codec to
EX90 and
sharing
presentation

UCJ10.6S.VCS.G.023

PassedSX80
Codec(H.323) ->
Cisco VCS ->
EX90(H.323) ->
Hold/Resume

Verify whether hold
and resume for the
video call from Cisco
TelePresence SX80
Codec to Cisco
TelePresence EX90
works successfully
when both are
registered as H.323 in
Cisco TelePresence
Video
Communication
Server

Hold/Resume
H.323 call
from SX80 to
EX90

UCJ10.6S.VCS.G.024
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Passed500-32 -> Unified
CM -> TX9000 ->
Add and merge ->
Unified CM ->
SX80 Codec

Verify whether the
call with Cisco
Telepresence SX80
Codec is merged with
the existing call of
Cisco Telepresence
System 500-32 in
Cisco Telepresence
System TX9000
where all are
registered with Cisco
Unified
Communications
Manager

Merging
SX80 Codec
call with
500-32 call in
TX9000

UCJ10.6S.VCS.G.025

Passed500-32 -> Unified
CM ->SX80Codec
-> Add -> Unified
CM -> TX9000

Verify whether Cisco
TelePresence TX9000
registered with Cisco
Unified
Communications
Manager can be added
for multisite
conference fromCisco
TelePresence SX80
Codec registered with
Cisco Unified
Communications
Manager

Adding
TX9000 for
multisite
conference
from SX80
Codec
registered
with Unified
CM

UCJ10.6S.VCS.G.026

Passed500-32 -> Unified
CM -> SIP Trunk
-> Cisco VCS ->
SX80 Codec ->
Add ->Cisco VCS
-> SIP Trunk ->
Unified CM ->
TX9000

Verify whether Cisco
TelePresence TX9000
registered with Cisco
Unified
Communications
Manager can be added
for multisite
conference fromCisco
TelePresence SX80
Codec registered with
Cisco TelePresence
Video
Communication
Server

Adding
TX9000 for
multisite
conference
from SX80
Codec
registered
with Cisco
VCS

UCJ10.6S.VCS.G.027
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Passed500-32 -> Unified
CM cluster2 ->
SX80 Codec ->
Add ->Unified CM
cluster2 -> SIP
Trunk ->Unified
CM cluster 1 ->
TX9000

Verify whether Cisco
TelePresence TX9000
registered with Cisco
Unified
Communications
Manager cluster1 can
be added for multisite
conference fromCisco
TelePresence SX80
Codec registered with
Cisco Unified
Communications
Manager cluster2

Inter-cluster
multisite
conference
call from
SX80 Codec
to TX9000

UCJ10.6S.VCS.G.028

Passed500-32 -> Unified
CM -> TX9000
SX80 Codec ->
Unified CM ->
TX9000 -> Call
Forward Busy ->
MX300G2

Verify whether call
forward busy is
working for Cisco
TelePresence TX9000
registered in Cisco
Unified
Communications
Manager to Cisco
TelePresence
MX300G2 registered
in Cisco Unified
Communications
Manager

Call forward
busy in
TX9000 to
MX300G2
registered in
Unified CM

UCJ10.6S.VCS.G.029

Passed500-32 -> Unified
CM -> TX9000
->Call Forward No
Answer ->
MX300G2

Verify whether call
forward no answer is
working for Cisco
TelePresence TX9000
registered in Cisco
Unified
Communications
Manager to Cisco
TelePresence
MX300G2 registered
in Cisco Unified
Communications
Manager

Call forward
no answer in
TX9000 to
MX300G2
registered in
Unified CM

UCJ10.6S.VCS.G.030
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Passed500-32 -> Unified
CM cluster 2 ->
TX9000
EX90 -> Unified
CM cluster 2 ->
TX9000 -> Call
Forward busy ->
Unified CM cluster
2 -> SIP Trunk ->
Unified CM cluster
1 -> SX80 Codec

Verify whether the
call is forwarded to
Cisco TelePresence
SX80 Codec
registered in Cisco
Unified
Communications
Manager cluster 1
through SIP Trunk
when Cisco
TelePresence TX9000
registered in Cisco
Unified
Communications
Manager cluster 2 is
busy with other call

Call forward
busy in
TX9000 to
SX80 Codec
through SIP
Trunk

UCJ10.6S.VCS.G.031

Passed500-32 -> Unified
CM cluster 2->
TX9000 -> Call
Forward No
Answer -> Unified
CM cluster 2 ->
SIP Trunk ->
Unified CM cluster
1 -> SX80 Codec

Verify whether the
call is forwarded to
Cisco TelePresence
SX80 Codec
registered in Cisco
Unified
Communications
Manager cluster 1
through SIP Trunk
when Cisco
TelePresence TX9000
registered in Cisco
Unified
Communications
Manager cluster 2
leaves the call
unanswered

Call forward
no answer in
TX9000 to
SX80 Codec
through SIP
Trunk

UCJ10.6S.VCS.G.032

Passed500-32 -> Unified
CM -> TX9000
EX90 -> Unified
CM -> TX9000 ->
Call Forward Busy
-> SX80 Codec

Verify whether call
forward busy is
working for Cisco
TelePresence TX9000
registered in Cisco
Unified
Communications
Manager to Cisco
TelePresence SX80
Codec registered in
Cisco Unified
Communications
Manager

Call forward
busy in
TX9000 to
SX80 Codec
registered in
Unified CM

UCJ10.6S.VCS.G.033
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Passed500-32 -> Unified
CM -> TX9000
->Call Forward No
Answer -> SX80
Codec

Verify whether call
forward no answer is
working for Cisco
TelePresence TX9000
registered in Cisco
Unified
Communications
Manager to Cisco
TelePresence SX80
Codec registered in
Cisco Unified
Communications
Manager

Call forward
no answer in
TX9000 to
SX80 Codec
registered in
Unified CM

UCJ10.6S.VCS.G.034

PassedNAVerify whether the
'xStatus Video Output'
command given in
xAPI of the end point
Cisco TelePresence
System Integrator
Package C90 displays
the information about
the display device
connected to it

GettingEDID
information
about the
display
through
'xStatus
VideoOutput'
command
given in xAPI
of Integrator
Package C90

UCJ10.6S.VCS.G.035

PassedIntegrator Package
C90 -> Cisco
VCS-> EX90
Integrator Package
C90 -> Add ->
Cisco VCS ->
Cisco TelePresence
MX300-G2

Verify whether the
conference call can be
established among
Cisco TelePresence
System Integrator
Package C90, Cisco
TelePresence
MX300-G2 and Cisco
TelePresence System
EX90 all are
registered with Cisco
TelePresence Video
Communication
Server

Video
Conferencing
between
Integrator
Package C90,
MX300-G2
and EX90
registered
with Cisco
VCS

UCJ10.6S.VCS.G.036
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PassedIntegrator Package
C90 -> Unified
CM-> EX90
Integrator Package
C90 -> Add ->
Unified CM ->
Cisco TelePresence
MX300-G2

Verify whether the
conference call can be
established among
Cisco TelePresence
System Integrator
Package C90, Cisco
TelePresence System
EX90 and Cisco
TelePresence
MX300-G2 all are
registered with Cisco
Unified
Communications
Manager

Video
Conferencing
between
Integrator
Package C90,
EX90 and
MX300-G2
registered
with Unified
CM

UCJ10.6S.VCS.G.037

PassedEX90 -> Unified
CM -> Integrator
Package C90 ->
Hold/Transfer ->
Unified CM -> SIP
Trunk -> Cisco
VCS ->MX300-G2

Verify whether the
consultative call
transfer from Cisco
TelePresence System
Integrator Package
C90 registered with
Cisco Unified
Communications
Manager to Cisco
TelePresence
MX300-G2 registered
with Cisco
TelePresence Video
Communication
Server works success
fully

Consultative
Call Transfer
from
Integrator
Package C90
registered
with Unified
CM to
MX300-G2
registered
with Cisco
VCS

UCJ10.6S.VCS.G.038

PassedEX90 -> Cisco
VCS -> Integrator
Package C90 ->
Hold/Transfer ->
Cisco VCS -> SIP
Trunk -> Unified
CM -> Cisco
TelePresence
MX300 -G2

Verify whether the
consultative call
transfer from Cisco
TelePresence System
Integrator Package
C90 registered with
Cisco TelePresence
Video
Communication
Server to Cisco
TelePresence
MX300-G2 registered
with Cisco Unified
Communications
Manager works
successfully

Consultative
Call Transfer
from
Integrator
Package C90
registered
with Cisco
VCS to
MX300-G2
registered
with Unified
CM

UCJ10.6S.VCS.G.039
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PassedIntegrator Package
C90 ->Unified CM
-> Cisco
TelePresence
MX300-G2 ->
Presentation
sharing

Verify whether the
presentation in Cisco
TelePresence System
Integrator Package
C90 can be shared
with Cisco
TelePresence
MX300-G2 both
registered with
Unified CM

Presentation
sharing
between
Integrator
Package C90
and
MX300-G2
both are
registered
with Unified
CM

UCJ10.6S.VCS.G.040

PassedIntegrator Package
C90 -> Cisco VCS
-> Cisco
TelePresence
MX300-G2 ->
Presentation
Sharing

Verify whether the
presentation in Cisco
TelePresence System
Integrator Package
C90 can be shared
with Cisco
TelePresence
MX300-G2 both
registered with Cisco
TelePresence Video
Communication
Server.

Presentation
sharing
between
Integrator
Package C90
and
MX300-G2
both are
registered
with Cisco
VCS

UCJ10.6S.VCS.G.041

PassedIntegrator Package
C90 ->Unified CM
-> 500-32 ->
Presentation
sharing

Verify whether the
presentation in Cisco
TelePresence System
Integrator Package
C90 can be shared
with Cisco
TelePresence System
500-32 both registered
with Cisco Unified
Communications
Manager

Presentation
sharing
between
Integrator
Package C90
and 500-32
both are
registered
with Unified
CM

UCJ10.6S.VCS.G.042

PassedNAVerify whether the
'xStatus Video Output'
command given in
xAPI of the end point
Cisco TelePresence
SX20 Quick Set
displays the
information about the
display device
connected to it

GettingEDID
information
about the
display
through
xStatus Video
Output
command
given in xAPI
of SX20
Quick Set.

UCJ10.6S.VCS.G.043
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PassedSX20 Quick Set ->
CiscoVCS->EX90
SX20 Quick Set ->
Add -> Cisco VCS
-> MX300-G2

Verify whether the
conference call can be
established from
Cisco TelePresence
SX20 Quick Set to
Cisco TelePresence
MX300-G2 both
registered with Cisco
TelePresence Video
Communication
Server

Video
Conferencing
from SX20
Quick Set to
MX300-G2
both
registered
with Cisco
VCS

UCJ10.6S.VCS.G.044

PassedSX20 Quick Set ->
CiscoVCS->EX90
SX20 Quick Set ->
Add -> Cisco VCS
-> SIP Trunk ->
Unified CM ->
Cisco TelePresence
MX300-G2

Verify whether the
conference call can be
established from
Cisco TelePresence
SX20 Quick Set
registered with Cisco
TelePresence Video
Communication
Server to Cisco
TelePresence
MX300-G2 registered
with Cisco Unified
Communications
Manager.

Video
Conferencing
from SX20
Quick Set
registered
with Cisco
VCS to
MX300-G2
registered
with Unified
CM

UCJ10.6S.VCS.G.045

PassedSX10 Quick Set ->
Unified CM ->
Integrator Package
C90

Verify whether video
call from Cisco
TelePresence SX10
Quick Set to Cisco
TelePresence System
Integrator Package
C90 both are
registered with Cisco
Unified
Communications
Manager can be
established
successfully.

Making video
call from
SX10 Quick
Set to
Integrator
Package C90
both are
registered
with Unified
CM

UCJ10.6S.VCS.G.046
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PassedSX10 Quick Set ->
Unified CM ->
Integrator Package
C90 -> Hold /
Resume

Verify whether
Holding and
Resuming a video call
from Cisco
TelePresence SX10
Quick Set to Cisco
TelePresence System
Integrator Package
C90 both are
registered with Cisco
Unified
Communications
Manager works
successfully.

Hold and
Resume a
video call
from SX10
Quick Set to
Integrator
Package C90
both are
registered
with Unified
CM

UCJ10.6S.VCS.G.047

PassedSX10 Quick Set ->
Unified CM
cluster(1) -> SIP
Trunk -> Unified
CM cluster(2) ->
500-32

Verify whether inter
cluster video call from
Cisco TelePresence
SX10 Quick Set
registered with Cisco
Unified
Communications
Manager cluster(1) to
Cisco TelePresence
System 500-32
registered with Cisco
Unified
Communications
Manager cluster(2)
can be established
successfully.

Making inter
cluster video
call from
SX10 Quick
Set registered
with Unified
CMcluster(1)
to 500-32
registered
with Unified
CMcluster(2)

UCJ10.6S.VCS.G.048

PassedSX10 Quick Set ->
Unified CM ->
SX20 Quick Set

Verify whether video
call from Cisco
TelePresence SX10
Quick Set to Cisco
TelePresence SX20
Quick Set both are
registered with Cisco
Unified
Communications
Manager can be
established
successfully.

Making video
call from
SX10 Quick
Set to SX20
Quick Set
both are
registered
with Unified
CM

UCJ10.6S.VCS.G.049
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PassedSX10 Quick Set ->
Unified CM ->
SX20 Quick Set ->
Hold / Resume

Verify whether
Holding and
Resuming a video call
from Cisco
TelePresence SX10
Quick Set to Cisco
TelePresence SX20
Quick Set both are
registered with Cisco
Unified
Communications
Manager works
successfully.

Hold and
Resumevideo
call from
SX10 Quick
Set to SX20
Quick Set
both are
registered
with Unified
CM

UCJ10.6S.VCS.G.050

PassedMX200-G2 ->
Unified CM ->
500-32

Verify whether video
call from Cisco
TelePresence
MX200-G2 to Cisco
TelePresence System
500-32 both are
registered with Cisco
Unified
Communications
Manager can be
established
successfully.

Making video
call from
MX200-G2
to 500-32
both are
registered
with Unified
CM

UCJ10.6S.VCS.G.051

PassedMX200-G2 ->
Unified CM -> SIP
Trunk -> Cisco
VCS->MX300-G2

Verify whether video
call from Cisco
TelePresence
MX200-G2 registered
with Cisco Unified
Communications
Manager to Cisco
TelePresence
MX300-G2 registered
with Cisco
TelePresence Video
Communication
Server can be
established
successfully.

Making video
call from
MX200-G2
registered
with Unified
CM to
MX300-G2
registered
with Cisco
VCS.

UCJ10.6S.VCS.G.052
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PassedMX200-G2 ->
Unified CM ->
Integrator Package
C90

Verify whether video
call from Cisco
TelePresence
MX200-G2 to Cisco
TelePresence System
Integrator Package
C90 both are
registered with Cisco
Unified
Communications
Manager can be
established
successfully.

Making video
call from
MX200-G2
to Integrator
Package C90
both are
registered
with Unified
CM

UCJ10.6S.VCS.G.053

PassedMX200-G2 ->
Unified CM
cluster(1) -> SIP
Trunk -> Unified
CM cluster(2) ->
500-32

Verify whether inter
cluster video call from
Cisco TelePresence
MX200-G2 registered
with Cisco Unified
Communications
Manager cluster(1) to
Cisco TelePresence
System 500-32
registered with Cisco
Unified
Communications
Manager cluster(2)
can be established
successfully.

Making inter
cluster video
call from
MX200-G2
registered
with Unified
CMcluster(1)
to 500-32
registered
with Unified
CMcluster(2)

UCJ10.6S.VCS.G.054

PassedMX200-G2 ->
Unified CM ->
SX20 Quick Set

Verify whether video
call from Cisco
TelePresence
MX200-G2 to Cisco
TelePresence SX20
Quick Set both are
registered with Cisco
Unified
Communications
Manager can be
established
successfully.

Making video
call from
MX200-G2
to SX20
Quick Set
both are
registered
with Unified
CM

UCJ10.6S.VCS.G.055
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PassedMX200-G2 ->
Unified CM ->
SX20 Quick Set ->
Hold / Resume

Verify whether
Holding and
Resuming a video call
from Cisco
TelePresence
MX200-G2 to Cisco
TelePresence SX20
Quick Set both are
registered with Cisco
Unified
Communications
Manager works
successfully.

Hold and
Resumevideo
call from
MX200-G2
to SX20
Quick Set
both are
registered
with Unified
CM

UCJ10.6S.VCS.G.056

PassedMX200-G2 ->
Unified CM ->
500-32
MX200-G2 ->Add
-> Unified CM ->
SX20 Quick Set

Verify whether the
conference call among
Cisco TelePresence
MX200-G2, Cisco
TelePresence System
500-32 and Cisco
TelePresence SX20
Quick Set registered
with Cisco Unified
Communications
Manager can be
established
successfully.

Making
Conference
call among
MX200-G2 ,
500-32 and
SX20 Quick
Set all are
registered
with Unified
CM

UCJ10.6S.VCS.G.057

PassedMX200-G2 ->
Unified CM ->
500-32
MX200-G2 -> Add
-> Unified CM ->
Integrator Package
C90

Verify whether the
conference call among
Cisco TelePresence
MX200-G2, Cisco
TelePresence System
500-32 and Cisco
TelePresence System
Integrator Package
C90 registered with
Cisco Unified
Communications
Manager can be
established
successfully.

Making
Conference
call among
MX200-G2 ,
500-32 and
Integrator
Package C90
all are
registered
with Unified
CM

UCJ10.6S.VCS.G.058
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Passed500-32 -> Unified
CM -> MX300-G2

Verify whether video
call from Cisco
TelePresence System
500-32 to Cisco
TelePresence
MX300-G2 both are
registered with Cisco
Unified
Communications
Manager can be
established
successfully.

Making video
call from
500-32 to
MX300-G2
both are
registered
with Unified
CM

UCJ10.6S.VCS.G.059

Passed500-32 -> Unified
CM -> SIP Trunk
-> Cisco VCS ->
MX300-G2

Verify whether video
call from Cisco
TelePresence System
500-32 registeredwith
Cisco Unified
Communications
Manager to Cisco
TelePresence
MX300-G2 registered
with Cisco
TelePresence Video
Communication
Server can be
established.

Making video
call from
500-32
registered
with Unified
CM to
MX300-G2
registered
with Cisco
VCS

UCJ10.6S.VCS.G.060

Passed500-32-> Unified
CM-> EX90
500-32-> Add
->Unified CM ->
MX300-G2

Verify whether the
conference call can be
established from
Cisco TelePresence
System 500-32 to
Cisco TelePresence
MX300-G2 both are
registered with Cisco
Unified
Communications
Manager

Multisite
Conferencing
between
500-32, EX90
and
MX300-G2
are registered
with Unified
CM

UCJ10.6S.VCS.G.061
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Passed500-32-> Unified
CM -> SIP Trunk
-> Cisco VCS ->
EX90
500-32-> Unified
CM -> Add -> SIP
Trunk -> Cisco
VCS ->MX300-G2

Verify whether the
conference call can be
established from
Cisco TelePresence
System 500-32
registered with Cisco
Unified
Communications
Manager to Cisco
TelePresence
MX300-G2 registered
with Cisco
TelePresence Video
Communication
Server

Conferencing
from 500-32
registered
with Unified
CM to
MX300-G2
registered
with Cisco
VCS

UCJ10.6S.VCS.G.062

Passed500-32 -> Unified
CM -> Cisco
TelePresence SX80
Codec

Verify whether the
video call from Cisco
TelePresence System
500-32 can be
established to Cisco
TelePresence SX80
Codec both are
registered with Cisco
Unified
Communications
Manager

Making
Video Call
from 500-32
to SX80
Codec both
are registered
with Unified
CM

UCJ10.6S.VCS.G.063

Passed500-32 -> Unified
CM - > SIP Trunk
-> Cisco VCS ->
Cisco TelePresence
SX80 Codec

Verify whether the
video call from Cisco
TelePresence System
500-32 registeredwith
Cisco Unified
Communications
Manager can be
established to Cisco
TelePresence SX80
Codec registered with
Cisco TelePresence
Video
Communication
Server

Making
Video Call
from 500-32
registered
with Unified
CM to SX80
Codec
registered
with Cisco
VCS

UCJ10.6S.VCS.G.064
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Passed500-32-> Unified
CM-> EX90
500-32-> Add
->Unified CM ->
SX80 Codec

Verify whether the
conference call can be
established from
Cisco TelePresence
System 500-32 to
Cisco TelePresence
SX80 Codec both are
registered with Cisco
Unified
Communications
Manager

Conferencing
among
500-32,EX90
and SX80
Codec
registered
with Unified
CM

UCJ10.6S.VCS.G.065

Passed500-32 -> Unified
CM Cluster(1) ->
SIP Trunk ->
Unified CM
Cluster(2) -> SX80
Codec

Verify whether the
inter-cluster call from
Cisco TelePresence
System 500-32
registered with Cisco
Unified
Communications
Manager Cluster (1)
to Cisco TelePresence
SX80 Codec
registered with Cisco
Unified
Communications
Manager Cluster (2)
can be established.

Making
Inter-Cluster
Call from
500-32
registered
with Unified
CM Cluster
(1) to SX80
Codec
registered
with Unified
CM Cluster
(2).

UCJ10.6S.VCS.G.066

Passed500-32(Presentation
Sharing) -> Unified
CM Cluster(1) ->
SIP Trunk ->
Unified CM
Cluster(2) -> SX80
Codec

Verify whether the
presentation from
Cisco TelePresence
System 500-32
registered with Cisco
Unified
Communications
Manager Cluster(1)
can be shared with
Cisco TelePresence
SX80 Codec
registered with Cisco
Unified
Communications
Manager Cluster(2)
successfully.

Presentation
sharing from
500-32
registered
with Unified
CM
Cluster(1) to
SX80 Codec
registered
with Unified
CM
Cluster(2).

UCJ10.6S.VCS.G.067
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Passed500-32(Presentation
Sharing) -> Unified
CM Cluster(1) ->
SIP Trunk ->
Unified CM
Cluster(2) ->
MX300-G2

Verify whether the
inter-cluster call from
Cisco TelePresence
System 500-32
registered with Cisco
Unified
Communications
Manager Cluster(1) to
Cisco TelePresence
MX300-G2 registered
with Cisco Unified
Communications
Manager Cluster(2)
can be established.

Presentation
sharing from
500-32
registered
with Unified
CM
Cluster(1) to
Cisco
TelePresence
MX300-G2
registered
with Unified
CM
Cluster(2).

UCJ10.6S.VCS.G.068

Passed500-32(Presentation
Sharing) -> Unified
CM -> SIP Trunk
-> Cisco VCS ->
SX80 Codec

Verify whether the
presentation from
Cisco TelePresence
System 500-32
registered with Cisco
Unified
Communications
Manager can be
shared with Cisco
TelePresence SX80
Codec registered with
Cisco TelePresence
Video
Communication
Server successfully.

Presentation
sharing from
500-32
registered
with Unified
CM to SX80
Codec
registered
with Cisco
VCS

UCJ10.6S.VCS.G.069

Passed500-32(Presentation
Sharing) -> Unified
CM -> SIP Trunk
->Cisco VCS ->
MX300-G2

Verify whether the
presentation from
Cisco TelePresence
System 500-32
registered with Cisco
Unified
Communications
Manager can be
shared with Cisco
TelePresence
MX300-G2 registered
with Cisco
TelePresence Video
Communication
Server successfully.

Presentation
sharing from
500-32
registered
with Unified
CM to
MX300-G2
registered
with Cisco
VCS

UCJ10.6S.VCS.G.070
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PassedEX90 -> Unified
CM -> 500-32 ->
Call forward all - >
Unified CM -> SIP
Trunk -> Cisco
VCS ->MX300-G2

Verify whether video
call to Cisco
TelePresence System
500-32 registeredwith
Cisco Unified
Communications
Manager can be
forwarded to Cisco
TelePresence
MX300-G2 registered
with Cisco
TelePresence Video
Communication
Server.

Call Forward
All in 500-32
registered
with Unified
CM to
MX300-G2
registered
with Cisco
VCS

UCJ10.6S.VCS.G.071

Passed500-32 ->Unified
CM -> MX300G2
-> Hold/Resume

Verify whether
Hold/Resume of a
video call between
Cisco TelePresence
System 500-32 and
Cisco TelePresence
MX300-G2 both
registered in Cisco
Unified
Communications
Manager works
successfully

Hold/Resume
a video call
between
500-32 and
MX300-G2

UCJ10.6S.VCS.G.072

Passed500-32 ->Unified
CM ->SX80Codec
-> Hold/Resume

Verify whether
Hold/Resume of a
video call between
System Cisco
TelePresence System
500-32 and Cisco
TelePresence Cisco
TelePresence SX80
Codec both are
registered in Cisco
Unified
Communications
Manager works
successfully

Hold/Resume
a video call
between
500-32 and to
SX80 Codec

UCJ10.6S.VCS.G.073

CSCur60996FailedNAVerify whether the
changes of language
in Cisco TelePresence
SX10 Quick Set
works successfully

Checking the
language
changes in
SX10 Quick
Set

UCJ10.6S.VCS.G.074
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CSCur60216FailedNAVerify whether the
number of languages
present in Web GUI,
Touch UI and remote
usage of Cisco
TelePresence SX10
Quick Set are equal

Comparing
the number of
languages
Present and
supported by
Web GUI,
Touch UI and
remote usage
of SX10
Quick Set

UCJ10.6S.VCS.G.075

CSCur60272FailedJabber Guest
(Windows) ->
Cisco
Expressway-E ->
Expressway-C ->
Unified CM ->
EX90

To verify that user is
able to make a video
call fromCisco Jabber
Guest on Windows to
EX90 and disable
video mute

Make a video
call from
Cisco Jabber
Guest on
Windows to
EX90 and
Disable video
mute

UCJ10.6S.VCS.G.076

CSCur59459FailedJabber Guest
(Windows) ->
Cisco
Expressway-E ->
Expressway-C ->
Unified CM -> SIP
Trunk -> Cisco TS
7010

To Verify that user is
able to make meet me
conference fromCisco
Jabber Guest on
Windows to Cisco TS
7010 and verify the
caller name is
displaying correctly

Caller name
in Cisco
Jabber Guest
client while
making Meet
me
conference
video call
from Cisco
Jabber Guest
on Windows
to Cisco TS
7010

UCJ10.6S.VCS.G.077

Cisco Jabber for iPhone and iPad
DefectsStatusCall Component FlowDescriptionTitleLogical ID

PassedIP Phone -> Unified
CM -> Jabber for
iPhone

Verify whether
Jabber for
iPhone can able
to park the
incoming call
from IP Phone
successfully

Park the
incoming call
from IP Phone
in Jabber for
iPhone

UCJ10.6S.CJI.G.001
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PassedIP Phone A -> Unified
CM -> IP Phone B ->
Unified CM -> Jabber
for iPhone

Verify whether
Jabber for
iPhone can able
to park the
transferred call
from IP Phone
successfully

Park the
transferred call
from IP Phone
in Jabber for
iPhone

UCJ10.6S.CJI.G.004

PassedIP Phone A -> Unified
CM -> IP Phone B ->
Unified CM -> Jabber
for iPhone

Verify whether
Cisco Jabber for
iPhone can able
to park the
forwarded
incoming call
from IP Phone
successfully
when the call
forward all is
enabled

Park the
forwarded call
from IP Phone
in Jabber for
iPhone when the
call forward all
is enabled

UCJ10.6S.CJI.G.013

PassedIP Phone A -> Unified
CM1 -> SIP Trunk ->
Unified CM2 -> Jabber
for iPhone

Verify whether
Cisco Jabber for
iPhone can able
to park the
incoming call
from IP Phone
after hold and
resume the call
via SIP Trunk
successfully

Park the
incoming call
from IP Phone
in Jabber for
iPhone after
hold and resume
the call via SIP
Trunk

UCJ10.6S.CJI.G.026

PassedJabber for iPhone1 ->
Unified CM -> Jabber
for iPhone2

Verify whether
Jabber for
iPhone2 can
able to park the
incoming call
from Jabber for
iPhone1
successfully

Park the
incoming call
from Jabber for
iPhone in Jabber
for iPhone

UCJ10.6S.CJI.G.031

PassedIP Phone -> Unified
CM -> Jabber for
iPhone

Verify whether
audio statistics
shown in Jabber
for iPhone when
audio call made
between the IP
Phone and
Jabber for
iPhone
successfully

Check the audio
statistics in
Jabber for
iPhone while
incoming call
from IP Phone

UCJ10.6S.CJI.G.036
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PassedIP Phone -> Unified
CM -> Jabber for
iPhone

Verify whether
video statistics
shown in the
Jabber for
iPhone when
video call made
between the IP
Phone and
Jabber for
iPhone
successfully

Check the video
statistics in the
Jabber for
iPhone while
incoming call
from IP Phone

UCJ10.6S.CJI.G.039

PassedCisco TelePresence
System EX90 ->
Unified CM -> Jabber
for iPhone

Verify whether
video statistics
shown in the
Jabber for
iPhone when
video call made
between the
Cisco
TelePresence
System EX90
and Jabber for
iPhone
successfully

Check the video
statistics in the
Jabber for
iPhone while
incoming call
from Cisco
TelePresence
System EX90

UCJ10.6S.CJI.G.042

PassedNAVerify whether
Instant
Messaging can
be sent from
Jabber for
iPhone1 to
Jabber for
iPhone2
successfully

Send Instant
Messaging from
Jabber for
iPhone1 to
Jabber for
iPhone2

UCJ10.6S.CJI.G.043

PassedIP Phone -> Unified
CM1 -> SIP Trunk ->
Unified CM2 -> Jabber
for iPhone

Verify whether
audio statistics
shown in the
Jabber for
iPhone when
audio call made
between the IP
Phone and
Jabber for
iPhone via SIP
Trunk
successfully

Check the audio
statistics in the
Jabber for
iPhone while
incoming call
from IP Phone
via SIP Trunk

UCJ10.6S.CJI.G.037
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PassedIP Phone -> Unified
CM -> Jabber for
iPhone

Verify whether
audio statistics
has been shown
in the Jabber for
iPhone while
incoming call
from IP Phone
after done hold
and resume in
Jabber for
iPhone
successfully

Check the audio
statistics in the
Jabber for
iPhone while
incoming call
from IP Phone
after hold and
resume

UCJ10.6S.CJI.G.041

PassedIP Phone A -> Unified
CM1 -> SIP Trunk ->
Unified CM2 -> IP
Phone B -> Unified
CM2 -> Jabber for
iPhone

Verify whether
Cisco Jabber for
iPhone can able
to park the
forwarded
incoming call
from IP Phone
via SIP trunk
successfully
when the call
forward no
answer is
enabled

Park the
forwarded call
from IP Phone
in Jabber for
iPhone via SIP
Trunk when the
call forward no
answer is
enabled

UCJ10.6S.CJI.G.020

PassedIP Phone -> Unified
CM -> Jabber for iPad

Verify whether
Jabber for iPad
can able to park
the incoming
call from IP
Phone
successfully

Park the
incoming call
from IP Phone
in Jabber for
iPad

UCJ10.6S.CJIPad.G.001

PassedIP Phone A -> Unified
CM -> IP Phone B ->
Unified CM -> Jabber
for iPad

Verify whether
Jabber for iPad
can able to park
the transferred
call from IP
Phone
successfully

Park the
transferred call
from IP Phone
in Jabber for
iPad

UCJ10.6S.CJIPad.G.004

   Test Results for Cisco Unified Communications System Release 10.6 for Japan
54

Test Results Summary
Cisco Jabber for iPhone and iPad



PassedIP Phone A -> Unified
CM -> IP Phone B ->
Unified CM -> Jabber
for iPad

Verify whether
Cisco Jabber for
iPad can able to
park the
forwarded
incoming call
from IP Phone
successfully
when the call
forward all is
enabled

Park the
forwarded call
from IP Phone
in Jabber for
iPad when the
call forward all
is enabled

UCJ10.6S.CJIPad.G.013

PassedIP Phone A -> Unified
CM1 -> SIP Trunk ->
Unified CM2 -> Jabber
for iPad

Verify whether
Cisco Jabber for
iPad can able to
park the
incoming call
from IP Phone
after hold and
resume the call
via SIP Trunk
successfully

Park the
incoming call
from IP Phone
in Jabber for
iPad after hold
and resume the
call via SIP
Trunk

UCJ10.6S.CJIPad.G.026

PassedJabber for iPad1 ->
Unified CM -> Jabber
for iPad2

Verify whether
Jabber for iPad
2 can able to
park the
incoming call
from Jabber for
iPad 1
successfully

Park the
incoming call
from Jabber for
iPad in Jabber
for iPad

UCJ10.6S.CJIPad.G.031

PassedIP Phone -> Unified
CM -> Jabber for iPad

Verify whether
audio statistics
shown in the
Jabber for iPad
when audio call
made between
the IP Phone and
Jabber for iPad
successfully

Check the audio
statistics in the
Jabber for iPad
while incoming
call from IP
Phone

UCJ10.6S.CJIPad.G.036

PassedIP Phone -> Unified
CM -> Jabber for iPad

Verify whether
video statistics
shown in the
Jabber for iPad
when video call
made between
the IP Phone and
Jabber for iPad
successfully

Check the video
statistics in the
Jabber for iPad
while incoming
call from IP
Phone

UCJ10.6S.CJIPad.G.039
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PassedCisco TelePresence
System EX90 ->
Unified CM -> Jabber
for iPad

Verify whether
video statistics
shown in the
Jabber for iPad
when video call
made between
the Cisco
TelePresence
System EX90
and Jabber for
iPad
successfully

Check the video
statistics in the
Jabber for iPad
while incoming
call from Cisco
TelePresence
System EX90

UCJ10.6S.CJIPad.G.042

PassedNAVerify whether
Instant
Messaging can
be sent from
Jabber for iPad1
to Jabber for
iPad2
successfully

Send Instant
Messaging from
Jabber for iPad1
to Jabber for
iPad2

UCJ10.6S.CJIPad.G.043

PassedIP Phone -> Unified
CM1 -> SIP Trunk ->
Unified CM2 -> Jabber
for iPad

Verify whether
audio statistics
shown in the
Jabber for iPad
when audio call
made between
the IP Phone and
Jabber for iPad
via SIP Trunk
successfully

Check the audio
statistics in the
Jabber for iPad
while incoming
call from IP
Phone via SIP
Trunk

UCJ10.6S.CJIPad.G.037

PassedIP Phone -> Unified
CM1 -> Jabber for iPad

Verify whether
audio statistics
has been shown
in the Jabber for
iPad while
incoming call
from IP Phone
after done hold
and resume in
Jabber for iPad
successfully

Check the audio
statistics in the
Jabber for iPad
while incoming
call from IP
Phone after hold
and resume

UCJ10.6S.CJIPad.G.041

   Test Results for Cisco Unified Communications System Release 10.6 for Japan
56

Test Results Summary
Cisco Jabber for iPhone and iPad



PassedIP Phone A -> Unified
CM1 -> SIP Trunk ->
Unified CM2 -> IP
Phone B -> Unified
CM2 -> Jabber for iPad

Verify whether
Cisco Jabber for
iPad can able to
park the
forwarded
incoming call
from IP Phone
via SIP trunk
successfully
when the call
forward no
answer is
enabled

Park the
forwarded call
from IP Phone
in Jabber for
iPad via SIP
Trunk when the
call forward no
answer is
enabled

UCJ10.6S.CJIPad.G.020

Cisco Jabber for Android
DefectsStatusCall Component

flow
DescriptionTitleLogical ID

PassedIP Phone A ->
Unified CM ->
Jabber for Android

Verify whether
Jabber for Android
can able to park the
incoming call from
IP Phone
successfully

Park the
incoming call
from IP Phone
in Jabber for
Android

UCJ10.6S.CJA.G.001

PassedIP Phone A ->
Unified CM1 -> SIP
Trunk -> Unified
CM2 -> Jabber for
Android

Verify whether
Jabber for Android
can able to park the
incoming call from
IP Phone via SIP
Trunk successfully

Park the
incoming call
from IP Phone
in Jabber for
Android via SIP
Trunk

UCJ10.6S.CJA.G.002

PassedIP Phone A ->
Unified CM -> IP
Phone B -> Unified
CM -> Jabber for
Android

Verify whether
Jabber for Android
can able to park the
transferred call from
IP Phone
successfully

Park the
transferred call
from IP Phone
in Jabber for
Android

UCJ10.6S.CJA.G.004

PassedIP Phone A ->
Unified CM1 -> SIP
Trunk -> Unified
CM2 -> IP Phone B
-> Unified CM2 ->
Jabber for Android

Verify whether
Jabber for Android
can able to park the
consult transferred
call from IP Phone
via SIP Trunk
successfully

Park the
transferred call
from IP Phone
in Jabber for
Android via SIP
Trunk

UCJ10.6S.CJA.G.008
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PassedIP Phone A ->
Unified CM -> IP
Phone B -> Unified
CM -> IP Phone C
-> Unified CM ->
Jabber for Android

Verify whether
Jabber for Android
can able to park the
chain transfer call
from IP Phone
successfully

Park the chain
transferred call
from IP Phone
in Jabber for
Android

UCJ10.6S.CJA.G.010

PassedIP Phone A ->
Unified CM ->
Jabber for Android

Verify whether
Cisco Jabber for
Android can able to
park the incoming
call from IP Phone
after hold and
resume the call
successfully

Park the
incoming call
from IP Phone
in Jabber for
Android after
hold and resume
the call

UCJ10.6S.CJA.G.025

PassedIP Phone A ->
Unified CM ->
Jabber for Android

Verify whether
audio statistics
shown in Jabber for
Androidwhen audio
call made between
the IP Phone and
Jabber for Android
successfully

Check the audio
statistics in the
Jabber for
Android while
incoming call
from IP Phone

UCJ10.6S.CJA.G.036

PassedIP Phone A ->
Unified CM ->
Jabber for Android

Verify whether
video statistics
shown in Jabber for
Androidwhen video
call made between
IP Phone and Jabber
for Android
successfully

Check the video
statistics in
Jabber for
Android while
incoming call
from IP Phone

UCJ10.6S.CJA.G.039

PassedNAVerify whether
image file can be
sent from Jabber for
Android1 to Jabber
for Android2 during
Instant Messaging
successfully

Send image file
from Jabber for
Android1 to
Jabber for
Android2 during
Instant
Messaging

UCJ10.6S.CJA.G.046

PassedNAVerify whether
video file can be
sent from Jabber for
Android1 to Jabber
for Android2 during
Instant Messaging
successfully

Send video file
from Jabber for
Android1 to
Jabber for
Android2 during
Instant
Messaging

UCJ10.6S.CJA.G.049
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PassedIP Phone A ->
Unified CM -> IP
Phone B -> Unified
CM -> Jabber for
Android

Verify whether
Cisco Jabber for
Android can able to
park the forwarded
incoming call from
IP Phone
successfully when
the call forward all
is enabled

Park the
forwarded call
from IP Phone
in Jabber for
Android when
call forward all
is enabled

UCJ10.6S.CJA.G.013

PassedIP Phone A ->
Unified CM1 -> SIP
Trunk -> Unified
CM2 -> IP Phone B
-> Unified CM2 ->
Jabber for Android

Verify whether
Cisco Jabber for
Android can able to
park the forwarded
incoming call from
IP Phone via SIP
Trunk successfully
when the call
forward all is
enabled

Park the
forwarded call
from IP Phone
in Jabber for
Android via SIP
Trunk when the
call forward all
is enabled

UCJ10.6S.CJA.G.014

PassedIP Phone B ->
Unified CM -> IP
Phone C -> Unified
CM -> IP Phone A
->Unified CM -> IP
Phone B -> Unified
CM -> Jabber for
Android

Verify whether
Cisco Jabber for
Android can able to
park the forwarded
incoming call from
IP Phone
successfully when
the call forward
busy is enabled

Park the
forwarded call
from IP Phone
in Jabber for
Android when
call forward
busy is enabled

UCJ10.6S.CJA.G.016

PassedJabber for Android
-> Unified CM ->
Jabber for iPhone

Verify whether
Jabber for iPhone
can able to park the
incoming call from
Jabber for Android
successfully

Park the
incoming call
from Jabber for
Android in
Jabber for
iPhone

UCJ10.6S.CJA.G.028

PassedIP Phone -> Unified
CM1 -> SIP Trunk
-> Unified CM2 ->
Jabber for Android

Verify whether
audio statistics
shown in the Jabber
for Android when
audio call made
between the IP
Phone and Jabber
for Android via SIP
Trunk successfully

Check the audio
statistics in the
Jabber for
Android while
incoming call
from IP Phone
via SIP Trunk

UCJ10.6S.CJA.G.037
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PassedNAVerify whether
Instant Messaging
can be sent from
Jabber for Android1
to Jabber for
Android2
successfully

Send Instant
Messaging from
Jabber for
Android1 to
Jabber for
Android2

UCJ10.6S.CJA.G.043

Cisco Jabber for Windows
DefectsStatusCall Component

flow
DescriptionTitleLogical ID

PassedCJW A -> Unified
CM 1 -> SIP trunk
-> Unified CM 2 ->
CJW B

Verify that Cisco
Jabber for Windows
B attends the
incoming call from
Cisco Jabber for
Windows A via SIP
Trunk and CJW A
checks the call
statistics details

Make call from
CJW A to CJW
B via SIP Trunk
and validate the
call statistics

UCJ10.6S.CJW.G.006

PassedCJW A -> Unified
CM -> CJW B

Verify that specified
ring tone is heard
successfully while
receiving incoming
call in Cisco Jabber
for Windows B

Validate
personal ring
tone in CJW

UCJ10.6S.CJW.G.011

PassedCJW A -> Unified
CM1 -> H.323 ->
CUBE -> H.323 ->
Unified CM2 ->
CJW B

Verify that specified
ring tone is heard
successfully in CJW
B while receiving
incoming call from
Cisco Jabber for
Windows A via
CUBE throughH.323
to H.323
inter-working

Make call from
CJW A to CJW
Bvia CUBE and
check specified
ring tone

UCJ10.6S.CJW.G.014

PassedNAVerify that Cisco
Jabber for Windows
A initiates IM chat
with Cisco Jabber for
Windows B and chats
has been saved
successfully

Auto save IM by
Cisco Jabber for
Windows

UCJ10.6S.CJW.G.035
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PassedNAVerify that Cisco
Jabber for Windows
A initiates IM chat
with Cisco Jabber for
Windows B and
check whether print
IM option is available

Validate print
IM option in
Cisco Jabber for
Windows

UCJ10.6S.CJW.G.036

PassedNAVerify that in Cisco
Jabber for Windows
IM spell check works
successfully in
Windows 8 EN
platform

Spell check in
Cisco Jabber for
Windows using
Windows 8 EN
platform

UCJ10.6S.CJW.G.001

PassedNAVerify that "Alert
when available" pop
up notification
appears when the user
becomes "available"
from "away" state

Enable "Alert
when available"
for an user in
Jabber for
Windows

UCJ10.6S.CJW.G.051

PassedNAVerify that during
chat with multiple
users, drag and drop
of conversation tab in
chat window is
working successfully

Conversation
Tab reordering
in Jabber for
Windows

UCJ10.6S.CJW.G.052

PassedNAVerify that user can
able to send protected
chat messages in chat
window using
security label
successfully

Protected chat
messages in
Jabber for
Windows

UCJ10.6S.CJW.G.054

Cisco Jabber for Mac
DefectsStatusCall Component flowDescriptionTitleLogical ID

PassedCJM1 -> Unified CM1
-> CJM2 -> Unified
CM1 -> SIP Trunk ->
Unified CM2 -> CJW1

Verify Call is
Forwarded from
CJM2 to CJW1
via SIP trunk
while making
call from CJM1
to CJM2

Inter-cluster
Call Forward in
Cisco Jabber for
Mac

UCJ10.6S.CJM.G.121
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PassedCJM1 -> Unified CM1
-> CJM2 -> Unified
CM1 -> CJA

Verify Call is
Transferred
from CJM to
CJA while
making Call
from CJM1 to
CJM2

Transfer Call
from Jabber for
Mac to Jabber
for Android

UCJ10.6S.CJM.G.122

PassedCJM1 -> Unified CM1
-> CJM2 -> Unified
CM1 -> ICT Trunk ->
Unified CM2 -> Phone
C (9971)

Verify Call is
Transferred
from CJM to IP
Phone 9971 via
ICTTrunkwhile
making call
from CJM1 to
CJM2

Transfer Call
from Jabber for
Mac to IP Phone
9971 via ICT
Trunk

UCJ10.6S.CJM.G.123

PassedNAVerify Group
chats are sent
from Jabber for
Mac to 2 or
more users

Send Group
Chats to
multiple users in
Jabber for Mac

UCJ10.6S.CJM.G.124

PassedNAVerify whether
theMac user can
share desktop
with CJW user
successfully

SharingDesktop
from Mac user
to CJW user

UCJ10.6S.CJM.G.125

PassedCJM1 -> Unified CM1
-> CJM2

Verify whether
the call is
established
successfully
from CJM1 to
CJM2 while
making call
from CJM1 to
CJM2 by dialing
URI of the
CJM2 user

Intra-cluster
URI Dialing in
Jabber for Mac

UCJ10.6S.CJM.G.126

PassedNAVerify WebEx
meeting is
established
between CJM
and CJW while
sending WebEx
Meeting request
from CJM to
CJW

Start WebEx
Meeting from
Cisco Jabber for
Mac to Cisco
Jabber for
Windows

UCJ10.6S.CJM.G.127
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PassedCJM ->Unified CM1 ->
CUBE -> Unified CM2
-> Phone A (6941)

Verify Chats are
sent successfully
from CJM to
CJA while call
is in progress
between CJM
and IP Phone via
CUBE

SendChats from
CJM to CJA
while call is in
progress
between CJM
and IP Phone
via CUBE

UCJ10.6S.CJM.G.128

PassedNAVerify files (txt,
pdf, images,
docs) are
transferred from
CJM1 user to
CJM2 user
successfully

File Transfer in
Cisco Jabber for
Mac

UCJ10.6S.CJM.G.129

PassedNAVerify audio
files are
transferred from
Jabber for Mac
to Jabber for
Windows
successfully

Audio file
transfer in
Jabber for Mac

UCJ10.6S.CJM.G.130

PassedCJM ->Unified CM1 ->
CJW

Verify files are
transferred from
CJM to CJW
while call is in
progress
between Jabber
for Mac and
Jabber for
Windows

Send files from
Cisco Jabber for
Mac when call
is in progress
with Cisco
Jabber for
Windows

UCJ10.6S.CJM.G.131

PassedNAVerify chats
should not sent
from Jabber for
Mac to Jabber
for Android user
when Jabber for
Android user is
in blocked state

Send Chats for
blocked users
from Jabber for
Mac to Jabber
for Android

UCJ10.6S.CJM.G.132
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PassedCJM ->Unified CM1 ->
CJI

Verify whether
the call is
established
successfully
between CJM
and Jabber for
iPhone when
Jabber for
iPhone is
blocked in CJM

Make call to
blocked users
from Jabber for
Mac

UCJ10.6S.CJM.G.133

PassedCJM ->Unified CM1 ->
CUBE -> Unified CM2
-> Phone A (9951)

Verify Screen
captures are sent
from CJM to
CJW when call
is in progress
between CJM
and IP Phone via
CUBE

Send Screen
Captures when
call is in
progress
between CJM
and IP Phone
via CUBE

UCJ10.6S.CJM.G.134

PassedCJM ->Unified CM1 ->
PSTN -> Unified CM2
-> Phone A (DX650)

Verify call is
established from
Jabber for MAC
to DX650 via
PSTN
successfully

Make call from
CJM to DX650
via PSTN

UCJ10.6S.CJM.G.135

PassedNAVerify states are
changed by
changing the
custom states in
Jabber for Mac

Custom state in
Cisco Jabber for
Mac

UCJ10.6S.CJM.G.136

PassedNAVerify
emoticons are
sent from Jabber
for Mac to
Jabber for
Android while
chatting

Send chats with
emoticons in
Jabber for Mac

UCJ10.6S.CJM.G.137

Cisco Unified Survivable Remote Site Telephony
DefectsStatusCall Component

flow
DescriptionTitleLogical ID
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PassedPhone A (99xx) ->
Unified SRST ->
Phone B

Verify that speed dial in
99xx IP phone is
assigned successfully
and Cisco Unified IP
phone 99xx makes call
to IP phone B using
speed dial button

Assign speed
dial for 99xx IP
phone and
initiate call
using speed dial

UCJ10.6S.SRST.G.201

PassedPhone A ->Unified
SRST -> Phone B
(99xx) -> Phone C

Verify that call forward
is set in 99xx DN
configuration page and
IP phone A initiates call
to 99xx and check
whether call gets
forwarded to IP phone C
successfully during fail
over

Set Call forward
in Phone DN
page of 99xx in
Unified CM and
provision it in
fallback

UCJ10.6S.SRST.G.205

PassedPhone A ->Unified
SRST -> Phone B
(69xx) -> Phone C

Verify that call forward
is set successfully in
69xx SIP phone DN
page and after
provisioning and during
fallback check whether
call forward is
configured successfully
and validate call gets
forwarded to IP phone C
successfully when call
initiated from IP phone
A to 69xx IP phone

Assign call
forward in 69xx
SIP phone DN
page and
validate during
fail over

UCJ10.6S.SRST.G.207

PassedPhone A (99xx) ->
Unified SRST ->
Phone B

Verify that Line Text
Label configured in 99xx
IP phone is successful
and during fallback
check in 99xx IP phone
Line Text Label is
displayed correctly

Display of Line
Text Label in
99xx IP phone

UCJ10.6S.SRST.G.208

PassedPhone A (99xx) ->
Unified SRST ->
Phone B (69xx)

Verify that music on
hold is heard
successfully in 69xx IP
phone when IP phone A
which is in active call
with 69xx IP phone goes
to hold state

MOH in 69xx
IP phone

UCJ10.6S.SRST.G.210

PassedPhone A ->Unified
SRST -> Phone B
(8945)

Verify that caller ID
given in IP phone A is
displayed in 89xx IP
phone successfully

Validate caller
ID in 89xx IP
phone

UCJ10.6S.SRST.G.232
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Cisco Unity Connection
DefectsStatusCall Component flowDescriptionTitleLogical ID

PassedIP Phone -> Unified
CM -> Unity
Connection -> Media
Sense

Verify whether
the user is able
to record a
video greetings
through TUI
call

Record Video
Greetings
through TUI
after enabled
Video Accounts
in CUC

UCJ10.6S.CUC.G.001

PassedIP Phone A -> Unified
CM -> Unity
Connection -> Media
Sense -> Unified CM
-> IP Phone B

Verify whether
the user is able
to see video
greetings when
call forward all
is enabled to
voicemail

Verify Video
Greetings in
Unified IP
Phones when
Call forward all
is enabled

UCJ10.6S.CUC.G.002

PassedIP Phone A ->Unified
CM -> Unity
Connection -> Media
Sense -> Unified CM
-> Jabber for Android

Verify whether
the user is able
to see video
greetings in
Jabber for
Android when
call forward all
is enabled to
voicemail

Verify Video
Greetings in
Jabber for
Android when
Call forward All
is enabled

UCJ10.6S.CUC.G.003

PassedIP Phone A -> Unified
CM -> Unity
Connection -> Media
Sense

Verify whether
the user is able
to record and
playback video
greetings
through TUI
call using
99XX
endpoints

Record and
playback the
VideoGreetings
through TUI
using 9971 IP
Phone

UCJ10.6S.CUC.G.004

Passed500-32 -> Unified CM
-> Unity Connection ->
Media Sense

Verify whether
the user is able
to record and
playback video
greetings
through TUI
call using
TX9000
endpoints

Record and
playback the
VideoGreetings
through TUI
using CTS
500-32

UCJ10.6S.CUC.G.005
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Cisco Virtualization Experience Media Engine for Windows
DefectsStatusCall Component

flow
DescriptionTitleLogical ID

PassedCJW1 -> Unified
CM -> CJW2

Verify whether audio
call made between
CJW1 and CJW2 is
successful when Cisco
Jabber for Windows is
in Virtualized
Environment

Make an audio
call from
CJW1 toCJW2
when in
Virtualized
Environment

UCJ10.6S.VXME.G.001

PassedIP Phone A ->
Unified CM ->
CJW1

Verify whether an
intra-cluster audio call
made between IP Phone
A and CJW1 is
successful when Cisco
Jabber for Windows is
in Virtualized
Environment

Make an
intra-cluster
audio call from
IP Phone to
CJW1 when in
Virtualized
Environment

UCJ10.6S.VXME.G.002

PassedIP Phone A (99xx)
-> Unified CM ->
CJW1

Verify whether an
intra-cluster video call
made between IP Phone
A (99xx) and CJW1 is
successful when Cisco
Jabber for Windows is
in Virtualized
Environment

Make an
intra-cluster
video call from
IP Phone
(99xx) to
CJW1 when
Cisco Jabber
forWindows is
in Virtualized
Environment

UCJ10.6S.VXME.G.008

PassedIP Phone A (99xx)
-> Unified CM1 ->
SIP Trunk ->
Unified CM2 ->
CJW1

Verify whether an
inter-cluster video call
made between IP Phone
A (99xx) and CJW1 via
SIP Trunk is successful
when Cisco Jabber for
Windows is in
Virtualized
Environment

Make an
inter-cluster
video call from
IP Phone
(99xx) to
CJW1 via SIP
Trunk when in
Virtualized
Environment

UCJ10.6S.VXME.G.009

PassedIP Phone A ->
Unified CM1 ->
PSTN Trunk ->
Unified CM2 -> IP
Phone B -> Unified
CM2 -> CJW1

Verify whether an
inter-cluster call
transfer to CJW1 is
successful when call
made from IP Phone A
to IP Phone B via PSTN
Trunk

Transfer an
inter-cluster
call from IP
Phone toCJW1
when callmade
from an IP
Phone via
PSTN Trunk

UCJ10.6S.VXME.G.016
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PassedIP Phone A (99xx)
-> Unified CM1 ->
SIP Trunk ->
Unified CM2 -> IP
Phone B (99xx) ->
Unified CM2 ->
CJW1

Verify whether an
inter-cluster video call
transfer to CJW1 when
call made from IP
Phone A (99xx) to IP
Phone B (99xx) via SIP
Trunk is successful

Transfer an
inter-cluster
video call from
IP Phone
(99xx) to
CJW1 when
call made from
an IP Phone A
(99xx) via SIP
Trunk

UCJ10.6S.VXME.G.024

PassedIP Phone A ->
Unified CM ->
CJW1

Verify whether an
intra-cluster call hold
and resume in CJW1 is
successful when call
made from IP Phone to
CJW1 when in
Virtualized
Environment

Call Hold and
Resume in
CJW1 when
call made from
IP Phone to
CJW1 when in
Virtualized
Environment

UCJ10.6S.VXME.G.034

PassedIP Phone A ->
Unified CM ->
CJW1 -> Unified
CM -> IP Phone B

Verify whether the
intra-cluster call
conference between IP
Phone A, IP Phone B
and CJW1 is successful
when Cisco Jabber for
Windows is in
Virtualized
Environment

Intra-cluster
call conference
between IP
Phone A, IP
Phone B and
CJW1 when in
Virtualized
Environment

UCJ10.6S.VXME.G.039

PassedIP Phone A ->
Unified CM1 -> SIP
Trunk -> Unified
CM2 -> CJW1 ->
Unified CM2 -> IP
Phone B

Verify whether the
inter-cluster call
conference between IP
Phone A, IP Phone B
and CJW1 is successful
when in Virtualized
Environment

Inter-cluster
call conference
between IP
Phone A, IP
Phone B and
CJW1 via SIP
Trunk when in
Virtualized
Environment

UCJ10.6S.VXME.G.040

PassedIP Phone A ->
Unified CM -> IP
Phone B -> Unified
CM -> CJW1

Verify whether the
CJW in Virtualized
Environment is able to
retrieve the parked call
successfully

Retrieve the
parked call
from CJW1
when callmade
between IP
Phones

UCJ10.6S.VXME.G.044
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PassedIP Phone A ->
Unified CM ->
CJW1 -> Unified
CM -> IP Phone B

Verify whether the Call
Forward All for CJW1
is successful when
Cisco Jabber for
Windows is in
Virtualized
Environment

Enable Call
Forward All
for CJW1 in
Unified CM
when in VDI
environment

UCJ10.6S.VXME.G.061

PassedIP Phone A ->
Unified CM1 ->
CJW -> Unified
CM1 -> SIP Trunk
-> Unified CM2 ->
IP Phone B

Verify whether the Call
Forward All is enabled
in Unified CM for
CJW1 to IP Phone at
the other cluster via SIP
trunk successfully

Enable Call
Forward All
for CJW1 to IP
Phone at the
other cluster
via SIP trunk
in Unified CM

UCJ10.6S.VXME.G.062

PassedIP Phone A ->
Unified CM ->
CJW1 -> Unified
CM -> IP Phone B

Verify whether the Call
ForwardNoAnswer for
CJW1 is successful
when Cisco Jabber for
Windows is in
Virtualized
Environment

Enable Call
Forward No
Answer for
CJW1 in
Unified CM

UCJ10.6S.VXME.G.066

PassedIP Phone A ->
Unified CM1 ->
CJW1 -> Unified
CM1 -> IP Phone B
-> Unified CM1 ->
CJW1 -> Unified
CM1 -> SIP Trunk
-> Unified CM2 ->
IP Phone C

Verify whether the Call
Forward Busy for
CJW1 to IP Phone at
the other cluster via SIP
trunk is successful
when Cisco Jabber for
Windows is in
Virtualized
Environment

Enable Call
Forward Busy
for CJW1 in
Unified CM to
IP Phone at the
other cluster
via SIP Trunk

UCJ10.6S.VXME.G.072

PassedNAVerify whether one of
the UC accessories -
mouse is supported and
Jabber is logged and
navigated using mouse
when Jabber is in
Virtualized
Environment

Support for one
of the
accessories -
Mouse to login
Jabber and
navigate to all
tabs in Jabber
when Jabber in
Virtualized
Environment

UCJ10.6S.VXME.G.121

Cisco TelePresence Multipoint Control Unit
DefectsStatusCall Component

Flow
DescriptionTitleLogical ID
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PassedMCU 4510 ->
CiscoVCS ->Cisco
TelePresence
MX300-G2

Verify whether
Cisco TelePresence
MX300-G2
registered in Cisco
TelePresence Video
Communication
Server can be added
to a conference
using SIP registrar in
Cisco TelePresence
MCU 4510

Adding Cisco
TelePresence
MX300-G2
registered in
Cisco VCS to
the conference
using SIP
Registrar

UCJ10.6S.MCU.G.001

PassedMCU 4510 ->
Cisco VCS-> SX80
Codec

Verify whether
Cisco TelePresence
SX80 Codec
registered in Cisco
TelePresence Video
Communication
Server can be added
to a conference
using SIP registrar in
Cisco TelePresence
MCU 4510

Adding Cisco
TelePresence
SX80 Codec
registered in
Cisco VCS to
the conference
using SIP
Registrar

UCJ10.6S.MCU.G.002

PassedSX20
QuickSet->Cisco
VCS -> Integrator
Package C90
SX20
QuickSet->Add
Participant->Cisco
VCS ->Cisco
Telepresence
MX300-G2->Cisco
VCS -> MCU
5310-> hold/resume

Verify whether
Cisco TelePresence
SX20 Quick Set ,
Cisco TelePresence
System Integrator
Package C90 and
Cisco TelePresence
MX300-G2
registered in Cisco
TelePresence Video
Communication
Server can join the
Multiway
conference call by
Cisco TelePresence
MCU 5310 and hold
and resume the
conference call in
MX300-G2

Hold and
resume the
Multiway
conference call
using MCU
5310 in
MX300-G2

UCJ10.6S.MCU.G.003
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PassedSX20
QuickSet->Cisco
VCS ->Integrator
Package C90
SX20 QuickSet->
Add Participant
->Cisco VCS
->Cisco
Telepresence SX80
Codec -> Cisco
VCS -> MCU
5310-> hold/resume

Verify whether
Cisco TelePresence
SX20 Quick Set ,
Cisco TelePresence
System Integrator
Package C90 and
Cisco TelePresence
SX80 Codec
registered in Cisco
TelePresence Video
Communication
Server can join the
conference call by
Cisco TelePresence
MCU 5310 and hold
and resume the
conference call in
SX80 Codec

Hold and
resume the
Multiway
conference call
using MCU
5310 in Cisco
TelePresence
SX80 Codec

UCJ10.6S.MCU.G.004

PassedSX20 QuickSet ->
Cisco
VCS->Integrator
Package C90
SX20 QuickSet ->
Add participant ->
Cisco VCS->Cisco
Telepresence
MX300-G2 SX20
QuickSet -> Add
Participant -> Cisco
VCS-> EX90 ->
CiscoVCS ->MCU
5310

Verify whether
Cisco TelePresence
SX20 Quick Set ,
Cisco TelePresence
MX300-G2, Cisco
TelePresence
System Integrator
Package C90 and
Cisco TelePresence
System EX90
registered in Cisco
TelePresence Video
Communication
Server can join the
conference call by
Cisco TelePresence
MCU 5310 and stay
in the conference for
1hour

Long duration
Multiway
conference call
in MX300-G2
using MCU
5310 registered
with Cisco VCS

UCJ10.6S.MCU.G.005
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PassedSX20 QuickSet->
Cisco
VCS->Integrator
Package C90
SX20
QuickSet->Add
Participant-> Cisco
VCS->Cisco
Telepresence SX80
Codec and EX90 ->
CiscoVCS ->MCU
5310

Verify whether
Cisco TelePresence
SX20 Quick Set ,
Cisco TelePresence
SX80 Codec, Cisco
TelePresence
System Integrator
Package C90 and
Cisco TelePresence
System EX90
registered in Cisco
TelePresence Video
Communication
Server can join the
conference call by
Cisco TelePresence
MCU 5310 and stay
in the conference for
1hour

Long duration
Multiway
conference call
in SX80 Codec
using MCU
5310

UCJ10.6S.MCU.G.006

PassedSX20 QuickSet ->
Cisco VCS ->
EX90
SX20 Quick Set ->
Add Participant ->
CiscoVCS ->Cisco
Telepresence
MX300-G2 ->
CiscoVCS ->MCU
5310 Cisco
Telepresence
MX300-G2 ->
Presentation
Sharing

Verify whether
Cisco TelePresence
SX20 Quick Set ,
Cisco TelePresence
MX300-G2 and
Cisco TelePresence
System EX90
registered in Cisco
TelePresence Video
Communication
Server can join the
conference call by
Cisco TelePresence
MCU 5310 and
share the
presentation from
Cisco TelePresence
MX300-G2

Presentation
sharing from
Cisco
TelePresence
MX300-G2 in
Multiway
conference call
usingMCU5310

UCJ10.6S.MCU.G.007
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PassedSX20 QuickSet
->Cisco VCS ->
EX90
SX20 Quick Set
->Add Participant
-> Cisco VCS->
Cisco Telepresence
SX80 Codec ->
CiscoVCS ->MCU
5310 ->
Presentation
Sharing

Verify whether
Cisco TelePresence
SX20 Quick Set ,
Cisco TelePresence
SX80 Codec and
Cisco TelePresence
System EX90
registered in Cisco
TelePresence Video
Communication
Server can join the
conference call by
Cisco TelePresence
MCU 5310 and
share the
presentation from
Cisco TelePresence
SX80 Codec

Presentation
sharing from
Cisco
TelePresence
SX80 Codec in
Multiway
conference call
usingMCU5310

UCJ10.6S.MCU.G.008

PassedIntegrator Package
C90 -> Unified CM
-> EX90
Integrator Package
C90 -> Add
Participant-> MCU
5310 -> SIP Trunk
-> Unified CM ->
CiscoVCS ->Cisco
VCSExpressway ->
SX20 QuickSet

Verify whether the
conference call from
Cisco TelePresence
System Integrator
Package C90
registered in Cisco
Unified
Communications
Manager to SX20
QuickSet registered
with Unified CMvia
CollaborationEDGE
using MCU 5310
works successfully

Conference call
to SX20
QuickSet
registered with
Unified CM via
Collaboration
EDGE from
Integrator
Package C90
registered with
Unified CM .

UCJ10.6S.MCU.G.009
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PassedSX20 QuickSet
,EX90 &
MX300-G2 ->
CiscoVCS ->MCU
5310 ->
Presentation
Sharing

Verify whether
Cisco TelePresence
SX20 Quick Set ,
Cisco TelePresence
MX300-G2 and
Cisco TelePresence
System EX90
registered in Cisco
TelePresence Video
Communication
Server can join the
MeetMe conference
call by Cisco
TelePresence MCU
5310 and share the
presentation from
Cisco TelePresence
MX300-G2

Presentation
sharing from
Cisco
TelePresence
MX300-G2 in
Meet Me
conference
usingMCU5310

UCJ10.6S.MCU.G.010

Cisco TelePresence Management Suite
DefectsStatusCall Component

Flow
DescriptionTitleLogical ID

PassedNAVerify whether the Add
System is renamed to
Add by Address in the
Add Systems page in
Cisco TelePresence
Management Suite

Changes to Add
Systems page

UCJ10.6S.TMS.G.001

PassedNAVerify whether the From
List is renamed to Add
from Unified CM or
TMS in Cisco
TelePresence
Management Suite

Changes to
From List page

UCJ10.6S.TMS.G.002

PassedNAVerify whether the list
conferences section has
been split into Search
and Advanced in Cisco
TelePresence
Management Suite

Change under
List
Conferences in
Cisco TMS

UCJ10.6S.TMS.G.003
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PassedNAVerify whether the
search only phone book
sources are removed
from participants lists
under conferences in
Cisco TelePresence
Management Suite

Search only
phone book
sources
removed from
scheduling

UCJ10.6S.TMS.G.004

PassedNAVerify whether the long
conference title more
than 100 characters are
supported under List
Conferences in Cisco
TelePresence
Management Suite

Long
Conference title
in Cisco TMS

UCJ10.6S.TMS.G.005

PassedNAVerify whether the
editing of dial string for
participants is disabled
in Cisco TelePresence
Management Suite new
conference page

Change to dial
string of
participants

UCJ10.6S.TMS.G.006

PassedCisco TMS -> MCU
5310 -> Cisco VCS
-> EX90, EX60,
SX80 Codec

Verify whether the
Reconnect message
displays on the master
endpoint registered in
Cisco TelePresence
Video Communication
Server when Show
ReconnectMessage Box
on Endpoints is set to
No in Cisco
TelePresence
Management Suite

Reconnect
message on
Master endpoint
registered in
Cisco VCS

UCJ10.6S.TMS.G.007

PassedNAVerify whether the User
time zones appears
under list conferences in
Cisco TelePresence
Management Suite

User time zones
in List
Conferences

UCJ10.6S.TMS.G.008

PassedNAVerify whether the User
time zones appears
under Edit Personal
Information in Cisco
TelePresence
Management Suite

User time zones
under Edit
Personal
Information

UCJ10.6S.TMS.G.009
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PassedNAVerify whether the User
time zones appears
under Participant List
Tab and Participant
Availability Table in
Cisco TelePresence
Management Suite

User time zones
under
Participant List
and Participant
Availability
table

UCJ10.6S.TMS.G.010

PassedNAVerify whether the value
can be set for the
allocation attempts field
in Cisco TelePresence
Management Suite

Change in
Allocation
Attempts Field

UCJ10.6S.TMS.G.011

PassedCisco TMS -> Ad
hoc Booking ->
Unified CM ->EX90
Cisco TMS -> MCU
4510 -> SIP Trunk
-> Unified CM ->
EX90

Verify whether the ad
hoc call in Cisco
TelePresence System
EX90 registered in Cisco
Unified
Communications
Manager is not
disconnected when a No
Connect Conference is
about to start in Cisco
TelePresence
Management Suite

No Ad hoc call
disconnection
for endpoints
registered in
Unified CM

UCJ10.6S.TMS.G.012

PassedCisco TMS -> Ad
hoc Booking ->
Cisco VCS -> EX90
Cisco TMS -> MCU
4510 -> Cisco VCS
-> EX90

Verify whether the ad
hoc call in Cisco
TelePresence System
EX90 registered in Cisco
TelePresence Video
Communication Server
is not disconnected
when a No Connect
Conference is about to
start in Cisco
TelePresence
Management Suite

No Ad hoc call
disconnection
for endpoints
registered in
Cisco VCS

UCJ10.6S.TMS.G.013

PassedNAVerify whether the
warning appears when
the site administrator is
set as default group in
Cisco TelePresence
Management Suite

Warning when
Site
Administrator is
set as default
group

UCJ10.6S.TMS.G.014

   Test Results for Cisco Unified Communications System Release 10.6 for Japan
76

Test Results Summary
Cisco TelePresence Management Suite



PassedNAVerify whether the
conference title appears
under the description
column in the Activity
Status page in Cisco
TelePresence
Management Suite

Conference
Title under
Description
Column

UCJ10.6S.TMS.G.015

PassedNAVerify whether Audio
call-in button under
Smart Scheduler can be
disabled in Cisco
TelePresence
Management Suite
Provisioning Extension

Disable Audio
Call-In button
in Smart
Scheduler

UCJ10.6S.TMS.G.016

PassedNAVerify whether Video
call-in button under
Smart Scheduler can be
disabled in Cisco
TelePresence
Management Suite
Provisioning Extension

Disable Video
Call-In button
in Smart
Scheduler

UCJ10.6S.TMS.G.017

PassedNAVerify whether ports on
a bridge can be reserved
for Cascading in Cisco
TelePresence
Management Suite
Provisioning Extension

Reserve Ports
on a bridge for
Cascading

UCJ10.6S.TMS.G.018

PassedNAVerify whether all the
option keys present in
Cisco TelePresence
System EX90 is present
and shown in Cisco
TelePresence
Management Suite

Option key
support for
EX90 in Cisco
TMS

UCJ10.6S.TMS.G.019

Cisco TelePresence Conductor
DefectsStatusCall Component

Flow
DescriptionTitleLogical ID
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PassedNAVerify whether
Cisco TelePresence
Conductor raises an
alarm when the
Cisco TelePresence
Server on VM has
no encryption
feature key installed

Alarm raised
when no
Encryption
feature key
enabled in
TelePresence
Server on VM

UCJ10.6S.TC.G.001

PassedNAVerify whether
Cisco TelePresence
Conductor raises an
alarm when the
Cisco TelePresence
Server 7010 has no
encryption feature
key installed

Alarm raised
when no
Encryption
feature key
enabled in
TelePresence
Server 7010

UCJ10.6S.TC.G.002

PassedNAVerify whether
Cisco TelePresence
Conductor raises an
alarm when the
Cisco MCU 4510
has no encryption
feature key installed

Alarm raised
when no
Encryption
feature key
enabled inMCU
4510

UCJ10.6S.TC.G.003

PassedNAVerify whether
Cisco TelePresence
Conductor raises an
alarm when the
Cisco MCU 5310
has no encryption
feature key installed

Alarm raised
when no
Encryption
feature key
enabled inMCU
5310

UCJ10.6S.TC.G.004

PassedNAVerify whether
Cisco TelePresence
Conductor raises an
alarmwhen the same
Cisco MCU 5310 is
added more than
once

Alarm raised
when the same
MCU 5310 is
added to the
TelePresence
Conductor

UCJ10.6S.TC.G.005

PassedNAVerify whether
Cisco TelePresence
Conductor raises an
alarmwhen the same
Cisco TelePresence
Server on VM is
added more than
once

Alarm raised
when the same
TelePresence
Server on VM is
added to the
TelePresence
Conductor

UCJ10.6S.TC.G.006
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PassedNAVerify whether the
field Number of
cascade ports to
reserve on the
Conference
templates page has
been renamed to
Maximum number
of cascades in Cisco
TelePresence
Conductor

Change of field
name in
Conductor

UCJ10.6S.TC.G.007

PassedNAVerify whether the
SNMPpage displays
a Description field
in Cisco
TelePresence
Conductor

Description
field in SNMP
page

UCJ10.6S.TC.G.008

PassedMX300-G2 ->Cisco
VCS -> Conductor
->TelePresence
Server onVM ->HD
Lecture Conference

Verify whether
Cisco TelePresence
MX300-G2 can join
a HD Lecture
conferencemanaged
by Cisco
TelePresence Server
on VM in Cisco
Telepresence
Conductor

Joining a HD
Lecture
conference from
MX300-G2
managed by
Cisco
TelePresence
Server on VM

UCJ10.6S.TC.G.009

PassedMX300-G2 ->Cisco
VCS -> Conductor
->TelePresence
Server on VM -> SD
Lecture Conference

Verify whether
Cisco TelePresence
MX300-G2 can join
a SD Lecture
conferencemanaged
by Cisco
TelePresence Server
on VM in Cisco
Telepresence
Conductor

Joining a SD
Lecture
conference from
MX300-G2
managed by
Cisco
TelePresence
Server on VM

UCJ10.6S.TC.G.010

PassedMX300-G2 ->Cisco
VCS -> Conductor
-> TelePresence
Server 7010 -> HD
Lecture Conference

Verify whether
Cisco TelePresence
MX300-G2 can join
a HD Lecture
conferencemanaged
by Cisco
TelePresence Server
7010 in Cisco
Telepresence
Conductor

Joining a HD
Lecture
conference from
MX300-G2
managed by
Cisco
TelePresence
Server 7010

UCJ10.6S.TC.G.011
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PassedMX300-G2 ->Cisco
VCS -> Conductor
-> TelePresence
Server 7010 -> SD
Lecture Conference

Verify whether
Cisco TelePresence
MX300-G2 can join
a SD Lecture
conferencemanaged
by Cisco
TelePresence Server
7010 in Cisco
Telepresence
Conductor

Joining a SD
Lecture
conference from
MX300-G2
managed by
Cisco
TelePresence
Server 7010

UCJ10.6S.TC.G.012

PassedMX300-G2 ->Cisco
VCS -> Conductor
-> TelePresence
Server 7010 ->
Audio Only Lecture
Conference

Verify whether
Cisco TelePresence
MX300-G2 can join
an Audio-only
Lecture conference
managed by Cisco
TelePresence Server
7010 in Cisco
Telepresence
Conductor

Joining an
Audio-only
Lecture
conference from
MX300-G2
managed by
Cisco
TelePresence
Server 7010

UCJ10.6S.TC.G.013

PassedMX300-G2 ->Cisco
VCS -> Conductor
-> TelePresence
Server onVM ->HD
Meeting Conference

Verify whether
Cisco TelePresence
MX300-G2 can join
a HD Meeting
conferencemanaged
by Cisco
TelePresence Server
on VM in Cisco
Telepresence
Conductor

Joining a HD
Meeting
conference from
MX300-G2
managed by
Cisco
TelePresence
Server on VM

UCJ10.6S.TC.G.014

PassedMX300-G2 ->Cisco
VCS -> Conductor
-> TelePresence
Server on VM -> SD
Meeting Conference

Verify whether
Cisco TelePresence
MX300-G2 can join
a SD Meeting
conferencemanaged
by Cisco
TelePresence Server
on VM in Cisco
Telepresence
Conductor

Joining a SD
Meeting
conference from
MX300-G2
managed by
Cisco
TelePresence
Server on VM

UCJ10.6S.TC.G.015
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PassedMX300-G2 ->Cisco
VCS -> Conductor
-> TelePresence
Server 7010 -> HD
Meeting Conference

Verify whether
Cisco TelePresence
MX300-G2 can join
a HD Meeting
conferencemanaged
by Cisco
TelePresence Server
7010 in Cisco
Telepresence
Conductor

Joining a HD
Meeting
conference from
MX300-G2
managed by
Cisco
TelePresence
Server 7010

UCJ10.6S.TC.G.016

PassedMX300-G2 ->Cisco
VCS -> Conductor
-> TelePresence
Server 7010 -> SD
Meeting Conference

Verify whether
Cisco TelePresence
MX300-G2 can join
a SD Meeting
conferencemanaged
by Cisco
TelePresence Server
7010 in Cisco
Telepresence
Conductor

Joining a SD
Meeting
conference from
MX300-G2
managed by
Cisco
TelePresence
Server 7010

UCJ10.6S.TC.G.017

PassedSX80 Codec ->
Cisco VCS ->
Conductor -> MCU
5310 -> Meeting
Conference

Verify whether
Cisco TelePresence
SX80 Codec can
join a Meeting
conferencemanaged
byCiscoMCU5310
in Cisco
Telepresence
Conductor

Joining a
Meeting
conference from
SX80 Codec
managed by
MCU 5310

UCJ10.6S.TC.G.018

PassedSX80 Codec ->
Cisco VCS ->
Conductor -> MCU
5310 -> Lecture
Conference

Verify whether
Cisco TelePresence
SX80 Codec can
join a Lecture
conferencemanaged
byCiscoMCU5310
in Cisco
Telepresence
Conductor

Joining a
Lecture
conference from
SX80 Codec
managed by
MCU 5310

UCJ10.6S.TC.G.019

PassedSX80 Codec ->
Cisco VCS ->
Conductor ->
TelePresence Server
on VM -> HD
Lecture Conference

Verify whether
Cisco TelePresence
SX80 Codec can
join a HD Lecture
conferencemanaged
by Cisco
TelePresence Server
on VM in Cisco
Telepresence
Conductor

Joining a HD
Lecture
conference from
SX80 Codec
managed by
Cisco
TelePresence
Server on VM

UCJ10.6S.TC.G.020
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PassedSX80 Codec ->
Cisco VCS ->
Conductor ->
TelePresence Server
on VM -> SD
Lecture Conference

Verify whether
Cisco TelePresence
SX80 Codec can
join a SD Lecture
conferencemanaged
by Cisco
TelePresence Server
on VM in Cisco
Telepresence
Conductor

Joining a SD
Lecture
conference from
SX80 Codec
managed by
Cisco
TelePresence
Server on VM

UCJ10.6S.TC.G.021

PassedSX80 Codec ->
Cisco VCS ->
Conductor ->
TelePresence Server
7010 -> HD Lecture
Conference

Verify whether
Cisco TelePresence
SX80 Codec can
join a HD Lecture
conferencemanaged
by Cisco
TelePresence Server
7010 in Cisco
Telepresence
Conductor

Joining a HD
Lecture
conference from
SX80 Codec
managed by
Cisco
TelePresence
Server 7010

UCJ10.6S.TC.G.022

PassedSX80 Codec ->
Cisco VCS ->
Conductor ->
TelePresence Server
7010 -> SD Lecture
Conference

Verify whether
Cisco TelePresence
SX80 Codec can
join a SD Lecture
conferencemanaged
by Cisco
TelePresence Server
7010 in Cisco
Telepresence
Conductor

Joining a SD
Lecture
conference from
SX80 Codec
managed by
Cisco
TelePresence
Server 7010

UCJ10.6S.TC.G.023

PassedSX80 Codec ->
Cisco VCS ->
Conductor ->
TelePresence Server
on VM -> HD
Meeting Conference

Verify whether
Cisco TelePresence
SX80 Codec can
join a HD Meeting
conferencemanaged
by Cisco
TelePresence Server
on VM in Cisco
Telepresence
Conductor

Joining a HD
Meeting
conference from
SX80 Codec
managed by
Cisco
TelePresence
Server on VM

UCJ10.6S.TC.G.024
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PassedSX80 Codec ->
Cisco VCS ->
Conductor ->
TelePresence Server
on VM -> SD
Meeting Conference

Verify whether
Cisco TelePresence
SX80 Codec can
join a SD Meeting
conferencemanaged
by Cisco
TelePresence Server
on VM in Cisco
Telepresence
Conductor

Joining a SD
Meeting
conference from
SX80 Codec
managed by
Cisco
TelePresence
Server on VM

UCJ10.6S.TC.G.025

PassedSX80 Codec ->
Cisco VCS ->
Conductor ->
TelePresence Server
7010 ->HDMeeting
Conference

Verify whether
Cisco TelePresence
SX80 Codec can
join a HD Meeting
conferencemanaged
by Cisco
TelePresence Server
7010 in Cisco
Telepresence
Conductor

Joining a HD
Meeting
conference from
SX80 Codec
managed by
Cisco
TelePresence
Server 7010

UCJ10.6S.TC.G.026

PassedSX80 Codec ->
Cisco VCS ->
Conductor ->
TelePresence Server
7010 -> SDMeeting
Conference

Verify whether
Cisco TelePresence
SX80 Codec can
join a SD Meeting
conferencemanaged
by Cisco
TelePresence Server
7010 in Cisco
Telepresence
Conductor

Joining a SD
Meeting
conference from
SX80 Codec
managed by
Cisco
TelePresence
Server 7010

UCJ10.6S.TC.G.027

PassedSX80 Codec ->
Cisco VCS ->
Conductor ->
TelePresence Server
on VM -> HD
Meeting Conference
HD Meeting
Conference ->
Conductor -> Cisco
VCS -> MX300-G2

Verify whether
Cisco TelePresence
MX300-G2 can join
as an auto dialed
participant for a HD
Meeting conference
managed by Cisco
TelePresence Server
on VM in Cisco
Telepresence
Conductor

AddMX300-G2
as an
auto-dialed
participant for
Meeting HD
conference

UCJ10.6S.TC.G.028
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PassedSX80 Codec ->
Cisco VCS ->
Conductor ->
TelePresence Server
on VM -> SD
Meeting Conference
SD Meeting
Conference ->
Conductor -> Cisco
VCS -> MX300-G2

Verify whether
Cisco TelePresence
MX300-G2 can join
as an auto dialed
participant for a SD
Meeting conference
managed by Cisco
TelePresence Server
on VM in Cisco
Telepresence
Conductor

AddMX300-G2
as an
auto-dialed
participant for
Meeting SD
conference

UCJ10.6S.TC.G.029

PassedSX80 Codec ->
Cisco VCS ->
Conductor -> Cisco
TS 7010 -> SD
Meeting Conference
SD Meeting
Conference ->
Conductor -> Cisco
VCS -> MX300-G2

Verify whether
Cisco TelePresence
MX300-G2 can join
as an auto dialed
participant for a SD
Meeting conference
managed by Cisco
TelePresence Server
7010 in Cisco
Telepresence
Conductor

AddMX300-G2
as an
auto-dialed
participant for
Meeting SD
conference
managed by
Cisco TS 7010

UCJ10.6S.TC.G.030

PassedSX80 Codec ->
Unified CM -> SIP
Trunk -> Conductor
-> Rendezvous
Conference

Verify whether
rendezvous
conference call from
Cisco TelePresence
SX80 Codec
registered in Cisco
Unified
Communications
Manager to Cisco
TelePresence
Conductor works
successfully

Rendezvous
conference call
from SX80
Codec to
Conductor

UCJ10.6S.TC.G.031

PassedSX80 Codec ->
UnifiedCM ->EX90
-> Add -> EX60 ->
Unified CM -> SIP
Trunk -> Conductor
-> Ad hoc
Conference

Verify whether ad
hoc conference call
from Cisco
TelePresence SX80
Codec registered in
Cisco Unified
Communications to
Cisco TelePresence
Conductor works
successfully

Ad hoc
conference call
from SX80
Codec to
Conductor

UCJ10.6S.TC.G.032
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PassedEX90 ->UnifiedCM
-> SIP Trunk ->
Conductor ->
Rendezvous
Conference
Conductor -> SIP
Trunk -> Unified
CM -> SX80 Codec

Verify whether
Cisco TelePresence
Conductor makes
call to Cisco
TelePresence SX80
Codec when
rendezvous
conference is
initiated in Cisco
TelePresence
System EX90

Adding SX80
Codec as
Auto-dialed
participant for a
Rendezvous
conference in
Conductor

UCJ10.6S.TC.G.033

PassedMX300G2 ->
Unified CM -> SIP
Trunk -> Conductor
-> Rendezvous
Conference

Verify whether
rendezvous
conference call from
Cisco TelePresence
MX300G2
registered in Cisco
Unified
Communications
Manager to Cisco
TelePresence
Conductor works
successfully

Rendezvous
conference call
fromMX300G2
to Conductor

UCJ10.6S.TC.G.034

PassedMX300G2 ->
UnifiedCM ->EX90
-> Add -> EX60 ->
Unified CM -> SIP
Trunk -> Conductor
-> Ad hoc
Conference

Verify whether ad
hoc conference call
from Cisco
TelePresence
MX300G2
registered in Cisco
Unified
Communications to
Cisco TelePresence
Conductor works
successfully

Ad hoc
conference call
fromMX300G2
to Conductor

UCJ10.6S.TC.G.035

PassedEX90 ->UnifiedCM
-> SIP Trunk ->
Conductor ->
Rendezvous
Conference
Conductor -> SIP
Trunk -> Unified
CM -> MX300G2

Verify whether
Cisco TelePresence
Conductor makes
call to Cisco
TelePresence
MX300G2 when
rendezvous
conference is
initiated in Cisco
TelePresence
System EX90

Adding
MX300G2 as
Auto-dialed
participant for a
Rendezvous
conference in
Conductor

UCJ10.6S.TC.G.036
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PassedSX80 Codec ->
Cisco VCS-E ->
Cisco VCS-C ->
Unified CM -> SIP
Trunk -> Conductor
-> Rendezvous
Conference

Verify whether
rendezvous
conference call from
Cisco TelePresence
SX80 Codec
registered in Cisco
Unified
Communications
Manager via
Collaboration Edge
to Cisco
TelePresence
Conductor works
successfully

Rendezvous
conference call
from SX80
Codec
registered via
Collaboration
Edge to
Conductor

UCJ10.6S.TC.G.037

PassedSX80 Codec ->
UnifiedCM ->EX90
-> Add -> EX60 ->
Unified CM -> SIP
Trunk -> Conductor
-> Audio only ad hoc
Conference

Verify whether
audio only ad hoc
conference call from
Cisco TelePresence
SX80 Codec
registered in Cisco
Unified
Communications to
Cisco TelePresence
Conductor works
successfully

Audio only Ad
hoc conference
call from SX80
Codec to
Conductor

UCJ10.6S.TC.G.038

PassedEX90 ->UnifiedCM
-> SIP Trunk ->
Conductor ->
Rendezvous
Conference
Conductor -> SIP
Trunk -> Unified
CM ->CiscoVCS-C
-> Cisco VCS-E ->
SX80 Codec

Verify whether
Cisco TelePresence
Conductor makes
call to Cisco
TelePresence SX80
Codec registered in
Cisco Unified
Communications
Manager via
Collaboration Edge
when rendezvous
conference is
initiated in Cisco
TelePresence
System EX90
registered in Cisco
Unified
Communications
Manager

Adding SX80
Codec
registered via
Collaboration
Edge as
Auto-dialed
participant for a
Rendezvous
conference in
Conductor

UCJ10.6S.TC.G.039
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PassedSX80 Codec ->
Unified CM -> SIP
Trunk -> Conductor
-> Audio only
Rendezvous
Conference

Verify whether
audio only
rendezvous
conference call from
Cisco TelePresence
SX80 Codec
registered in Cisco
Unified
Communications
Manager to Cisco
TelePresence
Conductor works
successfully

Audio only
rendezvous
conference call
from SX80 to
Conductor

UCJ10.6S.TC.G.040

Cisco TelePresence Server
DefectsStatusCall Component FlowDescriptionTitleLogical ID

PassedMX200-G2->Unified
CM->SIP Trunk->Cisco
TS 7010->video
conference

To verify that
user is able to
do meet me
video
conference from
Cisco
TelePresence
MX200-G2
using Cisco
TelePresence
Server 7010

Initiate the meet
me video
conference from
MX200-G2
using Cisco TS
7010

UCJ10.6S.TS.G.001

PassedEX60,MX200-G2,SX80
Codec ->Unified
CM->SIP Trunk->Cisco
TS 7010->video
conference

To verify that
user is able to
do video
conference
between Cisco
TelePresence
MX200-G2,Cisco
TelePresence
SX80 Codec &
Cisco
TelePresence
System EX60
using Cisco
TelePresence
Server 7010

Conference
between
MX200-G2 ,
SX80 Codec &
EX60 using
Cisco TS 7010

UCJ10.6S.TS.G.002
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PassedEX60,MX200-G2,SX10
Quick Set ->Unified
CM->SIP Trunk->Cisco
TS 7010->video
conference ->Presentation
Sharing

To verify that
user is able to
do presentation
sharing in video
conference
between Cisco
TelePresence
MX200-G2,
Cisco
TelePresence
SX10 Quick Set
& Cisco
TelePresence
System EX60
using Cisco
TelePresence
Server 7010

Presentation
Sharing in video
conference
using Cisco TS
7010

UCJ10.6S.TS.G.003

PassedEX60,MX200-G2,SX80
Codec ->Unified
CM->SIP Trunk->Cisco
TS 7010->video
conference
->Hold/Resume

To verify that
user is able to
doHold/Resume
in video
conference
between Cisco
TelePresence
MX200-G2,
Cisco
TelePresence
SX80 Codec &
Cisco
TelePresence
System EX60
using Cisco
TelePresence
Server 7010

Hold/Resume in
MX200-G2
while in video
conference
using Cisco TS
7010

UCJ10.6S.TS.G.004

Passed7861,MX300-G2,SX80
Codec ->Unified
CM->SIP Trunk->Cisco
TS 7010->video
conference ->
7861->Park->Unified
CM->MX200-G2->Retrieve

To verify that
user is able to
retrieve the
parked video
conference in
Cisco
TelePresence
MX200-G2
using Cisco
TelePresence
Server 7010

Retrieve the
parked video
conference in
MX200-G2
using Cisco TS
7010

UCJ10.6S.TS.G.005
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PassedEX60,MX200-G2,SX10
Quick Set ->Unified
CM->SIP Trunk->Cisco
TS 7010->video
conference ->Presentation
Sharing->Hold/Resume

To verify that
user is able to
doHold/Resume
while sharing
presentation in
video
conference
between Cisco
TelePresence
MX200-G2,
Cisco
TelePresence
SX10 Quick Set
& Cisco
TelePresence
System EX60
using Cisco
TelePresence
Server 7010

Hold/Resume in
MX200-G2
while sharing
presentation in
conference
using Cisco TS
7010

UCJ10.6S.TS.G.006

Passed7861,MX200-G2,SX20
Quick Set ->Unified
CM->SIP Trunk->Cisco
TS 7010->video
conference ->
MX200-G2->Hold/Transfer->Unified
CM->EX90

To verify that
user is able to
do consultative
transfer from
Cisco
TelePresence
MX200-G2
while in video
conference
using Cisco
TelePresence
Server 7010

Consultative
Transfer in
MX200-G2
while video
conference
using Cisco TS
7010

UCJ10.6S.TS.G.007

PassedMX200-G2->Unified
CM->SIP Trunk->Cisco
TS 7010->video
conference SX10 Quick
Set->Cisco VCS->SIP
Trunk->UnifiedCM->SIP
Trunk->Cisco TS 7010->
video conference

To verify that
user is able to
do conference
between Cisco
TelePresence
MX200-G2
registered with
Unified CM and
Cisco
TelePresence
SX10 Quick Set
registered with
Cisco VCS
using Cisco
TelePresence
Server 7010

Conference
between
MX200-G2
registered with
Unified CM and
SX10 Quick Set
with Cisco VCS
using Cisco TS
7010

UCJ10.6S.TS.G.008
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PassedMX200-G2(H.323),
SX20 Quick Set->Cisco
VCS->Cisco TS
7010->video conference

To verify that
user is able to
do conference
between Cisco
TelePresence
MX200-G2 as
H.323 endpoint
and Cisco
TelePresence
SX20 Quick Set
as SIP endpoint
registered with
Cisco VCS
using Cisco
TelePresence
Server 7010

Conference
between
MX200-G2
(H.323) and
SX20 Quick
Set(SIP)
registered with
Cisco VCS
using Cisco TS
7010

UCJ10.6S.TS.G.009

PassedSX10Quick Set->Unified
CM->SIP Trunk->Cisco
TS 7010->video
conference

To verify that
user is able to
do meet me
video
conference from
Cisco
TelePresence
SX10 Quick Set
using Cisco
TelePresence
Server 7010

Initiate the meet
me video
conference from
SX10 Quick Set
using Cisco TS
7010

UCJ10.6S.TS.G.010

PassedEX60,8945,SX10 Quick
Set ->Unified CM->SIP
Trunk->Cisco TS
7010->video conference
->Presentation
Sharing->Hold/Resume

To verify that
user is able to
doHold/Resume
while sharing
presentation in
video
conference
between Cisco
TelePresence
SX10Quick Set,
Cisco
TelePresence
System EX60&
IP Phone 8945
using Cisco
TelePresence
Server 7010

Hold/Resume in
SX10 Quick Set
while sharing
presentation
using Cisco TS
7010

UCJ10.6S.TS.G.011
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Passed7861,SX20 Quick Set
->Unified CM->SIP
Trunk->Cisco TS
7010->video conference
-> 7861->Park->Unified
CM->SX10 Quick
Set->Retrieve

To verify that
user is able to
retrieve the
parked video
conference in
Cisco
TelePresence
SX10Quick Set,
using Cisco
TelePresence
Server 7010

Retrieve the
parked video
conference in
SX10 Quick Set
using Cisco TS
7010

UCJ10.6S.TS.G.012

Cisco Jabber Guest
DefectsStatusCall Component

Flow
DescriptionTitleLogical ID

PassedJabber guest
client(windows) ->
Cisco
Expressway-E ->
Cisco
Expressway-C ->
Unified CM ->
MX300-G2

To Verify that
user is able to
make a call from
Jabber guest
client to Cisco
TelePresence
System
MX300-G2 via
Cisco
Expressway-E

Make a video
call from Jabber
guest client on
Windows to
MX300-G2 via
Cisco
Expressway-E

UCJ10.6S.JG.G.001

PassedJabber guest
client(windows) ->
Cisco
Expressway-E ->
Cisco
Expressway-C ->
Unified CM ->
SX80 Codec

To Verify that
user is able to
make a call from
Jabber guest
client on
Windows to
Cisco
TelePresence
SX80 Codec via
Cisco
Expressway-E

Make a video
call from Jabber
guest client on
Windows to
SX80 codec via
Cisco
Expressway-E

UCJ10.6S.JG.G.002
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PassedJabber guest
client(windows) ->
Cisco
Expressway-E ->
Cisco
Expressway-C ->
Unified CM ->
8945

To Verify that
user is able to
make a call from
Jabber guest
client on
windows to
Cisco Unified IP
Phone 8945 via
Cisco
Expressway-E

Make a video
call from Jabber
guest client on
windows to
CiscoUnified IP
Phone 8945 via
Cisco
Expressway-E

UCJ10.6S.JG.G.003

PassedJabber guest
client(windows) ->
Cisco
Expressway-E ->
Cisco
Expressway-C ->
Unified CM ->
9971

To Verify that
user is able to
make a call from
Jabber guest
client on
windows to
Cisco Unified IP
Phone 9971via
Cisco
Expressway-E

Make a video
call from Jabber
guest client on
windows to
CiscoUnified IP
Phone 9971via
Cisco
Expressway-E

UCJ10.6S.JG.G.004

PassedJabber guest
client(windows) ->
Cisco
Expressway-E ->
Cisco
Expressway-C ->
Unified CM ->
SX20 Quickset

To Verify that
user is able to
make a call from
Jabber guest
client on
Windows to
Cisco
TelePresence
SX20 Quickset
via Cisco
Expressway-E

Make a video
call from Jabber
guest client on
Windows to
SX20 Quickset
via Cisco
Expressway-E

UCJ10.6S.JG.G.005

PassedJabber guest
client(MAC) ->
Cisco
Expressway-E ->
Cisco
Expressway-C ->
Unified CM ->
MX300-G2

To Verify that
user is able to
make a call from
Jabber guest
client on MAC
to Cisco
TelePresence
System
MX300-G2 via
Cisco
Expressway-E

Make a video
call from Jabber
guest client on
MAC to
MX300-G2 via
Cisco
Expressway-E

UCJ10.6S.JG.G.006
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PassedJabber guest
client(MAC) ->
Cisco
Expressway-E ->
Cisco
Expressway-C ->
Unified CM ->
SX20 Quickset

To Verify that
user is able to
make a call from
Jabber guest
client on MAC
to Cisco
TelePresence
SX20 Quickset
via Cisco
Expressway-E

Make a video
call from Jabber
guest client on
MAC to SX20
Quickset via
Cisco
Expressway-E

UCJ10.6S.JG.G.007

PassedJabber guest
client(MAC) ->
Cisco
Expressway-E ->
Cisco
Expressway-C ->
Unified CM ->
EX60

To Verify that
user is able to
make a call from
Jabber guest
client on MAC
to EX60 via
Cisco
Expressway-E

Make a video
call from Jabber
guest client on
MAC to EX60
via Cisco
Expressway-E

UCJ10.6S.JG.G.008

PassedJabber guest
client(MAC) ->
Cisco
Expressway-E ->
Cisco
Expressway-C ->
Unified CM ->
8945

To Verify that
user is able to
make a call from
Jabber guest
client on MAC
to Cisco Unified
IP Phone 8945
via Cisco
Expressway-E

Make a video
call from Jabber
guest client on
MAC to Cisco
Unified IP
Phone 8945 via
Cisco
Expressway-E

UCJ10.6S.JG.G.009

PassedJabber guest
client(MAC) ->
Cisco
Expressway-E ->
Cisco
Expressway-C ->
Unified CM ->
9971

To Verify that
user is able to
make a call from
Jabber guest
client on MAC
to 9971 via
Cisco
Expressway-E

Make a video
call from Jabber
guest client on
MAC to Cisco
Unified IP
Phone 9971 via
Cisco
Expressway-E

UCJ10.6S.JG.G.010
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PassedJabber guest
client(windows) ->
Cisco
Expressway-E ->
Cisco
Expressway-C ->
Unified CM ->
SX80 Codec -> add
participant ->
MX300-G2

To Verify that
user is able to
Share
presentation
during adhoc
conference call
between SX80
Codec,
MX300-G2 and
Jabber guest
client on
windows via
Cisco
Expressway-E

Sharing
presentation
during adhoc
conference call
between SX80
Codec, Jabber
guest client on
windows and
MX300-G2 via
Cisco
Expressway-E

UCJ10.6S.JG.G.011

PassedJabber guest
client(windows) ->
Cisco
Expressway-E ->
Cisco
Expressway-C ->
Unified CM -> SIP
Trunk -> MCU
4510

To Verify that
user is able to
make a meet me
conference call
from Jabber
guest client to
Cisco
TelePresence
MCU 4510 via
Cisco
Expressway-E

Make ameet me
conference call
from Jabber
guest client on
Windows to
MCU 4510 via
Cisco
Expressway-E

UCJ10.6S.JG.G.012

PassedJabber guest
client(windows) ->
Cisco
Expressway-E ->
Cisco
Expressway-C ->
Unified CM -> SIP
Trunk -> Cisco TS
7010

To Verify that
user is able to
make a meet me
conference call
from Jabber
guest client to
Cisco
TelePresence
Server 7010 via
Cisco
Expressway-E

Make ameet me
conference call
from Jabber
guest client on
Windows to
Cisco TS 7010
via Cisco
Expressway-E

UCJ10.6S.JG.G.013
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PassedJabber guest
client(windows) ->
Cisco
Expressway-E ->
Cisco
Expressway-C ->
Unified CM -> SIP
Trunk ->Conductor
-> MCU 5310

To Verify that
user is able to
make a meet me
conference call
from Jabber
guest client to
Cisco
TelePresence
Conductor with
Cisco
TelePresence
MCU 5310 via
Cisco
Expressway-E

Make ameet me
conference call
from Jabber
guest client on
Windows to
Cisco
TelePresence
Conductor with
MCU 5310 via
Cisco
Expressway-E

UCJ10.6S.JG.G.014

PassedJabber guest
client(windows) ->
Cisco
Expressway-E ->
Cisco
Expressway-C ->
Unified CM -> SIP
Trunk ->Conductor
-> Cisco TS 7010

To Verify that
user is able to
make a meet me
conference call
from Jabber
guest client to
Cisco
TelePresence
Conductor with
Cisco
TelePresence
Server 7010 via
Cisco
Expressway-E

Make ameet me
conference call
from Jabber
guest client on
Windows to
Cisco
TelePresence
Conductor with
Cisco TS 7010
via Cisco
Expressway-E

UCJ10.6S.JG.G.015

PassedJabber guest
client(MAC) ->
Cisco
Expressway-E ->
Cisco
Expressway-C ->
Unified CM -> SIP
Trunk -> MCU
4510

To Verify that
user is able to
make a meet me
conference call
from Jabber
guest client to
Cisco
TelePresence
MCU 4510 via
Cisco
Expressway-E

Make ameet me
conference call
from Jabber
guest client on
MAC to MCU
4510 via Cisco
Expressway-E

UCJ10.6S.JG.G.016
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PassedJabber guest
client(MAC) ->
Cisco
Expressway-E ->
Cisco
Expressway-C ->
Unified CM -> SIP
Trunk -> Cisco TS
7010

To Verify that
user is able to
make a meet me
conference call
from Jabber
guest client to
Cisco
TelePresence
Server 7010 via
Cisco
Expressway-E

Make ameet me
conference call
from Jabber
guest client on
MAC to Cisco
TS 7010 via
Cisco
Expressway-E

UCJ10.6S.JG.G.017

PassedJabber guest
client(MAC) ->
Cisco
Expressway-E ->
Cisco
Expressway-C ->
Unified CM -> SIP
Trunk ->Conductor
-> MCU 5310

To Verify that
user is able to
make a meet me
conference call
from Jabber
guest client to
Cisco
TelePresence
Conductor with
Cisco
TelePresence
MCU 5310 via
Cisco
Expressway-E

Make ameet me
conference call
from Jabber
guest client on
MAC to Cisco
TelePresence
Conductor with
MCU 5310 via
Cisco
Expressway-E

UCJ10.6S.JG.G.018

PassedJabber guest
client(MAC) ->
Cisco
Expressway-E ->
Cisco
Expressway-C ->
Unified CM -> SIP
Trunk ->Conductor
-> Cisco TS 7010

To Verify that
user is able to
make a meet me
conference call
from Jabber
guest client to
Cisco
TelePresence
Conductor with
Cisco
TelePresence
Server 7010 via
Cisco
Expressway-E

Make ameet me
conference call
from Jabber
guest client on
MAC to Cisco
TelePresence
Conductor with
Cisco TS 7010
via Cisco
Expressway-E

UCJ10.6S.JG.G.019
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PassedJabber guest
client(IOS) ->
Cisco
Expressway-E ->
Cisco
Expressway-C ->
Unified CM ->
MX300-G2

To Verify that
user is able to
make a call from
Jabber guest
client on IOS to
Cisco
TelePresence
System
MX300-G2 via
Cisco
Expressway-E

Make a video
call from Jabber
guest client on
IOS to
MX300-G2 via
Cisco
Expressway-E

UCJ10.6S.JG.G.020

PassedJabber guest
client(Windows) ->
Cisco
Expressway-E ->
Cisco
Expressway-C ->
Unified CM ->
EX90

To verify that
user is able to
call adhoc link
from jabber
guest client on
Windows

Call adhoc link
from Jabber
Guest Client on
Windows

UCJ10.6S.JG.G.021

PassedJabber guest
client(MAC) ->
Cisco
Expressway-E ->
Cisco
Expressway-C ->
Unified CM ->
EX90 -> add
participant -> EX60
-> video conference

To Verify that
user is able to do
adhoc
conference
video call
between jabber
guest client on
MAC,EX90 and
EX60 via Cisco
Expressway-E

Adhoc
Conference
between jabber
guest client on
MAC, EX90
and EX60 via
Cisco
Expressway-E

UCJ10.6S.JG.G.022

PassedJabber guest
client(MAC) ->
Cisco
Expressway-E ->
Cisco
Expressway-C ->
Unified CM ->
EX90 ->
Presentation
sharing

To Verify that
user is able to
Share
presentation
between EX90
and Jabber guest
client on MAC
via Cisco
Expressway-E

Sharing
presentation
between EX90
and Jabber guest
client on MAC
via Cisco
Expressway-E

UCJ10.6S.JG.G.023
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PassedJabber guest
client(IOS) ->
Cisco
Expressway-E ->
Cisco
Expressway-C ->
Unified CM -> SIP
Trunk -> MCU
5310

To Verify that
user is able to
make a meet me
conference call
from Jabber
guest client on
IOS to Cisco
TelePresence
MCU 5310 via
Cisco
Expressway-E

Make ameet me
conference call
from Jabber
guest client on
IOS to MCU
5310 via Cisco
Expressway-E

UCJ10.6S.JG.G.024

PassedJabber guest
client(IOS) ->
Cisco
Expressway-E ->
Cisco
Expressway-C ->
Unified CM -> SIP
Trunk -> Cisco TS
7010

To Verify that
user is able to
make a meet me
conference call
from Jabber
guest client on
IOS to Cisco
TelePresence
Server 7010 via
Cisco
Expressway-E

Make ameet me
conference call
from Jabber
guest client on
IOS to Cisco TS
7010 via Cisco
Expressway-E

UCJ10.6S.JG.G.025

Cisco Collaboration Expressway
DefectsStatusCall Component

Flow
DescriptionTitleLogical ID

Passed500-32 -> Unified
CM -> Cisco VCS ->
Cisco VCS
Expressway -> EX90
(EM user) ->
Hold/Transfer ->
Cisco VCS
Expressway -> Cisco
VCS -> Unified CM
-> SX80 Codec

Verify whether the
consultative call
transfer from Cisco
TelePresence System
EX90 which is
logged in as
Extension Mobility
user registered in
Cisco Unified
Communications
Manager via
Collaboration EDGE
to Cisco
TelePresence SX80
Codec registered
with Cisco Unified
Communications
Manager works
successfully

Consultative
call transfer
from EX90
logged in as
EM user via
EDGE

UCJ10.6S.EDGE.G.001
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PassedEX90 (EM user) ->
Cisco VCS
Expressway -> Cisco
VCS -> Unified CM
-> SX80 Codec

Verify whether the
video call from
Cisco TelePresence
SystemEX90 logged
in as Extension
Mobility user
registered in Cisco
Unified
Communications
Manager via
Collaboration EDGE
to Cisco
TelePresence SX80
Codec registered
with Cisco Unified
Communications
Manager works
successfully

Making video
call from
EX90 logged
in as EM user
via EDGE

UCJ10.6S.EDGE.G.002

PassedEX90 (EM user) ->
Cisco VCS
Expressway -> Cisco
VCS -> Unified CM
-> SX80 Codec ->
Hold/Resume

Verify whether the
Hold/Resume for
video call in Cisco
TelePresence System
EX90 logged in as
Extension Mobility
user registered in
Cisco Unified
Communications
Manager via
Collaboration EDGE
to Cisco
TelePresence SX80
Codec registered
with Cisco Unified
Communications
Manager works
successfully

Hold/Resume
video call from
EX90 logged
in as EM user
via EDGE

UCJ10.6S.EDGE.G.003
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PassedEX90 (EM user) ->
Cisco VCS
Expressway -> Cisco
VCS -> Unified CM
cluster 1 -> SIP trunk
-> Unified CM
cluster 2 -> SX80
Codec

Verify whether the
video call from
Cisco TelePresence
SystemEX90 logged
in as Extension
Mobility user
registered with Cisco
Unified
Communications
Manager cluster 1
via Collaboration
EDGE to Cisco
TelePresence SX80
Codec registered
with Cisco Unified
Communications
Manager cluster 2
through SIP trunk
works successfully

Making
inter-cluster
video call from
EX90 logged
in as EM user
via EDGE

UCJ10.6S.EDGE.G.004

PassedEX90 (EM user) ->
Cisco VCS
Expressway -> Cisco
VCS -> Unified CM
-> EX60 ->
Presentation sharing

Verify whether the
presentation sharing
from Cisco
TelePresence System
EX90 logged in as
Extension Mobility
user, registered with
Cisco Unified
Communications
Manager via
Collaboration EDGE
to Cisco
TelePresence System
EX60 registeredwith
Cisco Unified
Communications
Manager works
successfully

Presentation
sharing from
EX90 logged
in as EM user
via EDGE

UCJ10.6S.EDGE.G.005
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PassedEX90 (EM user) ->
Cisco VCS
Expressway -> Cisco
VCS -> Unified CM
cluster 1 -> SIP trunk
-> Unified CM
cluster 2 -> SX80
Codec ->
Presentation sharing

Verify whether the
presentation sharing
from Cisco
TelePresence System
EX90 logged in as
Extension Mobility
user registered with
Cisco Unified
Communications
Manager cluster 1
via Collaboration
EDGE to Cisco
TelePresence SX80
Codec registered
with Cisco Unified
Communications
Manager cluster 2
through SIP trunk
works successfully

Making
inter-cluster
video call and
sharing
presentation
from EX90
logged in as
EM user

UCJ10.6S.EDGE.G.006

PassedEX90 (EM user) ->
Cisco VCS
Expressway -> Cisco
VCS -> Unified CM
-> SX80 Codec
EX90 (EM user) ->
Add participant ->
Cisco VCS
Expressway -> Cisco
VCS -> Unified CM
-> EX60

Verify whether
multisite conference
with three
participants from
Cisco TelePresence
SystemEX90 logged
in as Extension
Mobility user via
Collaboration EDGE
works successfully

Making
multisite
conference
with three
participants of
which EX90
logged in as
EM user via
EDGE

UCJ10.6S.EDGE.G.007

PassedEX90 -> Cisco VCS
Expressway -> Cisco
VCS -> Unified CM
cluster 1 -> SIP trunk
-> Unified CM
cluster 2 -> SX80
Codec

Verify whether the
video call from
Cisco TelePresence
System EX90
registered with Cisco
Unified
Communications
Manager cluster 1
via Collaboration
EDGE to Cisco
TelePresence SX80
Codec registered
with Cisco Unified
Communications
Manager cluster 2
through SIP trunk
works successfully

Making
inter-cluster
video call from
EX90 via
EDGE

UCJ10.6S.EDGE.G.008
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PassedEX90 -> Cisco VCS
Expressway -> Cisco
VCS -> Unified CM
-> EX60 ->
Presentation sharing

Verify whether the
presentation sharing
from Cisco
TelePresence System
EX90 registeredwith
Cisco Unified
Communications
Manager via
Collaboration EDGE
to Cisco
TelePresence System
EX60 egistered with
Cisco Unified
Communications
Manager works
successfully

Making video
call and
presentation
sharing from
EX90 via
EDGE

UCJ10.6S.EDGE.G.009

PassedEX90-> Cisco VCS
Expressway -> Cisco
VCS -> Unified CM
cluster 1 -> SIP trunk
-> Unified CM
cluster 2 -> SX80
Codec ->
presentation sharing

Verify whether the
presentation sharing
from Cisco
TelePresence System
EX90 registeredwith
Cisco Unified
Communications
Manager cluster 1
via Collaboration
EDGE to Cisco
TelePresence SX80
Codec registered
with Cisco Unified
Communications
Manager cluster 2
through SIP trunk
works successfully

Making
inter-cluster
video call and
sharing
presentation
from EX90

UCJ10.6S.EDGE.G.010

Passed500-32 -> Unified
CM -> Cisco VCS ->
Cisco VCS
Expressway -> SX20
Quick Set

Verify whether the
video call from
Cisco TelePresence
System 500-32 can
be established
successfully to Cisco
TelePresence SX20
Quick Set registered
in Unified CM via
Collaboration EDGE

Making Video
Call from
500-32
registered with
Unified CM to
SX20 Quick
Set registered
in Unified CM
via
Collaboration
EDGE

UCJ10.6S.EDGE.G.011
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Passed500-32 -> Unified
CM -> Cisco VCS ->
Cisco VCS
Expressway ->
Integrator Package
C90

Verify whether the
video call from
Cisco TelePresence
System 500-32 can
be established to
Cisco TelePresence
System Integrator
Package C90
registered in Unified
CM via
Collaboration EDGE

Making Video
Call from
500-32
registered with
Unified CM to
Integrator
Package C90
registered in
Unified CM
via
Collaboration
EDGE

UCJ10.6S.EDGE.G.012

Passed500-32 -> Unified
CM -> Cisco VCS ->
Cisco VCS
Expressway -> SX20
Quick Set ->
Presentation Sharing

Verify whether the
presentation in Cisco
TelePresence System
500-32 can be shared
with Cisco
TelePresence SX20
Quick Set registered
in Unified CM via
Collaboration EDGE

Presentation
sharing in
500-32
registered with
Unified CM to
SX20 Quick
Set registered
in Unified CM
via
Collaboration
EDGE

UCJ10.6S.EDGE.G.013

Passed500-32 -> Unified
CM -> Cisco VCS ->
Cisco VCS
Expressway ->
Integrator Package
C90 -> Presentation
Sharing

Verify whether the
presentation in Cisco
TelePresence System
500-32 can be shared
with Cisco
TelePresence System
Integrator Package
C90 registered in
Cisco Unified
Communications
Manager via
Collaboration EDGE

Presentation
sharing in
500-32
registered with
Unified CM to
Integrator
Package C90
registered in
Unified CM
via
Collaboration
EDGE

UCJ10.6S.EDGE.G.014
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PassedIntegrator Package
C90 -> Cisco VCS
Expressway -> Cisco
VCS A -> Unified
CM -> SIP Trunk ->
Cisco VCS B ->
Cisco TelePresence
MX300-G2

Verify whether video
call from Cisco
TelePresence System
Integrator Package
C90 registered with
Cisco Unified
Communications
Manager via
Collaboration EDGE
to Cisco
TelePresence
MX300-G2
registered with Cisco
Video
Communication
Server can be
established
successfully.

Making video
call from
Integrator
Package C90
registered in
Unified CM
via
Collaboration
EDGE to
Cisco
TelePresence
MX300-G2
registered with
Cisco VCS

UCJ10.6S.EDGE.G.015

PassedIntegrator Package
C90 -> Cisco VCS
Expressway -> Cisco
VCS -> Unified CM
-> SX80 Codec

Verify whether video
call from Cisco
TelePresence System
Integrator Package
C90 registered with
Cisco Unified
Communications
Manager via
collaboration EDGE
to Cisco
TelePresence SX80
Codec registered
with Cisco Unified
Communications
Manager can be
established
successfully

Making video
call from
Integrator
Package C90
register in
Unified CM
via
Collaboration
EDGE to
SX80 Codec
registered with
Unified CM

UCJ10.6S.EDGE.G.016
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PassedSX20 Quick Set ->
Cisco VCS
Expressway -> Cisco
VCS -> Unified CM
-> Cisco
TelePresence
MX300-G2

Verify whether video
call from Cisco
TelePresence SX20
Quick Set registered
with Cisco Unified
Communications
Manager via
Collaboration EDGE
to Cisco
TelePresence
MX300-G2
registered with
Unified
Communications
Manager can be
established
successfully.

Making video
call from
SX20 Quick
Set registered
with Unified
CM via
Collaboration
EDGE to
Cisco
TelePresence
MX300-G2
registered with
Unified CM
through

UCJ10.6S.EDGE.G.017

PassedSX20 Quick Set ->
Cisco VCS
Expressway -> Cisco
VCS->Unified CM
-> Cisco
TelePresence SX80
Codec

Verify whether video
call from SX20
Quick Set registered
with Cisco Unified
Communications
Manager through
Collaboration EDGE
to Cisco
TelePresence SX80
Codec registered
with Unified
Communications
Manager can be
established via
Collaboration
EDGE.

Making video
call from
SX20 Quick
Set registered
with Unified
CM through
Collaboration
EDGE to
Cisco
TelePresence
SX80 Codec
registered with
Unified CM

UCJ10.6S.EDGE.G.018

PassedSX20 Quick Set ->
Cisco VCS
Expressway -> Cisco
VCS -> Unified CM
-> Cisco
TelePresence SX80
Codec ->
Presentation Sharing

Verify whether the
presentation in Cisco
TelePresence SX20
QuickSet registered
with Cisco Unified
Communications
Manager via
Collaboration EDGE
can be shared
successfully with
Cisco TelePresence
SX80 Codec
registered with Cisco
Unified
Communications
Manager

Presentation
sharing in
SX20
QuickSet
registered with
Unified CM
via
Collaboration
EDGE to
SX80 Codec
registered with
Unified CM

UCJ10.6S.EDGE.G.019
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PassedSX20 Quick Set ->
Cisco VCS
Expressway -> Cisco
VCS A -> Unified
CM -> SIP Trunk ->
Cisco VCS B ->
Cisco TelePresence
SX80 Codec ->
Presentation Sharing

Verify whether the
presentation in Cisco
TelePresence SX20
Quick Set registered
with Cisco Unified
Communications
Manager via
Collaboration EDGE
can be shared with
Cisco TelePresence
SX80 Codec
registered with Cisco
Video
Communication
Server.

Presentation
sharing in
SX20 Quick
Set registered
with Unified
CM via
Collaboration
EDGE to
Cisco
TelePresence
SX80 Codec
registered with
Cisco VCS.

UCJ10.6S.EDGE.G.020

PassedCisco TelePresence
MX300-G2 ->
Unified CM -> Cisco
VCS -> Cisco VCS
Expressway -> SX20
QuickSet ->
Presentation Sharing

Verify whether the
presentation in Cisco
TelePresence
MX300-G2 can be
shared with SX20
Quick Set registered
in Unified
Communications
Manager via
Collaboration EDGE

Presentation
sharing in
Cisco
TelePresence
MX300-G2
registered with
Unified CM to
SX20 Quick
Set registered
in Unified CM
via
Collaboration
EDGE

UCJ10.6S.EDGE.G.021

PassedCisco TelePresence
MX300-G2 -> Cisco
VCS B -> SIP Trunk
-> Unified CM ->
Cisco VCS A->
Cisco VCS
Expressway ->
Collaboration
EDGE-> Cisco
TelePresence SX80
Codec ->
Presentation Sharing

Verify whether the
presentation in Cisco
TelePresence
MX300-G2
registered with Cisco
Video
Communication
Server can be shared
with Cisco
TelePresence SX20
Quick Set registered
in Unified
Communications
Manager via
Collaboration EDGE

Presentation
sharing in
Cisco
TelePresence
MX300-G2
registered with
Cisco VCS to
SX20 Quick
Set registered
in Unified CM
via
Collaboration
EDGE

UCJ10.6S.EDGE.G.022
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PassedEX90 -> Cisco VCS
B-> SIP Trunk ->
Unified CM -> Cisco
TelePresence
MX300-G2 ->
Hold/Transfer ->
Unified CM -> Cisco
VCSA ->CiscoVCS
Expressway -> SX20
Quick Set

Verify whether the
Consultative call
transfer from Cisco
TelePresence
MX300-G2
registered with Cisco
Unified
Communications
Manager to Cisco
TelePresence SX20
Quick Set registered
with Cisco Unified
Communications
Manager via
Collaboration EDGE
works successfully.

Consultative
Call Transfer
from Cisco
TelePresence
MX300-G2
registered with
Unified CM to
SX20 Quick
Set registered
with Unified
CM via
Collaboration
EDGE.

UCJ10.6S.EDGE.G.023

PassedSX20 Quick Set ->
Cisco VCS
Expressway -> Cisco
VCS A -> Unified
CM -> SIP Trunk ->
Cisco VCS B ->
Cisco TelePresence
SX80 Codec ->
Presentation Sharing

Verify whether the
presentation in Cisco
TelePresence SX20
Quick Set registered
with Cisco Unified
Communications
Manager via
Collaboration EDGE
can be shared with
Cisco TelePresence
SX80 Codec
registered with Cisco
Video
Communication
Server.

Presentation
sharing in
SX20 Quick
Set registered
with Unified
CM via
Collaboration
EDGE to
Cisco
TelePresence
SX80 Codec
registered with
Cisco VCS.

UCJ10.6S.EDGE.G.024

PassedCisco TelePresence
MX300-G2 ->
Unified CM -> Cisco
VCS -> Cisco VCS
Expressway -> SX20
Quick Set ->
Presentation Sharing

Verify whether the
presentation in Cisco
TelePresence
MX300-G2 can be
shared with SX20
Quick Set registered
in Unified
Communications
Manager via
Collaboration EDGE

Presentation
sharing in
Cisco
TelePresence
MX300-G2
registered with
Unified CM to
SX20 Quick
Set registered
in Unified CM
via
Collaboration
EDGE

UCJ10.6S.EDGE.G.025
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PassedCisco TelePresence
MX300-G2 -> Cisco
VCS B -> SIP Trunk
-> Unified CM ->
Cisco VCS A->
Cisco VCS
Expressway -> Cisco
TelePresence SX80
Codec ->
Presentation Sharing

Verify whether the
presentation in Cisco
TelePresence
MX300-G2
registered with Cisco
Video
Communication
Server can be shared
with Cisco
TelePresence SX20
Quick Set registered
in Unified
Communications
Manager via
Collaboration EDGE

Presentation
sharing in
Cisco
TelePresence
MX300-G2
registered with
Cisco VCS to
SX20 Quick
Set registered
in Unified CM
via
Collaboration
EDGE

UCJ10.6S.EDGE.G.026

PassedEX90 -> Cisco VCS
B-> SIP Trunk ->
Unified CM -> Cisco
TelePresence
MX300-G2 ->
Hold/Transfer ->
Unified CM -> Cisco
VCS A-> Cisco VCS
Expressway -> SX20
Quick Set

Verify whether the
Consultative call
transfer from Cisco
TelePresence
MX300-G2
registered with Cisco
Unified
Communications
Manager to Cisco
TelePresence SX20
Quick Set registered
with Cisco Unified
Communications
Manager via
Collaboration EDGE
works successfully.

Consultative
Call Transfer
from Cisco
TelePresence
MX300-G2
registered with
Unified CM to
SX20 Quick
Set registered
with Unified
CM via
Collaboration
EDGE.

UCJ10.6S.EDGE.G.027

PassedSX10 Quick Set ->
Unified CM -> Cisco
VCS -> Cisco VCS
Expressway ->SX20
Quick Set

Verify whether video
call from Cisco
TelePresence SX10
Quick Set registered
with Cisco Unified
Communications
Manager to Cisco
TelePresence SX20
Quick Set registered
with Cisco Unified
Communications
Manager via
Collaboration Edge
can be established
successfully.

Making video
call from
SX10 Quick
Set registered
with Unified
CM to SX20
Quick Set
registered with
Unified CM
via
Collaboration
EDGE

UCJ10.6S.EDGE.G.028
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PassedSX10 Quick Set ->
Unified CM -> Cisco
VCS -> Cisco VCS
Expressway ->
Integrator Package
C90

Verify whether video
call from Cisco
TelePresence SX10
Quick Set registered
with Cisco Unified
Communications
Manager to Cisco
TelePresence System
Integrator Package
C90 registered with
Cisco Unified
Communications
Manager via
Collaboration Edge
can be established
successfully.

Making video
call from
SX10 Quick
Set registered
with Unified
CM to
Integrator
Package C90
registered with
Unified CM
via
Collaboration
EDGE

UCJ10.6S.EDGE.G.029

Cisco Prime Collaboration

Cisco Prime Collaboration Provisioning
DefectsStatusDescriptionTitleLogical ID

PassedGo to Deploy-> Batch
Provisioning and verify
whether user is able to view
Country specific dial plans
Dial Plan system service is
added and activated as
default at Cisco Unified
Communications Manager
Web GUI while adding
Cisco Unified
Communications Manager
with Cisco Prime
Collaboration Provisioning

Provision the
Country specific
Dial Plan by default
while adding
Unified CM in CPC
Provisioning

UCJ10.6S.CPC-PR.G.001
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PassedGo to Deploy-> Batch
Provisioning and verify
whether user is able to view
AdHoc Conference system
service is added and
activated as default at Cisco
Unified Communications
Manager Web GUI while
adding Cisco Unified
Communications Manager
with Cisco Prime
Collaboration Provisioning

Provision the
AdHoc Conference
by default while
adding Unified CM
inCPCProvisioning

UCJ10.6S.CPC-PR.G.002

PassedGo to Deploy-> Batch
Provisioning and verify
whether user is able to view
Meetme Conference system
service is added and
activated as default at Cisco
Unified Communications
Manager Web GUI while
adding Cisco Unified
Communications Manager
with Cisco Prime
Collaboration Provisioning

Provision the
MeetmeConference
by default while
adding Unified CM
inCPCProvisioning

UCJ10.6S.CPC-PR.G.003

PassedGo to Deploy-> Batch
Provisioning and verify
whether user is able to view
One Touch Transfer system
service is added and
activated as default at Cisco
Unified Communications
Manager Web GUI while
adding Cisco Unified
Communications Manager
with Cisco Prime
Collaboration Provisioning

Provision the One
Touch Transfer by
default while adding
Unified CM in CPC
Provisioning

UCJ10.6S.CPC-PR.G.004

PassedGo to Deploy-> Batch
Provisioning and verify
whether user is able to view
BLF Speed Dials system
service is added and
activated as default at Cisco
Unified Communications
Manager Web GUI while
adding Cisco Unified
Communications Manager
with Cisco Prime
Collaboration Provisioning

Provision the BLF
Speed Dials by
default while adding
Unified CM in CPC
Provisioning

UCJ10.6S.CPC-PR.G.005
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PassedGo to Deploy-> Batch
Provisioning and verify
whether user is able to view
Intercom system service is
added and activated as
default at Cisco Unified
Communications Manager
Web GUI while adding
Cisco Unified
Communications Manager
with Cisco Prime
Collaboration Provisioning

Provision the
Intercom by default
while adding
Unified CM in CPC
Provisioning

UCJ10.6S.CPC-PR.G.006

PassedGo to Deploy-> Batch
Provisioning and verify
whether user is able to view
Directed Call Park system
service is added and
activated as default at Cisco
Unified Communications
Manager Web GUI while
adding Cisco Unified
Communications Manager
with Cisco Prime
Collaboration Provisioning

Provision the
Directed Call Park
by default while
adding Unified CM
inCPCProvisioning

UCJ10.6S.CPC-PR.G.007

PassedGo to Deploy-> Batch
Provisioning and verify
whether user is able to view
Hunt Group/ Call Queuing
system service is added and
activated as default at Cisco
Unified Communications
Manager Web GUI while
adding Cisco Unified
Communications Manager
with Cisco Prime
Collaboration Provisioning

Provision the Hunt
Group/ Call
Queuing by default
while adding
Unified CM in CPC
Provisioning

UCJ10.6S.CPC-PR.G.008

PassedGo to Deploy-> Batch
Provisioning and verify
whether user is able to view
Automatic Video system
service is added and
activated as default at Cisco
Unified Communications
Manager Web GUI while
adding Cisco Unified
Communications Manager
with Cisco Prime
Collaboration Provisioning

Provision the
Automatic Video by
default while adding
Unified CM in CPC
Provisioning

UCJ10.6S.CPC-PR.G.009
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PassedGo to Deploy-> Batch
Provisioning and verify
whether user is able to view
Auto Attendant system
service is added and
activated as default at Cisco
Unified Communications
Manager Web GUI while
adding Cisco Unified
Communications Manager
with Cisco Prime
Collaboration Provisioning

Provision the Auto
Attendant by default
while adding
Unified CM in CPC
Provisioning

UCJ10.6S.CPC-PR.G.010

PassedGo to Deploy-> Batch
Provisioning and verify
whether user is able to view
Visual Voicemail system
service is added and
activated as default at Cisco
Unified Communications
Manager Web GUI while
adding Cisco Unified
Communications Manager
with Cisco Prime
Collaboration Provisioning

Provision the Visual
Voicemail by
default while adding
Unified CM in CPC
Provisioning

UCJ10.6S.CPC-PR.G.011

PassedGo to Deploy-> Batch
Provisioning and verify
whether user is able to view
Call Pickup Groups system
service is added and
activated as default at Cisco
Unified Communications
Manager Web GUI while
adding Cisco Unified
Communications Manager
with Cisco Prime
Collaboration Provisioning

Provision the Call
Pickup Groups by
default while adding
Unified CM in CPC
Provisioning

UCJ10.6S.CPC-PR.G.012

PassedGo to Deploy-> Batch
Provisioning and verify
whether user is able to view
Phone Button Templates
system service is added and
activated as default at Cisco
Unified Communications
Manager Web GUI while
adding Cisco Unified
Communications Manager
with Cisco Prime
Collaboration Provisioning

Provision the Phone
Button Templates
by default while
adding Unified CM
inCPCProvisioning

UCJ10.6S.CPC-PR.G.013
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PassedGo to Deploy-> Batch
Provisioning and verify
whether user is able to view
Call back on busy system
service is added and
activated as default at Cisco
Unified Communications
Manager Web GUI while
adding Cisco Unified
Communications Manager
with Cisco Prime
Collaboration Provisioning

Provision the Call
back on busy by
default while adding
Unified CM in CPC
Provisioning

UCJ10.6S.CPC-PR.G.014

PassedGo to Deploy-> Batch
Provisioning and verify
whether user is able to view
Music on hold system
service is added and
activated as default at Cisco
Unified Communications
Manager Web GUI while
adding Cisco Unified
Communications Manager
with Cisco Prime
Collaboration Provisioning

Provision theMusic
on hold by default
while adding
Unified CM in CPC
Provisioning

UCJ10.6S.CPC-PR.G.015

PassedGo to Deploy-> Batch
Provisioning and verify
whether user is able to view
Corporate Directory system
service is added and
activated as default at Cisco
Unified Communications
Manager Web GUI while
adding Cisco Unified
Communications Manager
with Cisco Prime
Collaboration Provisioning

Provision the
Corporate Directory
by default while
adding Unified CM
inCPCProvisioning

UCJ10.6S.CPC-PR.G.016

PassedGo to Deploy-> Batch
Provisioning and verify
whether user is able to view
Single Number Reach
system service is added and
activated as default at Cisco
Unified Communications
Manager Web GUI while
adding Cisco Unified
Communications Manager
with Cisco Prime
Collaboration Provisioning

Single Number
Reach system
service at Unified
CMWebGUI while
adding Unified CM
inCPCProvisioning

UCJ10.6S.CPC-PR.G.017

Test Results for Cisco Unified Communications System Release 10.6 for Japan    
113

Test Results Summary
Cisco Prime Collaboration Provisioning



PassedGo to Deploy-> Batch
Provisioning and verify
whether user is able to view
Gateway templates system
service is added and
activated as default at Cisco
Unified Communications
Manager Web GUI while
adding Cisco Unified
Communications Manager
with Cisco Prime
Collaboration Provisioning

Gateway templates
system service at
Unified CMWeb
GUI while adding
Unified CM in CPC
Provisioning

UCJ10.6S.CPC-PR.G.018

PassedGo to Deploy->User
Provisioning and verify
whether end user is able to
import users from LDAP to
Cisco Prime Collaboration
Provisioning with newly
addedDepartment customer
field information

Import users with
newly added
Department
customer field
information from
LDAP

UCJ10.6S.CPC-PR.G.019

PassedGo to Deploy->User
Provisioning and verify
whether end user is able to
import users from LDAP to
Cisco Prime Collaboration
Provisioning with newly
added Manager User ID
customer field information

Import users with
newly added
Manager User ID
customer field
information from
LDAP

UCJ10.6S.CPC-PR.G.020

PassedGo to Deploy->User
Provisioning and verify
whether end user is able to
import users from LDAP to
Cisco Prime Collaboration
Provisioning with newly
added Title customer field
information

Import users with
newly added Title
customer field
information from
LDAP

UCJ10.6S.CPC-PR.G.021

PassedGo to Deploy->User
Provisioning and verify
whether end user is able to
import users from LDAP to
Cisco Prime Collaboration
Provisioning with newly
added City customer field
information

Import users with
newly added City
customer field
information from
LDAP

UCJ10.6S.CPC-PR.G.022
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PassedGo to Deploy->User
Provisioning and verify
whether end user is able to
import users from LDAP to
Cisco Prime Collaboration
Provisioning with newly
added State customer field
information

Import users with
newly added State
customer field
information from
LDAP

UCJ10.6S.CPC-PR.G.023

PassedGo to Deploy->User
Provisioning and verify
whether end user is able to
import users from LDAP to
Cisco Prime Collaboration
Provisioning with newly
added Office customer field
information

Import users with
newly added Office
customer field
information from
LDAP

UCJ10.6S.CPC-PR.G.024

PassedGo to Deploy->User
Provisioning and verify
whether end user is able to
import users from LDAP to
Cisco Prime Collaboration
Provisioning with newly
added Company customer
field information

Import users with
newly added
Company customer
field information
from LDAP

UCJ10.6S.CPC-PR.G.025

PassedGo to Deploy->User
Provisioning and verify
whether end user is able to
import users from LDAP to
Cisco Prime Collaboration
Provisioning with newly
added Street customer field
information

Import users with
newly added Street
customer field
information from
LDAP

UCJ10.6S.CPC-PR.G.026

PassedGo to Deploy->User
Provisioning and verify
whether end user is able to
import users from LDAP to
Cisco Prime Collaboration
Provisioning with newly
added Country customer
field information

Import users with
newly added
Country customer
field information
from LDAP

UCJ10.6S.CPC-PR.G.027

PassedGo to Deploy->User
Provisioning and verify
whether end user is able to
filter particular User ID
under User Provisioning
page by using Department
customer field

Filter User ID by
using Department
customer field
through CPC
Provisioning

UCJ10.6S.CPC-PR.G.028
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PassedGo to Deploy->User
Provisioning and verify
whether end user is able to
filter particular User ID
under User Provisioning
page by usingManager User
ID customer field

Filter User ID by
usingManager User
ID customer field
through CPC
Provisioning

UCJ10.6S.CPC-PR.G.029

PassedGo to Deploy->User
Provisioning and verify
whether end user is able to
filter particular User ID
under User Provisioning
page by using Title customer
field

Filter User ID by
using Title customer
field through CPC
Provisioning

UCJ10.6S.CPC-PR.G.030

PassedGo to Deploy->User
Provisioning and verify
whether end user is able to
filter particular User ID
under User Provisioning
page by using City customer
field

Filter User ID by
using City customer
field through CPC
Provisioning

UCJ10.6S.CPC-PR.G.031

PassedGo to Deploy->User
Provisioning and verify
whether end user is able to
filter particular User ID
under User Provisioning
page by using State
customer field

Filter User ID by
using State
customer field
through CPC
Provisioning

UCJ10.6S.CPC-PR.G.032

PassedGo to Deploy->User
Provisioning and verify
whether end user is able to
filter particular User ID
under User Provisioning
page by using Office
customer field

Filter User ID by
using Office
customer field
through CPC
Provisioning

UCJ10.6S.CPC-PR.G.033

PassedGo to Deploy->User
Provisioning and verify
whether end user is able to
filter particular User ID
under User Provisioning
page by using Company
customer field

Filter User ID by
using Company
customer field
through CPC
Provisioning

UCJ10.6S.CPC-PR.G.034
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PassedGo to Deploy->User
Provisioning and verify
whether end user is able to
filter particular User ID
under User Provisioning
page by using Street
customer field

Filter User ID by
using Street
customer field
through CPC
Provisioning

UCJ10.6S.CPC-PR.G.035

PassedGo to Deploy->User
Provisioning and verify
whether end user is able to
filter particular User ID
under User Provisioning
page by using Country
customer field

Filter User ID by
using Country
customer field
through CPC
Provisioning

UCJ10.6S.CPC-PR.G.036

PassedGo to Deploy->User
Provisioning and verify
whether end user is able to
import Japanese users from
LDAP to Cisco Prime
Collaboration Provisioning
with newly added customer
fields information

Import Japanese
users from LDAP
with newly added
customer fields
information

UCJ10.6S.CPC-PR.G.037

PassedGo to Deploy->User
Provisioning and verify
whether user is able to create
Japanese User ID
successfully with newly
added customer fields
through User Provisioning
page

Create Japanese
users with newly
added customer
fields through User
Provisioning page

UCJ10.6S.CPC-PR.G.038

PassedGo to Deploy->User
Provisioning and verify
whether user is able to view
respective error message
indication while creating
Japanese User ID with
special characters through
User Provisioning page

Error message
indication while
creating Japanese
User IDwith special
characters through
CPC Provisioning

UCJ10.6S.CPC-PR.G.039

PassedGo to Deploy->User
Provisioning and verify
whether user is able to view
respective error message
indication while creating
English User IDwith special
characters through User
Provisioning page

Error message
indication while
creating English
User IDwith special
characters through
CPC Provisioning

UCJ10.6S.CPC-PR.G.040
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PassedGo to Deploy->User
Provisioning and verify
whether user is able to
provision End Point line
with newly added Company
keyword and it should be
displayed at Cisco Unified
Communications Manager
Web GUI

Provision End Point
line with newly
added Company
Keyword through
CPC Provisioning

UCJ10.6S.CPC-PR.G.041

PassedGo to Deploy->User
Provisioning and verify
whether user is able to
provision End Point line
with newly added Midname
keyword and it should be
displayed at Cisco Unified
Communications Manager
Web GUI

Provision End Point
line with newly
added Midname
Keyword through
CPC Provisioning

UCJ10.6S.CPC-PR.G.042

PassedGo to Deploy->User
Provisioning and verify
whether user is able to
provision End Point line
with newly added
Department keyword and it
should be displayed at Cisco
Unified Communications
Manager Web GUI

Provision End Point
line with newly
added Department
Keyword through
CPC Provisioning

UCJ10.6S.CPC-PR.G.043

PassedGo to Deploy->User
Provisioning and verify
whether user is able to
provision End Point line
with newly added Email
keyword and it should be
displayed at Cisco Unified
Communications Manager
Web GUI

Provision End Point
line with newly
added Email
Keyword through
CPC Provisioning

UCJ10.6S.CPC-PR.G.044

PassedGo to Deploy->User
Provisioning and verify
whether user is able to
provision End Point line
with newly added Employee
ID keyword and it should be
displayed at Cisco Unified
Communications Manager
Web GUI

Provision End Point
line with newly
added Employee ID
Keyword through
CPC Provisioning

UCJ10.6S.CPC-PR.G.045
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PassedGo to Deploy->User
Provisioning and verify
whether user is able to
provision End Point line
with newly added Manager
keyword and it should be
displayed at Cisco Unified
Communications Manager
Web GUI

Provision End Point
line with newly
added Manager
Keyword through
CPC Provisioning

UCJ10.6S.CPC-PR.G.046

PassedGo to Deploy->User
Provisioning and verify
whether user is able to
provision End Point line
with newly added Country
keyword and it should be
displayed at Cisco Unified
Communications Manager
Web GUI

Provision End Point
line with newly
added Country
Keyword through
CPC Provisioning

UCJ10.6S.CPC-PR.G.047

PassedGo to Deploy->User
Provisioning and verify
whether user is able to
provision End Point line
with newly added Title
keyword and it should be
displayed at Cisco Unified
Communications Manager
Web GUI

Provision End Point
line with newly
added Title
Keyword through
CPC Provisioning

UCJ10.6S.CPC-PR.G.048

PassedGo to Deploy->User
Provisioning and verify
whether user is able to
provision End Point line
with newly added City
keyword and it should be
displayed at Cisco Unified
Communications Manager
Web GUI

Provision End Point
line with newly
added City
Keyword through
CPC Provisioning

UCJ10.6S.CPC-PR.G.049

PassedGo to Deploy->User
Provisioning and verify
whether user is able to
provision End Point line
with newly added State
keyword and it should be
displayed at Cisco Unified
Communications Manager
Web GUI

Provision End Point
line with newly
added State
Keyword through
CPC Provisioning

UCJ10.6S.CPC-PR.G.050
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PassedGo to Deploy->User
Provisioning and verify
whether user is able to
provision End Point line
with newly added Corporate
Mail keyword and it should
be displayed at Cisco
Unified Communications
Manager Web GUI

Provision End Point
line with newly
added Corporate
Mail Keyword
through CPC
Provisioning

UCJ10.6S.CPC-PR.G.051

PassedGo to Deploy->User
Provisioning and verify
whether end user is able to
move the User ID from one
Service Area to another
Service Area through User
Provisioning page

Move English User
ID from one Service
Area to another
Service Area
through User
Provisioning page

UCJ10.6S.CPC-PR.G.052

PassedGo to Deploy->User
Provisioning and verify
whether end user is able to
move the Japanese User ID
from one Service Area to
another Service Area
through User Provisioning
page

Move JapaneseUser
ID from one Service
Area to another
Service Area
through User
Provisioning page

UCJ10.6S.CPC-PR.G.053

PassedGo to Deploy->User
Provisioning and verify
whether end user is able to
move bulk English users
from one Service Area to
another Service Area
through User Provisioning
page

Move bulk English
users from one
Service Area to
another Service
Area through User
Provisioning page

UCJ10.6S.CPC-PR.G.054

PassedGo to Deploy->User
Provisioning and verify
whether end user is able to
move bulk Japanese users
from one Service Area to
another Service Area
through User Provisioning
page

Move bulk Japanese
users from one
Service Area to
another Service
Area through User
Provisioning page

UCJ10.6S.CPC-PR.G.055

PassedGo to Deploy->User
Provisioning and verify
whether end user is able to
move English User ID from
one Domain to another
Domain through User
Provisioning page

Move English User
ID from one
Domain to another
Domain through
User Provisioning
page

UCJ10.6S.CPC-PR.G.056
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PassedGo to Deploy->User
Provisioning and verify
whether end user is able to
move Japanese user ID from
one Domain to another
Domain through User
Provisioning page

Move JapaneseUser
ID from one
Domain to another
Domain through
User Provisioning
page

UCJ10.6S.CPC-PR.G.057

PassedGo to Deploy->User
Provisioning and verify
whether end user is able to
move bulk English users
from one Domain to another
Domain through User
Provisioning page

Move bulk English
users from one
Domain to another
Domain through
User Provisioning
page

UCJ10.6S.CPC-PR.G.058

PassedGo to Deploy->User
Provisioning and verify
whether end user is able to
move bulk Japanese users
from one Domain to another
Domain through User
Provisioning page

Move bulk Japanese
users from one
Domain to another
Domain through
User Provisioning
page

UCJ10.6S.CPC-PR.G.059

PassedGo to Deploy->User
Provisioning and verify
whether end user is able to
view the status while
moving English user ID
from one Service Area to
another Service Area
through User Provisioning
page

Status whilemoving
English User ID
from one Service
Area to another
Service Area
through User
Provisioning page

UCJ10.6S.CPC-PR.G.060

PassedGo to Deploy->User
Provisioning and verify
whether end user is able to
view the status while
moving Japanese user ID
from one Service Area to
another Service Area
through User Provisioning
page

Status whilemoving
Japanese User ID
from one Service
Area to another
Service Area
through User
Provisioning page

UCJ10.6S.CPC-PR.G.061

PassedGo to Deploy->User
Provisioning and verify
whether end user is able to
view the status while
moving English user ID
from one Domain to another
Domain through User
Provisioning page

Status whilemoving
English User ID
from oneDomain to
another Domain
through User
Provisioning page

UCJ10.6S.CPC-PR.G.062
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PassedGo to Deploy->User
Provisioning and verify
whether end user is able to
view the status while
moving Japanese user ID
from one Domain to another
Domain through User
Provisioning page

Status whilemoving
Japanese User ID
from oneDomain to
another Domain
through User
Provisioning page

UCJ10.6S.CPC-PR.G.063

PassedGo to Design-> User
Provisioning Setup and
verify whether user is able
to create Service Area with
respective Dial Plan and all
the users provisioned to that
Service Area are able to
utilize respective Dial Plan

Create Service Area
with Dial Plan
through CPC
Provisioning

UCJ10.6S.CPC-PR.G.064

PassedGo toDeploy->Provisioning
Inventory-> Manage
Endpoints and verify
whether user is able to delete
endpoint assigned with the
respective user which is
imported fromCiscoUnified
Communications Manager

Delete endpoint
imported from
Unified CM through
CPC Provisioning

UCJ10.6S.CPC-PR.G.065

PassedGo toDeploy->Provisioning
Inventory-> Manage
Endpoints and verify
whether end user is able to
assign users to open space
devices imported fromCisco
Unified Communications
Manager

Assign Users to
open space devices
through CPC
Provisioning

UCJ10.6S.CPC-PR.G.066

PassedGo toDeploy->Provisioning
Inventory-> Manage
Endpoints and verify
whether end user is able to
delete bulk number of
endpoints assigned with the
respective users which are
imported fromCiscoUnified
Communications Manager

Delete bulk number
of endpoints
imported from
Unified CM through
CPC Provisioning

UCJ10.6S.CPC-PR.G.067
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PassedGo to Design-> Getting
Started Wizard and verify
whether user is able to add
Cisco Unified
Communications Manager
10.5.1 and integrate with
other UC applications(Cisco
Unity Connection, Cisco
Unified IM & Presence)
through Cisco Prime
Collaboration Provisioning

Add Unified CM
10.5.1 and integrate
with other UC
applications using
Getting Started
Wizard through
CPC Provisioning

UCJ10.6S.CPC-PR.G.068

PassedGo to Design-> Getting
Started Wizard and verify
whether user is able to add
Cisco Unity Connection
10.5.1 and integrate with
other UC applications(Cisco
Unified Communications
Manger, Cisco Unified IM
& Presence) through Cisco
Prime Collaboration
Provisioning

Add Cisco Unity
Connection 10.5.1
and integrate with
other UC
applications using
Getting Started
Wizard through
CPC Provisioning

UCJ10.6S.CPC-PR.G.069

PassedGo to Design-> Getting
Started Wizard and verify
whether user is able to add
Cisco Unified IM &
Presence 10.5.1 and
integrate with other UC
applications(Cisco Unified
Communications Manager,
Cisco Unity Connection)
through Cisco Prime
Collaboration Provisioning

Add Cisco Unified
IM & Presence
10.5.1 and integrate
with other UC
applications using
Getting Started
Wizard through
CPC Provisioning

UCJ10.6S.CPC-PR.G.070

Cisco Prime Collaboration Assurance
DefectsStatusDescriptionTitleLogical ID

PassedGo to Operate -> Utilization
Monitor -> Conferencing
Devices and verify whether
user is able to see correct status
of Cisco TelePresence MCU
4510 after the successful
discovery

Status of MCU
4510 under
Conferencing
Devices

UCJ10.6S.CPC-AS.G.001
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PassedGo to Operate -> Utilization
Monitor -> Conferencing
Devices and verify whether
user is able to see correct name
of Cisco TelePresence MCU
4510 after the successful
discovery

Check name of
MCU 4510 under
the Conferencing
Devices

UCJ10.6S.CPC-AS.G.002

PassedGo to Operate -> Utilization
Monitor -> Conferencing
Devices and verify whether
user is able to see the correct
IP Address of Cisco
TelePresence MCU 4510

Check IP Address
ofMCU4510 under
the Conferencing
Devices

UCJ10.6S.CPC-AS.G.003

PassedGo to Operate -> Utilization
Monitor -> Conferencing
Devices and verify whether
user is able to see the correct
Video Ports/ Screen License
Usage of an idle Cisco
TelePresence MCU 4510

Check Video Ports/
Screen License
Usage of an idle
MCU 4510 under
the Conferencing
Devices

UCJ10.6S.CPC-AS.G.004

PassedGo to Operate -> Utilization
Monitor -> Conferencing
Devices and verify whether
user is able to see the Video
Ports/ Screen License Usage
as 1 of total available during a
Meet Me conference with a
single participant using Cisco
TelePresence MCU 4510

Check Video Ports/
Screen License
Usage of MCU
4510 during a Meet
Me conference with
one participant

UCJ10.6S.CPC-AS.G.005

PassedGo to Operate -> Utilization
Monitor -> Conferencing
Devices and verify whether
user is able to see the Video
Ports/ Screen License Usage
as 2 of total available during a
Meet Me conference with two
participants using Cisco
TelePresence MCU 4510

Check Video Ports/
Screen License
Usage of MCU
4510 during a Meet
Me conference with
two participants

UCJ10.6S.CPC-AS.G.006

PassedGo to Operate -> Utilization
Monitor -> Conferencing
Devices and verify whether
user is able to see the Video
Ports/ Screen License Usage
as 3 of total available during a
MeetMe conferencewith three
participants using Cisco
TelePresence MCU 4510

Check Video Ports/
Screen License
Usage of MCU
4510 during a Meet
Me conference with
three participants

UCJ10.6S.CPC-AS.G.007
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PassedGo to Operate -> Utilization
Monitor -> Conferencing
Devices and verify whether
user is able to see the Video
Ports/ Screen License Usage
as 3 of total available during
an ad hoc conference using
Cisco TelePresence MCU
4510

Check Video Ports/
Screen License
Usage of MCU
4510 during an Ad
hoc conference

UCJ10.6S.CPC-AS.G.008

PassedGo to Operate -> Utilization
Monitor -> Conferencing
Devices and verify whether
user is able to see the correct
total number of ports as 20 for
Cisco TelePresence MCU
4510 licensed for 20 video
ports under the Video Ports/
Screen License Usage

Check total number
of ports for MCU
4510 under Video
Ports/ Screen
License Usage

UCJ10.6S.CPC-AS.G.009

PassedGo to Operate -> Utilization
Monitor -> Conferencing
Devices and verify whether
user is able to see the Audio
Ports Used as 1 of total
available during a Meet Me
conference with a single audio
participant using Cisco
TelePresence MCU 4510

Check Audio Ports
Used byMCU4510
during a Meet Me
conferencewith one
participant

UCJ10.6S.CPC-AS.G.010

PassedGo to Operate -> Utilization
Monitor -> Conferencing
Devices and verify whether
user is able to see the Audio
Ports Used as 2 of total
available during a Meet Me
conference with two audio
participants using Cisco
TelePresence MCU 4510

Check Audio Ports
Used byMCU4510
during a Meet Me
conferencewith two
participants

UCJ10.6S.CPC-AS.G.011

PassedGo to Operate -> Utilization
Monitor -> Conferencing
Devices and verify whether
user is able to see the Audio
Ports Used as 3 of total
available during a Meet Me
conference with three audio
participants using Cisco
TelePresence MCU 4510

Check Audio Ports
Used byMCU4510
during a Meet Me
conference with
three participants

UCJ10.6S.CPC-AS.G.012
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PassedGo to Operate -> Utilization
Monitor -> Conferencing
Devices and verify whether
user is able to launch device
360 view for Cisco
TelePresence MCU 4510

Launch Device 360
view forMCU4510
under the
Conferencing
Devices

UCJ10.6S.CPC-AS.G.013

PassedGo to Operate -> Utilization
Monitor -> Conferencing
Devices and verify whether
user is able to cross launch
Cisco TelePresence MCU
4510 by clicking the IP
Address cross launch link

Cross launch MCU
4510 using IP
Address cross
launch link under
the Conferencing
Devices

UCJ10.6S.CPC-AS.G.014

PassedGo to Operate -> Utilization
Monitor -> Conferencing
Devices and verify whether
user is able to see the correct
name of Cisco TelePresence
Server on VM

Check the name of
Cisco TelePresence
Server on VM
under the
Conferencing
Devices

UCJ10.6S.CPC-AS.G.015

PassedGo to Operate -> Utilization
Monitor -> Conferencing
Devices and verify whether
user is able to see the correct
IP Address of Cisco
TelePresence Server on VM

Check the IP
Address of Cisco
TelePresence Server
on VM under the
Conferencing
Devices

UCJ10.6S.CPC-AS.G.016

PassedGo to Operate -> Utilization
Monitor and verify whether
user is able to see the correct
Video Ports/ Screen License
Usage of an idle Cisco
TelePresence Server on VM

Check Video Ports/
Screen License
Usage of an idle
Cisco TelePresence
Server on VM
under the
Conferencing
Devices

UCJ10.6S.CPC-AS.G.017

PassedGo to Operate -> Utilization
Monitor -> Conferencing
Devices and verify whether
user is able to see the Video
Ports/ Screen License Usage
as 1 of total available during a
Meet Me conference with a
single participant using Cisco
TelePresence Server on VM

Check Video Ports/
Screen License
Usage of Cisco
TelePresence Server
on VM during a
Meet Me
conferencewith one
participant

UCJ10.6S.CPC-AS.G.018
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PassedGo to Operate -> Utilization
Monitor -> Conferencing
Devices and verify whether
user is able to see the Video
Ports/ Screen License Usage
as 2 of total available during a
Meet Me conference with two
participants using Cisco
TelePresence Server on VM

Check Video Ports/
Screen License
Usage of Cisco
TelePresence Server
on VM during a
Meet Me
conferencewith two
participants

UCJ10.6S.CPC-AS.G.019

PassedGo to Operate -> Utilization
Monitor -> Conferencing
Devices and verify whether
user is able to see the Video
Ports/ Screen License Usage
as 3 of total available during a
MeetMe conferencewith three
participants using Cisco
TelePresence Server on VM

Check Video Ports/
Screen License
Usage of Cisco
TelePresence Server
on VM during a
Meet Me
conference with
three participants

UCJ10.6S.CPC-AS.G.020

PassedGo to Operate -> Utilization
Monitor -> Conferencing
Devices and verify whether
user is able to see the correct
total number of ports for Cisco
TelePresence Server on VM
under the Video Ports/ Screen
License Usage

Check the total
number of ports
under Video Ports/
Screen License
Usage for a Cisco
TelePresence Server
on VM

UCJ10.6S.CPC-AS.G.021

PassedGo to Operate -> Utilization
Monitor -> Conferencing
Devices and verify whether
user is able to launch device
360 view for Cisco
TelePresence Server on VM
correctly

Launch Device 360
view for Cisco
TelePresence Server
on VM under the
Conferencing
Devices

UCJ10.6S.CPC-AS.G.022

PassedGo to Operate -> Utilization
Monitor -> Conferencing
Devices and verify whether
user is able to cross launch
Cisco TelePresence Server on
VMby clicking the IP Address
cross launch link

Cross launch Cisco
TelePresence Server
on VM using IP
Address cross
launch link under
the Conferencing
Devices

UCJ10.6S.CPC-AS.G.023

PassedGo to Home -> Log Collection
Center and verify whether user
is able see CUC as predefined
group successfully

Check CUC as
predefined group
under log collection
center

UCJ10.6S.CPC-AS.G.024
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PassedGo to Home -> Log Collection
Center and verify whether user
is able see CUCM as
predefined group successfully

Check CUCM as
predefined group
under log collection
center

UCJ10.6S.CPC-AS.G.025

PassedGo to Home -> Log Collection
Center and verify whether user
is able see IM & Presence as
predefined group successfully

Check IM &
Presence as
predefined group
under log collection
center

UCJ10.6S.CPC-AS.G.026

PassedGo to Home -> Log Collection
Center and verify whether user
is able to add CUC
successfully

Add CUC under log
collection center

UCJ10.6S.CPC-AS.G.027

PassedGo to Home -> Log Collection
Center and verify whether user
is able to delete CUC
successfully

Delete CUC under
log collection center

UCJ10.6S.CPC-AS.G.028

PassedGo to Home -> Log Collection
Center and verify whether user
is able to edit Time Zone for
CUC successfully

Edit Time Zone for
CUC under log
collection center

UCJ10.6S.CPC-AS.G.029

PassedGo to Home -> Log Collection
Center and verify whether user
is able to add IM and Presence
successfully

Add IM and
Presence under log
collection center

UCJ10.6S.CPC-AS.G.030

PassedGo to Home -> Log Collection
Center and verify whether user
is able to delete IM and
Presence successfully

Delete IM and
Presence under log
collection center

UCJ10.6S.CPC-AS.G.031

PassedGo to Home -> Log Collection
Center and verify whether user
is able to edit Time Zone for
IM and Presence successfully

Edit Time Zone for
IM and Presence
under log collection
center

UCJ10.6S.CPC-AS.G.032

PassedVerify whether user can enable
the Auto Refresh for the
OpsView dashlet on the Home
Page of the Cisco Prime
Collaboration Assurance

Enable Auto
Refresh for
OpsView dashlet

UCJ10.6S.CPC-AS.G.033

PassedVerify whether user can disble
the Auto Refresh for the
OpsView dashlet on the Home
Page of the Cisco Prime
Collaboration Assurance

Disable Auto
Refresh for
OpsView dashlet

UCJ10.6S.CPC-AS.G.034
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PassedGo to Operate -> DeviceWork
Center and verify whether user
can enable Auto-Refresh
successfully

Enable Auto
Refresh on the
DWC page

UCJ10.6S.CPC-AS.G.035

PassedGo to Operate -> DeviceWork
Center and verify whether user
can disable Auto-Refresh
successfully

Disable Auto
Refresh on the
DWC page

UCJ10.6S.CPC-AS.G.036

PassedGo to Operate -> Alarms and
Events and verify whether user
can enable Auto-Refresh
successfully

Enable
Auto-Refresh on the
Alarms and Event
page

UCJ10.6S.CPC-AS.G.037

PassedGo to Operate -> Alarms and
Events and verify whether user
can disable Auto-Refresh
successfully

Disable
Auto-Refresh on the
Alarms and Event
page

UCJ10.6S.CPC-AS.G.038

PassedGo to Operate -> Endpoint
Diagnostics and verify whether
user can enable Auto-Refresh
successfully

Enable
Auto-Refresh on the
Endpoint
Diagnostics page

UCJ10.6S.CPC-AS.G.039

PassedGo to Operate -> Endpoint
Diagnostics and verify whether
user can disable Auto-Refresh
successfully

Disable
Auto-Refresh on the
Endpoint
Diagnostics page

UCJ10.6S.CPC-AS.G.040

PassedGo to Report -> Interactive
Reports -> UCM/CME Voice
Call Quality Reports -> CDR
and verify whether user is able
to get the incoming protocol
type in the CDR report

Check Incoming
protocol type in
CDR report

UCJ10.6S.CPC-AS.G.041

PassedGo to Report -> Interactive
Reports -> UCM/CME Voice
Call Quality Reports -> CDR
and verify whether user is able
to get the Outgoing protocol
type in the CDR report

Check Outgoing
protocol type in
CDR report

UCJ10.6S.CPC-AS.G.042

PassedGo to Home -> Performance
and verify whether user is able
to get the new improved
dashboard for UCM clusters

New improved
custom dashboard
for UCM clusters
under performance
monitor

UCJ10.6S.CPC-AS.G.043
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PassedGo to Operate -> DeviceWork
Center and verify whether user
is able to launch the
PerformanceMonitor page for
Cisco Unified
Communications Manager
from the 360 view page under
the Device Work Center

Launch
Performance
Monitor page for
Unified CM from
360 view

UCJ10.6S.CPC-AS.G.044

PassedGo to Operate -> DeviceWork
Center and verify whether user
is able to get the Maximized
Device 360 view for Audio IP
Phones

Maximized Device
360 view for Audio
IP Phones

UCJ10.6S.CPC-AS.G.045

PassedGo to Operate -> DeviceWork
Center and verify whether user
is able to get the Maximized
Device 360 view for Cisco
Jabber group

Maximized Device
360 view for Cisco
Jabber group

UCJ10.6S.CPC-AS.G.046

PassedGo to Operate -> DeviceWork
Center and verify whether user
is able to get the Maximized
Device 360 view for Desktop
video group

Maximized Device
360 view for
Desktop Video
group

UCJ10.6S.CPC-AS.G.047

PassedGo to Operate -> DeviceWork
Center and verify whether user
is able to get the Maximized
Device 360 view for Hard
Endpoints

Maximized Device
360 view for Hard
Endpoints

UCJ10.6S.CPC-AS.G.048

PassedGo to Operate -> DeviceWork
Center and verify whether user
is able to get the Maximized
Device 360 view for Mass
Endpoints

Maximized Device
360 view for Mass
Endpoints

UCJ10.6S.CPC-AS.G.049

PassedGo to Operate -> DeviceWork
Center and verify whether user
is able to get the Maximized
Device 360 view for Mobile
Endpoints

Maximized Device
360 view for
Mobile Endpoints

UCJ10.6S.CPC-AS.G.050

PassedGo to Operate -> DeviceWork
Center and verify whether user
is able to get the Maximized
Device 360 view for Soft
Clients

Maximized Device
360 view for Soft
clients

UCJ10.6S.CPC-AS.G.051
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PassedGo to Operate -> DeviceWork
Center and verify whether user
is able to get the Maximized
Device 360 view for Unknown
Devices

Maximized Device
360 view for
Unknown Devices

UCJ10.6S.CPC-AS.G.052

PassedGo to Operate -> DeviceWork
Center and verify whether user
is able to get the Maximized
Device 360 view for 3rd party
devices

Maximized Device
360 view for 3rd
party devices

UCJ10.6S.CPC-AS.G.053

PassedGo to Operate -> DeviceWork
Center and verify whether user
is able to get the Maximized
Device 360 view for
Gatekeepers

Maximized Device
360 view for
Gatekeepers

UCJ10.6S.CPC-AS.G.054

PassedGo to Operate -> DeviceWork
Center and verify whether user
is able to get the Maximized
Device 360 view for UC
Applications

Maximized Device
360 view for UC
Applications

UCJ10.6S.CPC-AS.G.055

PassedGo to Operate -> DeviceWork
Center and verify whether user
is able to create a profile for
Cisco TelePresence Video
Communication Server
Expressway successfully

Create a profile for
Cisco VCS
Expressway

UCJ10.6S.CPC-AS.G.056

PassedGo to Operate -> DeviceWork
Center and verify whether user
is able to discover Cisco
TelePresence Video
Communication Server
Expressway successfully

Discover Cisco
VCSExpressway in
CPC Assurance

UCJ10.6S.CPC-AS.G.057

PassedGo to Operate -> DeviceWork
Center and verify whether user
is able to delete a profile for
Cisco TelePresence Video
Communication Server
Expressway successfully

Delete a profile for
Cisco VCS
Expressway

UCJ10.6S.CPC-AS.G.058

PassedGo to Operate -> DeviceWork
Center and verify whether user
is able to discover Gateway
Router with SNMPv3
authentication successfully

Discover Gateway
Router with
SNMPv3
authentication

UCJ10.6S.CPC-AS.G.059
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PassedGo to Operate -> Call
Signaling Analyzer and verify
whether user is able to open
Call Ladder Diagram in a new
tab successfully

Open Call Ladder
Diagram in a new
tab

UCJ10.6S.CPC-AS.G.060

PassedVerify whether user is able to
get the home page within 5 (+/-
3 ) seconds after the successful
login

Check UI response
time for Login to
the CPC Assurance

UCJ10.6S.CPC-AS.G.061

PassedGo to Operate -> DeviceWork
Center and verify whether user
is able to get the Device 360
view and its detailed view page
within 5 (+/- 3 ) seconds

Check UI response
time for Device 360
view and its
detailed view

UCJ10.6S.CPC-AS.G.062

PassedVerify whether user is able to
see the new improved Home
Page in the Cisco Prime
Collaboration Assurance 10.6

New improved
Home Page of CPC
Assurance

UCJ10.6S.CPC-AS.G.063

PassedVerify whether user is able to
get the Treemap Cluster view
for the OpsView dashlet on the
home Page of Cisco Prime
Collaboration Assurance

Treemap Cluster
view for OpsView
dashlet on Home
Page

UCJ10.6S.CPC-AS.G.064

PassedVerify whether user is able to
get the List view for the
OpsView dashlet on the home
Page of Cisco Prime
Collaboration Assurance

List view for
OpsView dashlet on
Home Page

UCJ10.6S.CPC-AS.G.065

PassedVerify whether user is
redirected to the detailed page
of cluster after clicking the
cluster's box of the OpsView
page

Navigate to the
detailed page of a
cluster from
OpsView Page

UCJ10.6S.CPC-AS.G.066

PassedVerify whether user is able to
get all the alarm summary for
TelePresence endpoints,
Devices and Infrastructure
after selecting the Alarm
dashlet on the Home Page

Check Alarm
dashlet under the
Home Page

UCJ10.6S.CPC-AS.G.067

PassedGo to Administration ->
Certificate Management and
verify whether user is able to
generate a new CSR
successfully

Generate CSR
under the Certificate
Management page

UCJ10.6S.CPC-AS.G.068
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PassedGo to Administration ->
Certificate Management and
verify whether user is able to
download the CSR
successfully

Download CSR
under the Certificate
Management page

UCJ10.6S.CPC-AS.G.069

PassedGo to Administration ->
Certificate Management and
verify whether user is able to
use two characters for the
Country Name field
successfully

Validate Country
Name as two
characters under
Certificate
Management

UCJ10.6S.CPC-AS.G.070

PassedGo to Administration ->
Certificate Management and
verify whether user is able to
get the warning message for
using lower case character in
Country Name field
successfully

Check warning
message for lower
case character in
Country Name field

UCJ10.6S.CPC-AS.G.071

PassedGo to Administration ->
Certificate Management and
verify whether user is able to
get the warning message for
entering non-alphabet
characters for Country Name
field successfully

Check warning
message for
non-alphabet
characters in
Country Name field

UCJ10.6S.CPC-AS.G.072

PassedGo to Administration ->
Certificate Management and
verify whether user is able to
get the warning message as
Value Required if any
mandatory field is skipped
without any value

Check Value
Required warning
message after
skipping a
mandatory field
under Certificate
Management

UCJ10.6S.CPC-AS.G.073

PassedGo to Administration ->
Certificate Management and
verify whether user is able to
get the warning message for
entering non-alphabet
characters in State or Province
Name field successfully

Check warning
message for
non-alphabet
characters in State
or Province Name
field

UCJ10.6S.CPC-AS.G.074

PassedGo to Administration ->
Certificate Management and
verify whether user is able to
get the warning message for
entering non-alphabet
characters in Locality Name
field successfully

Check warning
message for
non-alphabet
characters in
Locality Name field

UCJ10.6S.CPC-AS.G.075
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PassedGo to Administration ->
Certificate Management and
verify whether user is able to
get the warning message for
entering non-alphabet
characters in Organization
Name field successfully

Check warning
message for
non-alphabet
characters in
Organization Name
field

UCJ10.6S.CPC-AS.G.076

PassedGo to Administration ->
Certificate Management and
verify whether user is able to
get the warning message for
entering non-alphabet
characters in Organizational
Unit Name field successfully

Check warning
message for
non-alphabet
characters in
Organizational Unit
Name field

UCJ10.6S.CPC-AS.G.077

PassedGo to Administration ->
Certificate Management and
verify whether user is able to
get a successful message after
generating a CSR

Verify successful
message for
generating a CSR

UCJ10.6S.CPC-AS.G.078

PassedGo to Operate -> Utilization
Monitor and verify whether
user is able to get all the Trunk
Utilization list under the
UtilizationMonitor dashboard

Trunk Utilization
Under Utilization
Monitor dashboard

UCJ10.6S.CPC-AS.G.079

Cisco Prime Collaboration Analytics
DefectsStatusDescriptionTitleLogical ID

PassedGo to Cisco Prime
Collaboration Assurance
Web-GUI -> Analyze ->
Custom Report Generator
then click New Query Icon
and verify whether user is
able to generate a new query
successfully

Generate New
Query in Custom
Report Generator

UCJ10.6S.CPC-AN.G.001

PassedGo to Cisco Prime
Collaboration Assurance
Web-GUI -> Analyze ->
Custom Report Generator
then choose cube, dimensions
, measures and verify
whether user is able to
Generate Custom Report
successfully

Generate Custom
Report by choosing
Cube , Dimension
and Measures

UCJ10.6S.CPC-AN.G.002
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PassedGo to Cisco Prime
Collaboration Assurance
Web-GUI -> Analyze ->
Custom Report Generator
then choose the cube,
Columns, rows and verify
whether user is able to save
query successfully

Save a query in
Custom Report
Generator

UCJ10.6S.CPC-AN.G.003

PassedGo to Cisco Prime
Collaboration Assurance
Web-GUI -> Analyze ->
Custom Report Generator
then click open query icon
and verify whether user is
able to open an existing
query successfully

Open an existing
query in Custom
Report Generator

UCJ10.6S.CPC-AN.G.004

PassedGo to Cisco Prime
Collaboration Assurance
Web-GUI -> Analyze ->
Custom Report Generator
then choose the cube,
columns, rows, mode as
Stacked Bar and verify
whether user is able to
generate and export the
custom report in XLS format

Generate custom
report and export
the report in XLS
format

UCJ10.6S.CPC-AN.G.005

PassedGo to Cisco Prime
Collaboration Assurance
Web-GUI -> Analyze ->
Custom Report Generator->
choose the cube, columns,
rows then click tags icon and
verify whether user is able to
add tags successfully

Add the Tags in
Custom Report
Generator

UCJ10.6S.CPC-AN.G.006

PassedGo to Cisco Prime
Collaboration Assurance
Web-GUI -> Analyze ->
Custom Report
Generator->choose the cube,
columns, rows then select the
tag to be deleted and verify
whether user is able to delete
the added tags successfully

Delete the Tags in
Custom Report
Generator

UCJ10.6S.CPC-AN.G.007
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PassedGo to Cisco Prime
Collaboration Assurance
Web-GUI -> Analyze ->
Custom Report Generator
then choose the cube,
columns, rows and verify
whether user is able to
display the report in MDX
Mode

Display the report
in MDX Mode in
Custom report
generator

UCJ10.6S.CPC-AN.G.008

PassedGo to Cisco Prime
Collaboration Assurance
Web-GUI -> Analyze ->
Custom Report
Generator->choose the cube,
columns, rows then click on
show explain plan and verify
whether user is able to see
the data in Explain plan

Show explain Plan
in Custom report
generator

UCJ10.6S.CPC-AN.G.009

PassedGo to Cisco Prime
Collaboration Assurance
Web-GUI -> Analyze ->
Custom Report Generator
then click on Show MDX
icon and verify whether user
is able to show the MDX
details successfully

ShowMDX Icon in
Custom report
generator

UCJ10.6S.CPC-AN.G.010

PassedGo to Cisco Prime
Collaboration Assurance
Web-GUI -> Analyze ->
Custom Report Generator
then click on Toggle Sidebar
Icon and verify whether user
is able to use toggle sidebar
successfully

Check Toggle
sidebar in Custom
report generator

UCJ10.6S.CPC-AN.G.011

PassedGo to Cisco Prime
Collaboration Assurance
Web-GUI -> Analyze ->
Custom Report Generator
then click on Toggle Fields
Icon and verify whether user
is able to use toggle fields
successfully

Check Toggle
Fields in Custom
report generator

UCJ10.6S.CPC-AN.G.012
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PassedGo to Cisco Prime
Collaboration Assurance
Web-GUI -> Analyze ->
Custom Report Generator
then click on Drill through
on cell Icon and verify
whether user is able to
generate the cell using drill
through on cell successfully

Check Drill through
on cell in Custom
report generator

UCJ10.6S.CPC-AN.G.013

PassedGo to Cisco Prime
Collaboration Assurance
Web-GUI -> Analyze ->
Custom Report
Generator->click on Export
Drill through on cell to CSV
Icon then select any cell in
the report and verify whether
user is able to export
drill-through on cell to CSV
format successfully

Check Export Drill
through on cell to
CSV format in
Custom report
generator

UCJ10.6S.CPC-AN.G.014

PassedGo to Cisco Prime
Collaboration Assurance
Web-GUI -> Analyze ->
Conferences then choose the
duration and verify whether
user is able to see the
conference statistics data

Check conference
statistics data by
choosing the time
period filter

UCJ10.6S.CPC-AN.G.015

PassedGo to Cisco Prime
Collaboration Assurance
Web-GUI -> Analyze ->
Conferences then choose the
cluster and verify whether
user is able to see the
conference statistics data

Check conference
statistics data by
choosing cluster

UCJ10.6S.CPC-AN.G.016

PassedGo to Cisco Prime
Collaboration Assurance
Web-GUI -> Analyze ->
Conferences then choose the
conference option as P2P and
verify whether user is able to
see the conference statistics
data

Check conference
statistics data by
choosing the P2P
option

UCJ10.6S.CPC-AN.G.017
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PassedGo to Cisco Prime
Collaboration Assurance
Web-GUI -> Analyze ->
Conferences then choose the
conference option as
Multisite and verify whether
user is able to check the
conference statistics data

Check conference
statistics data by
choosing the
Multisite option

UCJ10.6S.CPC-AN.G.018

PassedGo to Cisco Prime
Collaboration Assurance
Web-GUI -> Analyze ->
CapacityAnalysisDashboard
and verify whether user is
able to add DSP Utilization
dashlet successfully

Add DSP
Utilization dashlet
in Capacity
Analysis dashboard

UCJ10.6S.CPC-AN.G.019

PassedGo to Cisco Prime
Collaboration Assurance
Web-GUI -> Analyze ->
Capacity Analysis -> DSP
Utilization then choose the
filter as Peak and verify
whether user is able to view
the Peak utilized data
successfully

Check DSP
Utilization data by
choosing the filter
Peak

UCJ10.6S.CPC-AN.G.020

PassedGo to Cisco Prime
Collaboration Assurance
Web-GUI -> Analyze ->
Capacity Analysis-> DSP
Utilization then click on
Schedule Report in DSP
Utilization dashlet and verify
whether user is able to
schedule the report for DSP
Utilization data in CSV
Format

Schedule the report
for DSP Utilization
data

UCJ10.6S.CPC-AN.G.021

PassedGo to Cisco Prime
Collaboration Assurance
Web-GUI -> Analyze ->
Capacity Analysis-> DSP
Utilization then click on
Export to CSV in DSP
Utilization dashlet and verify
whether user is able to export
the DSP Utilization data in
CSV Format

Export DSP
Utilization data to
CSV format

UCJ10.6S.CPC-AN.G.022
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PassedGo to Cisco Prime
Collaboration Assurance
Web-GUI -> Analyze ->
Capacity Analysis-> DSP
Utilization -> Detailed
Analysis Export ->
Scheduled Export and verify
whether user is able to
Schedule the report in PDF
format

Schedule Export of
DSP Utilization
data in PDF format

UCJ10.6S.CPC-AN.G.023

PassedGo to Cisco Prime
Collaboration Assurance
Web-GUI -> Analyze ->
Capacity Analysis-> DSP
Utilization -> Detailed
Analysis Export ->
Scheduled Export and verify
whether user is able to
Schedule the report in CSV
format

Schedule Export of
DSP Utilization
data in CSV format

UCJ10.6S.CPC-AN.G.024

PassedGo to Cisco Prime
Collaboration Assurance
Web-GUI -> Check detailed
view of advanced reporting
based on cluster option and
verify whether user is able to
see the detailed view of
advanced reporting based
cluster option

Detailed View of
advanced reporting
based on cluster

UCJ10.6S.CPC-AN.G.025

PassedGo to Cisco Prime
Collaboration Assurance
Web-GUI -> Administration
-> Backup and verify
whether user is able to back
up the assurance and
analytics data successfully

Backup the
assurance and
analytics data

UCJ10.6S.CPC-AN.G.026

PassedGo to Cisco Prime
Collaboration Assurance
Web-GUI -> Administration
-> Backup Management and
Rebuilding a server to restore
the data and verify whether
user is able to restore the
assurance and analytics data
successfully

Restore the
assurance and
analytics data

UCJ10.6S.CPC-AN.G.027
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PassedAfter the installation of Cisco
Prime Collaboration
Assurance&Analytics verify
whether root access is
disabled by default

Check Root access
is disabled by
default

UCJ10.6S.CPC-AN.G.028

PassedGo to Analyze -> UC system
performance -> CPU
utilization then choose the
filter time period, capability,
utilization and verify whether
user is able to see the CPU
utilization data

Check CPU
Utilization data

UCJ10.6S.CPC-AN.G.029

PassedGo to Analyze -> UC system
performance -> CPU
utilization-> choose the filter
time period, capability,
utilization then click on the
Peak/Avg/Min and verify
whether CPUUtilization data
is getting sorted from
Ascending to Descending
and vice versa

Check the data sort
in CPU Utilization

UCJ10.6S.CPC-AN.G.030

PassedGo to Analyze -> UC system
performance -> Memory
utilization then choose the
filter time period, capability,
utilization and verify whether
user is able to generate the
Memory utilization data

Check Memory
Utilization data

UCJ10.6S.CPC-AN.G.031

PassedGo to Analyze -> UC system
performance -> Memory
utilization-> choose the filter
time period, capability,
utilization then click on the
Peak/Avg/Min randomly to
check whether Memory
Utilization data is getting
sorted from Ascending to
Descending and vice versa

Check the data sort
in Memory
Utilization

UCJ10.6S.CPC-AN.G.032
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PassedGo to Analyze ->
Technology Adoption ->
Deployment Distribution by
endpoint model then choose
the filters as time period,
status configured and verify
whether user is able to check
the deployment count of
configured endpoints based
on endpoint model

Deployment count
of configured
endpoints based on
endpoint model

UCJ10.6S.CPC-AN.G.033

PassedGo to Analyze -> Asset
usage -> Least used endpoint
types then choose the filters
as time period, call count per
week and verify whether user
is able to generate the list of
least used endpoints in a
particular period of time

Least used
endpoints based on
endpoint types

UCJ10.6S.CPC-AN.G.034

PassedGo to Analyze -> Asset
usage -> Least used endpoint
types then choose the filters
as time period, call count per
week and verify whether user
is able to toggle between the
Chart mode and Grid mode.

Toggle between
Chart mode and
Grid mode for the
data extracted from
Least used
endpoints

UCJ10.6S.CPC-AN.G.035

PassedGo to Analyze -> Capacity
Analyze -> Trunk utilization
then choose the filters as time
period, average, utilization
and verify whether user is
able to generate trunk
utilization data

Check Trunk
Utilization data

UCJ10.6S.CPC-AN.G.036

PassedGo to Analyze -> Capacity
Analyze -> Trunk utilization
then choose the filters as time
period, peak, utilization then
click on Export to CSV and
Check whether user is able
to export the trunk utilization
data to CSV

Export the Trunk
utilization data to
CSV

UCJ10.6S.CPC-AN.G.037

PassedGo to Analyze -> Capacity
Analysis -> Conferencing
devices video utilization then
choose the filters as time
period, utilization and verify
whether user is able to
generate the video utilization
of conferencing devices

Check video
utilization of the
conferencing
devices

UCJ10.6S.CPC-AN.G.038
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PassedGo to Analyze -> Capacity
Analysis -> Conferencing
devices video utilization->
choose the filters as time
period, utilization then click
on Schedule report and verify
whether user is able to
generate schedule report

Schedule report of
video utilization for
conferencing
devices

UCJ10.6S.CPC-AN.G.039

PassedGo to Analyze -> Capacity
Analysis -> Conferencing
devices video utilization->
choose the filters as time
period utilization then click
on Export to CSV and verify
whether user is able to
generate CSV file of Video
utilization by conferencing
devices

Export the CSV file
of video utilization
for conferencing
devices

UCJ10.6S.CPC-AN.G.040

PassedGo to Analyze -> UC System
performance -> CPU
Utilization->choose the
filters as time period,
capability and utilization then
click on Export to CSV and
verify whether user is able to
generate CSV file of CPU
Utilization

Export the CSV file
of CPU Utilization

UCJ10.6S.CPC-AN.G.041

PassedGo to Analyze -> UC System
performance -> CPU
Utilization->choose the
filters as time period,
capability and utilization then
click on Schedule Report and
verify whether user is able to
generate schedule report

Schedule report of
CPU Utilization

UCJ10.6S.CPC-AN.G.042

PassedGo to Analyze -> UC System
performance -> Memory
Utilization->choose the
filters as time period,
capability, utilization then
click on Schedule Report and
verify whether user is able to
generate schedule report

Schedule report of
Memory Utilization

UCJ10.6S.CPC-AN.G.043
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PassedGo to Analyze -> UC System
performance -> CPU
Utilization -> choose the
filters as capability,
utilization then click on See
details and verify whether
user is able to view the CPU
utilization in detailed view

Detailed view of
CPU Utilization

UCJ10.6S.CPC-AN.G.044

PassedGo to Analyze -> UC System
performance -> Memory
Utilization -> choose the
filters as capability,
utilization then click on See
details and verify whether
user is able to view the CPU
utilization in detailed view

Detailed view of
Memory Utilization

UCJ10.6S.CPC-AN.G.045

PassedGo to Analyze ->
TechnologyAdoption -> Call
Distribution by endpoint
model then choose the filters
as time period, call
distribution and verify
whether user is able to check
call distribution based on call
volume per endpoint model

Check Call
distribution based
on call volume per
endpoint model

UCJ10.6S.CPC-AN.G.046

PassedGo to Analyze -> Service
Experience -> Service
Experience Distribution->
choose the filters as time
period, Call type ,quality as
graded calls and verify
whether user is able generate
the percentage distribution of
calls based on good call
quality

Service Experience
Distribution based
on good call quality

UCJ10.6S.CPC-AN.G.047

PassedGo to Analyze -> Service
Experience -> Service
Experience Distribution and
choose the filters as time
period, Call type, quality as
Graded and ungraded calls
and verify whether user is
able to generate the
percentage distribution of
calls based on all quality

Service Experience
Distribution based
on all call types

UCJ10.6S.CPC-AN.G.048
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PassedGo to Analyze -> Capacity
Analysis -> Busy Hour
Trunk Capacity then choose
the filters as time period, All
Trunks and verify whether
user is able to generate the
trunk or route group data that
have minimal traffic

Generate trunk or
route groups data
having minimal
traffic

UCJ10.6S.CPC-AN.G.049

Cisco Unified Communication System Upgrade / Migration Test

Upgrade Paths
CUP(Upgrade)CUC(Upgrade)CUCM(PCD)6.1(5)

8.6(1) UCS - L28.5(1) UCS - L26.1(5) (MCS)Base Release

8.6(3) - PCD8.6(2) - PCD-Interim Release

-9.X - L26.1(5) (MCS)Migration

10.5(2)10.5(2)10.5(2) (UCS)Target release

CUP(Upgrade)CUC(Upgrade)CUCM(PCD)7.1(5)

8.6(1) UCS - L28.5(1) UCS - L27.1(5) (MCS)Base Release

8.6(3) - PCD8.6(2) - PCD-Interim Release

-9.X - L27.1(5) (MCS)Migration

10.5(2)10.5(2)10.5(2) (UCS)Target Release

CUP(Upgrade)CUC(Upgrade)CUCM(PCD)8.5(1)

8.6(1) UCS - L28.5(1) UCS - L28.5(1) (MCS)Base Release

8.6(3) - PCD8.6(2) - PCD-Interim Release

-9.X - L28.5(1) (MCS)Migration

10.5(2)10.5(2)10.5(2) (UCS)Target Release

CUP(Upgrade)CUC(Upgrade)CUCM(PCD)8.6(2)

8.6(3) UCS - PCD8.6(1) (UCS) - PCD8.6(2) (UCS)Base Release
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CUP(Upgrade)CUC(Upgrade)CUCM(PCD)8.6(2)

-9.x - L2-Interim Release

10.5(2)10.5(2)10.5(2) (UCS)Target Release

CUP(Upgrade)CUC(Upgrade)CUCM(PCD)9.1(2)

9.1(1) UCS - PCD9.1(2) (UCS)-L29.1(2) (UCS)Base Release

10.5(2)10.5(2) (UCS)10.5(2) (UCS)Target Release

CUP(Upgrade)CUC(Upgrade)CUCM(PCD)10.5(1)

10.5(1) UCS - PCD10.5(1) (UCS) - PCD10.5(1) (UCS)Base Release

10.5(2)10.5(2) (UCS)10.5(2) (UCS)Target Release

Note: Before Upgrading CUCM/CUC from 9.1.2 to 10.5.2, we need to install the cop
file(ciscocm.version3-keys.cop.sgn).

Before upgrading CUC from 8.5.1 to 8.6.2, We need to install the COP file
(ciscocm.refresh_upgrade_v1.3.cop.sgn)

COP-File download link:

http://software.cisco.com/download/
release.html?mdfid=283782839&reltype=all&relind=AVAILABLE&release=COP-Files&softwareid=282204704&sortparam=2

COP-File installation Procedure:

The COP-File installation steps as follows.

• Put the COP file on an FTP or SFTP server that the server that you are upgrading can access.

• Log in to Cisco Unified Communications Operating System Administration.

• Navigate to Software Upgrades > Install/Upgrade. The Software Installation/Upgrade window displays.

• From the Source list, choose Remote File system.

• In the Directory field, enter the path to the directory that contains the patch file on the remote system.
If the upgrade file is located on a Linux or Unix server, you must enter a forward slash (/) at the beginning
of the directory path. For example, if the upgrade file is in the patches directory, you must enter /patches
. If the upgrade file is located on a Windows server, remember that you are connecting to an FTP or
SFTP server, so use the appropriate syntax. Begin the path with a forward slash and use forward slashes
throughout the path. The path must start from the FTP or SFTP root directory on the server, so you
cannot enter a Windows absolute path, which starts with a drive letter (for example, C:).

• In the Server field, enter the server name or IP address.

• In the User Name field, enter the user name on the remote server.

• In the User Password field, enter the password on the remote server.
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• Select the transfer protocol from the Transfer Protocol field.

• To use the Email Notification feature, enter your Email Destination and SMTP Server in the fields
provided.

• To continue the upgrade process, click Next.

• Choose the upgrade version that you want to install and click Next.

• In the next window, monitor the progress of the download.

• If you want to install the upgrade and automatically reboot to the upgraded software, choose Switch to
new version after upgrade. The system restarts and runs the upgraded software.

• If you want to install the upgrade and then manually switch to the upgraded software at a later time,
choose Do not switch to new version after upgrade. Click Next.

•When the installation completes, click Finish (not applicable for Refresh Upgrades).

• To restart the system and activate the upgrade, choose Settings > Version then click Switch Version.
The system restarts running the upgraded software (not applicable for Refresh Upgrades).

Upgrade 6.1.5 to 10.5.2
Upgrade 6.1.5 to 10.5.2

Target Release SetMigration Release
Set

Intermediate Release
Set1

Base ReleaseProduct /
Component

10.5.2.99832-3NILNIL6.1.5.10000-10CUCM

10.5.2.9903-120(JP)NILNIL6.1.3.3000-1(JP)CUCM Locale

10.5.2.99832-39.1.2.10000-288.6.2.10000-308.5.1.10000-26CUC

10.5.2.1-1(JP)9.1.2.1-10(JP)8.6.2.1-69(JP)8.5.1.1-92(JP)CUC Locale

10.5.1.98020-2NIL8.6.3.10000-208.6.1.10000-34CUP

10.5.1.1000-1(JP)8.6.3.1000-1(JP)8.6.1.1000-1(JP)CUP locale

10.08.58.54.0(2)SRST

NIL15.1(3)T15.1(3)T12.4(15)T4Voice Gateway
IOS

NIL7.0(6)7.0(6)2.1(4)IP Communicator

NIL8.5(6)8.5(6)1.2(4)Unified Personal
Communicator

10.5.0NILNILNILJabber for Mac

10.5.0NILNILNILJabber for iPhone

10.5.0NILNILNILJabber iPad

10.5.0NILNILNILJabber for Android
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Upgrade 6.1.5 to 10.5.2

Target Release SetMigration Release
Set

Intermediate Release
Set1

Base ReleaseProduct /
Component

10.5.0NILNILNILJabber for
Windows

DefectsStatusDescriptionTitleLogical ID

PassedVerify whether Installation of
Unified CM 6.1(5) Publisher
on MCS is completed
successfully

Installation of Unified
CM 6.1(5) Publisher on
MCS

UC1052S.UPGRADE.U.001

PassedVerify whether Installation of
Unified CM 6.1(5) Subscriber
on MCS is completed
successfully

Installation of Unified
CM6.1(5) Subscriber on
MCS

UC1052S.UPGRADE.U.002

PassedVerify whether Installation of
Cisco Unity Connection 8.5(1)
Publisher on UCS is completed
successfully

Installation of Cisco
Unity Connection 8.5(1)
Publisher on UCS

UC1052S.UPGRADE.U.003

PassedVerify whether Installation of
Cisco Unity Connection 8.5(1)
Subscriber on UCS is
completed successfully

Installation of Cisco
Unity Connection 8.5(1)
Subscriber on UCS

UC1052S.UPGRADE.U.004

PassedVerify whether Installation of
Cisco Unified Presence 8.6(1)
Publisher is completed onUCS
successfully

Installation of Cisco
Unified Presence 8.6(1)
Publisher on UCS

UC1052S.UPGRADE.U.005

PassedVerify whether Installation of
Cisco Unified Presence 8.6(1)
Subscriber is completed on
UCS successfully

Installation of Cisco
Unified Presence 8.6(1)
Subscriber on UCS

UC1052S.UPGRADE.U.006

PassedVerify the Japanese locale
installed successfully into
Unified CM Publisher

Install Japanese locale
into Unified CM 6.1(5)
Publisher

UC1052S.UPGRADE.U.007

PassedVerify whether the Unified CM
integration with Active
Directory is successful

Integrate the Unified
CM with Active
Directory

UC1052S.UPGRADE.U.018

PassedVerify whether end user can be
created in the Unified CM
6.1(5) successfully

Create end user in the
Unified CM 6.1(5)

UC1052S.UPGRADE.U.019
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PassedVerify whether SCCP/SIP IP
Phones can be registered with
Unified CM6.1(5) successfully

IP Phones should be
registered with Unified
CM 6.1(5)

UC1052S.UPGRADE.U.020

PassedVerify whether SIP Trunk can
be created in the Unified CM
6.1(5) successfully

Create SIP Trunk to
interop Site in the
Unified CM 6.1(5)
Publisher

UC1052S.UPGRADE.U.021

PassedVerify whether ICT Trunk can
be created in the Unified CM
6.1(5) successfully

Create ICT Trunk to
interop Site in the
Unified CM 6.1(5)
Publisher

UC1052S.UPGRADE.U.022

PassedVerify whether Gateway can be
registered in Unified CM from
6.1(5) Publisher successfully

Register the H.323
Gateway in the Unified
CM 6.1(5) Publisher

UC1052S.UPGRADE.U.023

CSCur58310FailedVerify whether migration from
Unified CM 6.1(5) Publisher to
Unified CM 10.5(2) via Prime
Collaboration Deployment is
successful

Migrate from Unified
CM 6.1(5) Publisher to
Unified CM 10.5(2) via
Prime Collaboration
Deployment

UC1052S.UPGRADE.U.046

Upgrade 7.1.5 to 10.5.2
Upgrade 7.1.5 to 10.5.2

Target Release SetMigration Release
Set

Intermediate Release
Set1

Base ReleaseProduct / Component

10.5.2.99832-3NILNIL7.1.5.10000-12CUCM

10.5.2.9903-120(JP)NILNIL7.1.5.1000-2(JP)CUCM Locale

10.5.2.99832-39.1.2.10000-288.6.2.10000-308.5.1.10000-26CUC

10.5.2.1-1(JP)9.1.2.1-10(JP)8.6.2.1-69(JP)8.5.1.1-92(JP)CUC Locale

10.5.1.98020-2NIL8.6.3.10000-208.6.1.10000-34CUP

10.5.1.1000-1(JP)8.6.3.1000-1(JP)8.6.1.1000-1(JP)CUP locale

10.08.58.58SRST

NIL15.1(3)T15.1(3)T15.0(1)MVoice Gateway IOS

NIL7.0.67.0.67.0.6IP Communicator

NIL8.5(6)8.5(6)7.1(2)Unified Personal
Communicator

10.5.0NILNILNILJabber for Mac

10.5.0NILNILNILJabber for iPhone

   Test Results for Cisco Unified Communications System Release 10.6 for Japan
148

Test Results Summary
Upgrade 7.1.5 to 10.5.2



Upgrade 7.1.5 to 10.5.2

Target Release SetMigration Release
Set

Intermediate Release
Set1

Base ReleaseProduct / Component

10.5.0NILNILNILJabber iPad

10.5.0NILNILNILJabber for Android

10.5.0NILNILNILJabber for Windows

DefectsStatusDescriptionTitleLogical ID

PassedVerify whether Installation of
Unified CM 7.1(5) Publisher is
completed on MCS successfully

Installation of Unified
CM 7.1(5) Publisher on
MCS

UC1052S.UPGRADE.U.082

PassedVerify whether Installation of
Unified CM 7.1(5) Subscriber is
completed on MCS successfully

Installation of Unified
CM 7.1(5) Subscriber
on MCS

UC1052S.UPGRADE.U.083

PassedVerify whether Installation of
Cisco Unity Connection 8.5(1)
Publisher is completed on UCS
successfully

Installation of Cisco
Unity Connection
8.5(1) Publisher on
UCS

UC1052S.UPGRADE.U.084

PassedVerify whether Installation of
Cisco Unity Connection 8.5(1)
Subscriber is completed on UCS
successfully

Installation of Cisco
Unity Connection
8.5(1) Subscriber on
UCS

UC1052S.UPGRADE.U.085

PassedVerify whether Installation of
Cisco Unified Presence 8.6(1)
Publisher is completed on UCS
successfully

Installation of Cisco
Unified Presence 8.6(1)
Publisher on UCS

UC1052S.UPGRADE.U.086

PassedVerify whether Installation of
Cisco Unified Presence 8.6(1)
Subscriber is completed on UCS
successfully

Installation of Cisco
Unified Presence 8.6(1)
Subscriber on UCS

UC1052S.UPGRADE.U.087

PassedVerify whether the Japanese
locale is installed successfully
into Unified CM Publisher

Install Japanese locale
into Unified CM 7.1(5)
Publisher

UC1052S.UPGRADE.U.088

PassedVerify whether SCCP/SIP IP
Phones can be registered with
Unified CM 7.1(5)

IP Phones should be
registered with Unified
CM 7.1(5)

UC1052S.UPGRADE.U.101

PassedVerify whether SIP Trunk can be
created in the Unified CM 7.1(5)
successfully

Create SIP Trunk to
interop site in the
Unified CM 7.1(5)
Publisher

UC1052S.UPGRADE.U.102
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PassedVerify whether ICT Trunk can
be created in the Unified CM
7.1(5) successfully

Create ICT Trunk to
interop site in the
Unified CM 7.1(5)
Publisher

UC1052S.UPGRADE.U.103

PassedVerify whether H.323 Gateway
can be registered in the Unified
CM from 7.1(5) Publisher
successfully

Register the H.323
Gateway in the Unified
CM 7.1(5) Publisher

UC1052S.UPGRADE.U.104

PassedVerify whether MGCP Gateway
can be registered in the Unified
CM from 7.1(5) Publisher
successfully

Register the MGCP
Gateway in the Unified
CM 7.1(5) Publisher

UC1052S.UPGRADE.U.105

Upgrade 8.5.1 to 10.5.2
Upgrade 8.5.1 to 10.5.2

Target Release SetMigration Release
Set

Intermediate
Release Set1

Base ReleaseProduct / Component

10.5.2.99832-3NILNIL8.5.1.10000-26CUCM

10.5.2.9903-120(JP)NILNIL8.5.1.2100-1(JP)CUCM Locale

10.5.2.99832-39.1.2.10000-288.6.2.10000-308.5.1.10000-26CUC

10.5.2.1-1(JP)9.1.2.1-10(JP)8.6.2.1-69(JP)8.5.1.1-92(JP)CUC Locale

10.5.1.98020-2NIL8.6.3.10000-208.6.1.10000-34CUP

10.5.1.1000-1(JP)8.6.3.1000-1(JP)8.6.1.1000-1(JP)CUP locale

10.08.58.58SRST

NIL15.1(3)T15.1(3)T15.0(1)MVoice Gateway IOS

NIL7.0.67.0.67.0.6IP Communicator

NIL8.5(6)8.5(6)7.1(2)Unified Personal
Communicator

10.5.0NILNILNILJabber for Mac

10.5.0NILNILNILJabber for iPhone

10.5.0NILNILNILJabber iPad

10.5.0NILNILNILJabber for Android

10.5.0NILNILNILJabber for Windows
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DefectsStatusDescriptionTitleLogical ID

PassedVerify whether Installation of
Unified CM 8.5(1) Publisher is
completed on MCS successfully

Installation of Unified
CM 8.5(1) Publisher on
MCS

UC1052S.UPGRADE.U.163

PassedVerify whether Installation of
Unified CM 8.5(1) Subscriber is
completed on MCS successfully

Installation of Unified
CM 8.5(1) Subscriber on
MCS

UC1052S.UPGRADE.U.164

PassedVerify whether Installation of Cisco
Unity Connection 8.5(1) Publisher
is completed on UCS successfully

Installation of Cisco
Unity Connection 8.5(1)
Publisher on UCS

UC1052S.UPGRADE.U.165

PassedVerify whether Installation of Cisco
Unity Connection 8.5(1) Subscriber
is completed on UCS successfully

Installation of Cisco
Unity Connection 8.5(1)
Subscriber on UCS

UC1052S.UPGRADE.U.166

PassedVerify whether Installation of Cisco
Unified Presence 8.6(1) Publisher
is completed on UCS successfully

Installation of Cisco
Unified Presence 8.6(1)
Publisher on UCS

UC1052S.UPGRADE.U.167

PassedVerify whether Installation of Cisco
Unified Presence 8.6(1) Subscriber
is completed on UCS successfully

Installation of Cisco
Unified Presence 8.6(1)
Subscriber on UCS

UC1052S.UPGRADE.U.168

PassedVerify whether the Japanese locale
is installed successfully into
Unified CM Publisher

Install Japanese locale
into Unified CM 8.5(1)
Publisher

UC1052S.UPGRADE.U.169

PassedVerify whether voicemail works
successfully in the Cisco Unity
Connection 8.5(1)

Voicemail should work
properly in the Cisco
Unity Connection 8.5(1)

UC1052S.UPGRADE.U.193

PassedVerify whether voice mail
messages should receive on the
Cisco IP Communicator
successfully

Voice mail messages
should receive on the
Cisco IP Communicator

UC1052S.UPGRADE.U.194

PassedVerify whether backup can be taken
from the Unified CM via Disaster
Recovery System successfully

Backup should be taken
from the Unified CM
8.5(1)

UC1052S.UPGRADE.U.196

PassedVerify whether backup can be taken
from the Cisco Unity Connection
8.5(1) Publisher as well as
Subscriber successfully

Backup should be taken
from the Cisco Unity
Connection 8.5(1)
Publisher as well as
Subscriber

UC1052S.UPGRADE.U.197

PassedVerify whether backup can be taken
from the Cisco Unified Presence
8.6(1) Publisher as well as
Subscriber successfully

Backup should be taken
from the Cisco Unified
Presence 8.6(1) Publisher
as well as Subscriber

UC1052S.UPGRADE.U.198
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Upgrade 8.6.2 to 10.5.2
Upgrade 8.6.2 to 10.5.2

Target Release SetIntermediate Release
Set1

Base ReleaseProduct / Component

10.5.2.99832-3NIL8.6.2.10000-30CUCM

10.5.2.9903-120(JP)8.6.2.1000-1(JP)CUCM Locale

10.5.2.99832-39.1.2.10000-288.6.1.10000-43CUC

10.5.2.1-1(JP)9.1.2.1-10(JP)8.6.1.1-2(JP)CUC Locale

10.5.1.98020-2NIL8.6.3.10000-20CUP

10.5.1.1000-1(JP)8.6.3.1000-1(JP)CUP Locale

10.08.6SRST

15.4(1) T15.1(4)M1Voice Gateway IOS

8.6(1)IP Communicator

8.5(1)/Windows,
7.1(2)/Mac

Unified Personal
Communicator

10.5.08.1.5Jabber for Mac

DefectsStatusDescriptionTitleLogical ID

PassedVerify whether Installation of
Unified CM 8.6(2) Publisher on
UCS is successful

Installation of Unified
CM 8.6(2) Publisher on
UCS

UC1052S.UPGRADE.U.245

PassedVerify whether Installation of
Unified CM 8.6(2) Subscriber
on UCS is successful

Installation of Unified
CM 8.6(2) Subscriber
on UCS

UC1052S.UPGRADE.U.246

PassedVerify whether Installation of
Cisco Unity Connection 8.6(1)
Publisher on UCS is successful

Installation of Cisco
Unity Connection 8.6(1)
Publisher on UCS

UC1052S.UPGRADE.U.247

PassedVerify whether Installation of
Cisco Unity Connection 8.6(1)
Subscriber on UCS is successful

Installation of Cisco
Unity Connection 8.6(1)
Subscriber on UCS

UC1052S.UPGRADE.U.248

PassedVerify whether Installation of
Cisco Unified Presence 8.6(3)
Publisher on UCS is successful

Installation of Cisco
Unified Presence 8.6(3)
Publisher on UCS

UC1052S.UPGRADE.U.249

PassedVerify whether Installation of
Cisco Unified Presence 8.6(3)
Subscriber on UCS is successful

Installation of Cisco
Unified Presence 8.6(3)
Subscriber on UCS

UC1052S.UPGRADE.U.250
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PassedVerify whether the Japanese
locale is installed into Unified
CM 8.6(2) Publisher
successfully

Install Japanese locale
into Unified CM 8.6(2)
Publisher

UC1052S.UPGRADE.U.251

PassedVerify whether basic call can be
made between the IP Phones in
Unified CM 8.6(2)

Basic call can be made
in the Unified CM
8.6(2)

UC1052S.UPGRADE.U.270

PassedVerify whether interoperability
call can be made in the Unified
CM 8.6(2) successfully

Make an
interoperability call in
the Unified CM 8.6(2)

UC1052S.UPGRADE.U.272

PassedVerify whether Personal
Directory Service is successful
in Unified CM 8.6(2)

Personal Directory
Service in the Unified
CM 8.6(2)

UC1052S.UPGRADE.U.273

PassedVerify whether Fast Dial Service
is working in Unified CM8.6(2)
successfully

Fast Dial Service in the
Unified CM 8.6(2)

UC1052S.UPGRADE.U.274

PassedVerify whether migration from
Unified CM 8.6(2) Publisher to
Unified CM 10.5(2) via Prime
Collaboration Deployment is
successful

Migrate from Unified
CM 8.6(2) Publisher to
Unified CM 10.5(2) via
Prime Collaboration
Deployment

UC1052S.UPGRADE.U.285

PassedVerify whether Upgrade of
Cisco Unity Connection
Publisher from 9.1(2) to 10.5(2)
is successful

Upgrade the Cisco
Unity Connection
Publisher from 9.1(2) to
10.5(2)

UC1052S.UPGRADE.U.287

PassedVerify whether Upgrade of
Cisco Unified Presence
Publisher from 8.6(3) to 10.5(2)
via PCD is successful

Upgrade the Cisco
Unified Presence
Publisher from 8.6(3) to
10.5(2) via Prime
Collaboration
Deployment

UC1052S.UPGRADE.U.289

PassedVerify whether the Japanese
locale is installed successfully
into Unified CM 10.5(2)
Publisher

Install Japanese locale
into Unified CM
10.5(2) Publisher

UC1052S.UPGRADE.U.291

PassedVerify the Email Notification for
Scheduled/Completed tasks in
PCD

Checking the Email
Notification of
Scheduled/Completed
tasks in PCD

UC1052.UPGRADE.U.318

PassedVerify the Email Notification for
the Error/Cancel tasks in PCD

Checking the Email
Notification of
Error/Cancel tasks in
PCD

UC1052.UPGRADE.U.319

Test Results for Cisco Unified Communications System Release 10.6 for Japan    
153

Test Results Summary
Upgrade 8.6.2 to 10.5.2



Upgrade 9.1.2 to 10.5.2
Upgrade 9.1.2 to 10.5.2

Target Release SetIntermediate Release
Set1

Base ReleaseProduct / Component

10.5.2.99832-3NIL9.1.2.10000-28CUCM

10.5.2.9903-120(JP)9.1.2.1000-1(JP)CUCM Locale

10.5.2.99832-3NIL9.1.2.10000-28CUC

10.5.2.1-1(JP)9.1.2.1-10(JP)CUC Locale

10.5.1.98020-2NIL9.1.1.10000-8CUP

10.5.1.1000-1(JP)9.1.1.1000-1(JP)CUP Locale

10.09.0.1SRST

15.4(1) T15.2(4)MVoice Gateway IOS

10.5.09.0.1Jabber for Mac

10.5.09Jabber for iPhone

10.5.01.1Jabber for iPad

10.5.09.0.1Jabber for Android

10.5.09.0.1Jabber for Windows

DefectsStatusDescriptionTitleLogical ID

PassedVerify whether Installation of
Unified CM Publisher 9.1(2) on
UCS is successful

Installation of Unified
CM Publisher 9.1(2)
on UCS

UC1052S.UPGRADE.U.321

PassedVerify whether Installation of Cisco
Unity Connection Publisher 9.1(2)
on UCS is successful

Installation of Cisco
Unity Connection
Publisher 9.1(2) on
UCS

UC1052S.UPGRADE.U.323

PassedVerify whether Installation of Cisco
Unified Presence Publisher 9.1(1)
on UCS is successful

Installation of Cisco
Unified Presence
Publisher 9.1(1) on
UCS

UC1052S.UPGRADE.U.325

PassedVerify whether the Japanese locale
installed successfully into Unified
CM Publisher

Install Japanese locale
into Unified CM
Publisher 9.1(2)

UC1052S.UPGRADE.U.327
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PassedVerify whetherMGCPGateway can
be registered in Unified CM 9.1(2)
Publisher successfully

Register MGCP
Gateway in Unified
CM 9.1(2) Publisher

UC1052S.UPGRADE.U.345

PassedVerify whether voicemail works
properly in the Cisco Unity
Connection 9.1(2)

Voicemail should
work properly in the
Cisco Unity
Connection 9.1(2)

UC1052S.UPGRADE.U.352

PassedVerify whether backup can be taken
from Unified CM via Disaster
Recovery System successfully

Backup should be
taken from Unified
CM 9.1(2)

UC1052S.UPGRADE.U.355

PassedVerify whether migration from
Unified CM 9.1(2) Publisher to
Unified CM 10.5(2) via Prime
Collaboration Deployment
successfully

Migrate from Unified
CM 9.1(2) Publisher
to Unified CM 10.5(2)
via Prime
Collaboration
Deployment

UC1052S.UPGRADE.U.358

PassedVerify whether Upgrade of Cisco
Unity Connection Publisher from
9.1(2) to 10.5(2) is successful

Upgrade the Cisco
Unity Connection
Publisher from 9.1(2)
to 10.5(2)

UC1052S.UPGRADE.U.360

PassedVerify whether Upgrade of Cisco
Unified Presence Publisher from
9.1(1) to 10.5(2) via PCD is
successful

Upgrade the Cisco
Unified Presence
Publisher from 9.1(1)
to 10.5(2) via PCD

UC1052S.UPGRADE.U.362

PassedVerify whether the Japanese locale
installed successfully into Unified
CM 10.5(2) Publisher

Install Japanese locale
into Unified CM
10.5(2) Publisher

UC1052S.UPGRADE.U.364

PassedVerify whether LDAP synchronized
user is present in the Unified CM
after migration has been done
successfully

LDAP synchronized
user should be in the
Unified CM after
migration has done

UC1052S.UPGRADE.U.375

PassedVerify whether SCCP/SIP IP Phones
can be registered with Unified CM
after migration has been done
successfully

IP Phones should be
registered with
Unified CM after
migration has done

UC1052S.UPGRADE.U.376

PassedVerify the H.323 Gateway
Registration after the migration of
Unified CM from 9.1(2) to 10.5(2)
successfully

H.323 Gateway
Registration status
after migration has
done

UC1052S.UPGRADE.U.377

PassedVerify the MGCP Gateway
Registration after the migration of
Unified CM from 9.1(2) to 10.5(2)
successfully

MGCP Gateway
Registration status
after migration has
done

UC1052S.UPGRADE.U.378
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PassedVerify whether SIP Trunk should be
replicated in the Unified CM after
migration has been done
successfully

SIP Trunk should be
replicated in Unified
CM after migration
has done

UC1052S.UPGRADE.U.379

PassedVerify whether Fast Dial Service is
successful after migration of Unified
CM from 9.1(2) to 10.5(2)

Fast Dial Service after
migrating the Unified
CM from 9.1(2) to
10.5(2)

UC1052S.UPGRADE.U.384

PassedVerify whether Voice mail works
properly after upgrading the Cisco
Unity Connection from 9.1(2) to
10.5(2) successfully

Voice mail should
work after upgrading
the Cisco Unity
Connection from
9.1(2) to 10.5(2)

UC1052S.UPGRADE.U.385

PassedVerify whether Instant Messaging
on Jabber forWindowsworking fine
after upgrade from 9.1(1) to 10.5(2)
successfully

Check the Instant
Messaging on Jabber
for Windows after
upgrade from 9.1(1) to
10.5(2)

UC1052S.UPGRADE.U.386

PassedVerify whether basic call on Jabber
for Windows working fine after
upgrade from 9.1(1) to 10.5(2)
successfully

Make a basic call on
Jabber for Windows
after upgrade from
9.1.(1) to 10.5(2)

UC1052S.UPGRADE.U.387

Upgrade 10.5.1 to 10.5.2
Upgrade 10.5.1 to 10.5.2

Target Release SetIntermediate Release Set1Base ReleaseProduct / Component

10.5.2.99832-3NIL10.5.1.10000-7CUCM

10.5.2.9903-120(JP)10.5.1.1000-1(JP)CUCM Locale

10.5.2.99832-3NIL10.5.1.10000-7CUC

10.5.2.1-1(JP)10.5.0.1-1(JP)CUC Locale

10.5.1.98020-2NIL10.5.1.10000-9CUP

10.5.1.1000-1(JP)10.5.1.1000-1(JP)CUP Locale

10.09.0.1SRST

15.4(1) T15.2(4)MVoice Gateway IOS

10.5.010.5Jabber for Mac

10.5.010.5Jabber for iPhone

10.5.01.1Jabber for iPad
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Upgrade 10.5.1 to 10.5.2

Target Release SetIntermediate Release Set1Base ReleaseProduct / Component

10.5.010.5Jabber for Android

10.5.010.5Jabber for Windows

DefectsStatusDescriptionTitleLogical ID

PassedVerify whether Installation of
Unified CM Publisher 10.5(1) on
UCS is successful

Installation of Unified
CM Publisher 10.5(1)
on UCS

UC1052S.UPGRADE.U.397

PassedVerify whether Installation of
Cisco Unity Connection Publisher
10.5(1) on UCS is successful

Installation of Cisco
Unity Connection
Publisher 10.5(1) on
UCS

UC1052S.UPGRADE.U.399

PassedVerify whether Installation of
Cisco Unified Presence Publisher
10.5(1) on UCS is successful

Installation of Cisco
Unified Presence
Publisher 10.5(1) on
UCS

UC1052S.UPGRADE.U.401

PassedVerify whether the Japanese locale
installed successfully into Unified
CM Publisher

Install Japanese locale
into Unified CM
Publisher 10.5(1)

UC1052S.UPGRADE.U.403

PassedVerify whether SCCP/SIP IP
Phones can be registered with
Unified CM 10.5(1) successfully

IP Phones should be
registered with Unified
CM 10.5(1)

UC1052S.UPGRADE.U.416

PassedVerify whether SIP Trunk can be
created in the Unified CM 10.5(1)
successfully

Create SIP Trunk to
Interop site in the
Unified CM 10.5(1)
Publisher

UC1052S.UPGRADE.U.417

PassedVerify whether ICT Trunk can be
created in the Unified CM 10.5(1)
successfully

Create ICT Trunk to
Interop site in the
Unified CM 10.5(1)
Publisher

UC1052S.UPGRADE.U.418

PassedVerify whether Gateway can be
registered in the Unified CM
10.5(1) Publisher successfully

Register H.323Gateway
in the Unified CM
10.5(1) Publisher

UC1052S.UPGRADE.U.419

PassedVerify whether Voice mail
messages should receive on the
Cisco Jabber successfully

Voice mail messages
should receive on the
Cisco Jabber

UC1052S.UPGRADE.U.428

PassedVerify whether Instant Messaging
on Cisco Jabber is working
successfully

Check the Instant
Messaging on Cisco
Jabber

UC1052S.UPGRADE.U.429
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PassedVerify whether backup can be
taken from the Unified CM via
Disaster Recovery System
successfully

Backup should be taken
from the Unified CM
10.5(1)

UC1052S.UPGRADE.U.430

PassedVerify whether migration from
Unified CM 10.5(1) Publisher to
Unified CM 10.5(2) via Prime
Collaboration Deployment
successfully

Migrate from Unified
CM 10.5(1) Publisher to
Unified CM 10.5(2) via
Prime Collaboration
Deployment

UC1052S.UPGRADE.U.433

PassedVerify whether Upgrade of Cisco
Unity Connection Publisher from
10.5(1) to 10.5(2) via PCD is
successful

Upgrade the CiscoUnity
Connection Publisher
from 10.5(1) to 10.5(2)
via PCD

UC1052S.UPGRADE.U.435

PassedVerify whether Upgrade of Cisco
Unified Presence Publisher from
10.5(1) to 10.5(2) via PCD is
successful

Upgrade the Cisco
Unified Presence
Publisher from 10.5(1)
to 10.5(2) via PCD

UC1052S.UPGRADE.U.437

PassedVerify whether the Japanese locale
installed successfully into Unified
CM 10.5(2) Publisher

Install Japanese locale
into Unified CM10.5(2)
Publisher

UC1052S.UPGRADE.U.439

PassedVerify whether LDAP
synchronized user is present in the
Unified CM after the migration

LDAP synchronized
user should be in the
Unified CM after
migration

UC1052S.UPGRADE.U.450

PassedVerify whether SCCP/SIP IP
Phones can be registered with
Unified CM after the migration

IP Phones should be
registered with Unified
CM after migration

UC1052S.UPGRADE.U.451

PassedVerify the Email Notification for
Scheduled/Completed tasks in
PCD

Checking the Email
Notification of
Scheduled/Completed
tasks in PCD

UC1052S.UPGRADE.U.466

PassedVerify the Email Notification for
the Error/Cancel tasks in PCD

Checking the Email
Notification of
Error/Cancel tasks in
PCD

UC1052S.UPGRADE.U.467

Regression
Cisco Unified IP Phone Regression:

Regression Execution - Unified IP Phone Features

Failed %FailedPassed W/X
%

PassedW/XPassed %PassedTotal test
cases

Features
tested
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0%00%0100%99Auto Pickup

0%00%0100%33Barge

0%00%0100%11Call Park

0%00%0100%1515Call Pickup

0%00%0100%33Call Transfer

0%00%0100%11CFWD Busy

0%00%0100%22CFWD No
Answer

0%00%0100%77CFWD All

0%00%0100%77Conference

0%00%0100%22DND

0%00%0100%22Hold

0%00%0100%1818Hold and
Resume

0%00%0100%55Hold
Reversion

0%00%0100%66Make Call

0%00%0100%11Meet-Me

0%00%0100%44Opickup

0%00%0100%1111Park
Reversion

0%00%0100%11Privacy on
Hold

0%00%0100%55Redial

0%00%0100%11Shared Line

0%00%0100%104104Total

Cisco Jabber for Android Regression:

Regression Execution - Cisco Jabber for Android Features

Failed %FailedPassed W/X
%

Passed
W/X

Passed %PassedTotal test
cases

Features
tested

0%00%0100%11Alerting
Name

0%00%0100%44Make Call
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0%00%0100%11Secure Call

0%00%0100%1010User Interface

0%00%0100%1616Total

Related Documentation
Cisco IP Phone 8841, 8851, and 8861

User Guide:

http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/cuipph/8841_8851_8861/10_5/english/user_guide/
P881_BK_U33163AA_00_userguide-8841-8851-8861-10_0.html

Administration Guide:

http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/cuipph/8841_8851_8861/10_5/english/admin_guide/
P881_BK_AA5170E9_00_adminguide-8841-8851-8861-10_0.html

Release Note:

http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/cuipph/8841_8851_8861/firmware/10-2-1/english/
ReleaseNotes/P881_BK_R7A58C22_00_rn-10_2_1-8841-8851-8861/P881_BK_R7A58C22_00_rn-10_2_
1-8841-8851-8861_chapter_00.html

Cisco Unified Survivable Remote Site Telephony

Administration Guide:

http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/cusrst/admin/sccp_sip_srst/configuration/guide/
SCCP_and_SIP_SRST_Admin_Guide/srst_roadmap.html#pgfId-1152146

Cisco ATA 190 Analog Telephone Adapter

Administration Guide:

http://www.cisco.com/c/dam/en/us/td/docs/voice_ip_comm/cata/190/1_0/english/administration/guide/sip/
ATA190_AG.pdf

Release Note:

http://www.cisco.com/c/dam/en/us/td/docs/voice_ip_comm/cata/190/1_0/english/release/notes/ATA190_
RN.pdf

Cisco TelePresence Video Communication Server

Installation Guide:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/vcs/install_guide/
Cisco-VCS-Virtual-Machine-Install-Guide-X8-2.pdf

Release Note:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/vcs/release_note/
Cisco-VCS-Release-Note-X8-2-2.pdf
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http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/cuipph/8841_8851_8861/10_5/english/user_guide/P881_BK_U33163AA_00_userguide-8841-8851-8861-10_0.html
http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/cuipph/8841_8851_8861/10_5/english/user_guide/P881_BK_U33163AA_00_userguide-8841-8851-8861-10_0.html
http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/cuipph/8841_8851_8861/10_5/english/admin_guide/P881_BK_AA5170E9_00_adminguide-8841-8851-8861-10_0.html
http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/cuipph/8841_8851_8861/10_5/english/admin_guide/P881_BK_AA5170E9_00_adminguide-8841-8851-8861-10_0.html
http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/cuipph/8841_8851_8861/firmware/10-2-1/english/ReleaseNotes/P881_BK_R7A58C22_00_rn-10_2_1-8841-8851-8861/P881_BK_R7A58C22_00_rn-10_2_1-8841-8851-8861_chapter_00.html
http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/cuipph/8841_8851_8861/firmware/10-2-1/english/ReleaseNotes/P881_BK_R7A58C22_00_rn-10_2_1-8841-8851-8861/P881_BK_R7A58C22_00_rn-10_2_1-8841-8851-8861_chapter_00.html
http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/cuipph/8841_8851_8861/firmware/10-2-1/english/ReleaseNotes/P881_BK_R7A58C22_00_rn-10_2_1-8841-8851-8861/P881_BK_R7A58C22_00_rn-10_2_1-8841-8851-8861_chapter_00.html
http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/cusrst/admin/sccp_sip_srst/configuration/guide/SCCP_and_SIP_SRST_Admin_Guide/srst_roadmap.html#pgfId-1152146
http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/cusrst/admin/sccp_sip_srst/configuration/guide/SCCP_and_SIP_SRST_Admin_Guide/srst_roadmap.html#pgfId-1152146
http://www.cisco.com/c/dam/en/us/td/docs/voice_ip_comm/cata/190/1_0/english/administration/guide/sip/ATA190_AG.pdf
http://www.cisco.com/c/dam/en/us/td/docs/voice_ip_comm/cata/190/1_0/english/administration/guide/sip/ATA190_AG.pdf
http://www.cisco.com/c/dam/en/us/td/docs/voice_ip_comm/cata/190/1_0/english/release/notes/ATA190_RN.pdf
http://www.cisco.com/c/dam/en/us/td/docs/voice_ip_comm/cata/190/1_0/english/release/notes/ATA190_RN.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/vcs/install_guide/Cisco-VCS-Virtual-Machine-Install-Guide-X8-2.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/vcs/install_guide/Cisco-VCS-Virtual-Machine-Install-Guide-X8-2.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/vcs/release_note/Cisco-VCS-Release-Note-X8-2-2.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/vcs/release_note/Cisco-VCS-Release-Note-X8-2-2.pdf


Configuration Guide:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/vcs/config_guide/X8-2/
Cisco-VCS-Basic-Configuration-Single-VCS-Control-Deployment-Guide-X8-2.pdf

Collaboration EDGE Configuration Guide:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/vcs/config_guide/X8-2/
Mobile-Remote-Access-via-VCS-Deployment-Guide-X8-2.pdf

Cisco Telepresence Management Suite

Administration Guide:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/tms/admin_guide/
Cisco-TMS-Admin-Guide-14-5.pdf

Installation Guide:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/tms/install_guide/
Cisco-TMS-install-guide-14-5.pdf

Release Note:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/tms/release_note/
Cisco-TMS-release-notes-14-5.pdf

Cisco TelePresence System 500-32 & Cisco TelePresence TX9000

Release Note:

http://www.cisco.com/c/en/us/td/docs/telepresence/tx_sw/6_0/release/notes/tx_sw_6_0_release_notes.html

Administration Guide:

http://www.cisco.com/c/en/us/td/docs/telepresence/tx_sw/6_0/admin/guide/tx_6_0_admin_guide.pdf

Cisco TelePresence SX80 Codec

Administration Guide:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/sx-series/tc7/administration-guide/
sx80-administrator-guide-tc72.pdf

Installation Guide:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/sx-series/installation-guide/
sx80-installation-sheet.pdf

API Reference Guide:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/sx-series/tc7/api-reference-guide/
sx80-api-reference-guide-tc71.pdf

Cisco TelePresence SX20 QuickSet

Administration Guide:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/quick-set-sx20/tc7/administration-guide/
sx20-quickset-administrator-guide-tc72.pdf

API Reference Guide:
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http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/vcs/config_guide/X8-2/Cisco-VCS-Basic-Configuration-Single-VCS-Control-Deployment-Guide-X8-2.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/vcs/config_guide/X8-2/Cisco-VCS-Basic-Configuration-Single-VCS-Control-Deployment-Guide-X8-2.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/vcs/config_guide/X8-2/Mobile-Remote-Access-via-VCS-Deployment-Guide-X8-2.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/vcs/config_guide/X8-2/Mobile-Remote-Access-via-VCS-Deployment-Guide-X8-2.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/tms/admin_guide/Cisco-TMS-Admin-Guide-14-5.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/tms/admin_guide/Cisco-TMS-Admin-Guide-14-5.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/tms/install_guide/Cisco-TMS-install-guide-14-5.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/tms/install_guide/Cisco-TMS-install-guide-14-5.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/tms/release_note/Cisco-TMS-release-notes-14-5.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/tms/release_note/Cisco-TMS-release-notes-14-5.pdf
http://www.cisco.com/c/en/us/td/docs/telepresence/tx_sw/6_0/release/notes/tx_sw_6_0_release_notes.html
http://www.cisco.com/c/en/us/td/docs/telepresence/tx_sw/6_0/admin/guide/tx_6_0_admin_guide.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/sx-series/tc7/administration-guide/sx80-administrator-guide-tc72.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/sx-series/tc7/administration-guide/sx80-administrator-guide-tc72.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/sx-series/installation-guide/sx80-installation-sheet.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/sx-series/installation-guide/sx80-installation-sheet.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/sx-series/tc7/api-reference-guide/sx80-api-reference-guide-tc71.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/sx-series/tc7/api-reference-guide/sx80-api-reference-guide-tc71.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/quick-set-sx20/tc7/administration-guide/sx20-quickset-administrator-guide-tc72.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/quick-set-sx20/tc7/administration-guide/sx20-quickset-administrator-guide-tc72.pdf


http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/quick-set-sx20/tc7/api-reference-guide/
codec-sx20-api-reference-guide-tc72.pdf?mdfid=284091229

Cisco TelePresence SX10 QuickSet

Administration Guide:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/sx-series/tc7/administration-guide/sx10-administrator-guide-tc72.pdf

User Guide:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/sx-series/tc7/user-guide/trc6-sx10-user-guide-tc72.pdf

Cisco TelePresence System EX series

Administration Guide:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/ex-series/tc7/administration-guide/ex-series-administrator-guide-tc72.pdf

Cisco TelePresence System C/SX/EX/MX/Profile Series

Software Release Note TC7:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/software/tc7/release_notes/tc-software-release-notes-tc7.pdf

Getting Started Guide::

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/ex-series/tc7/getting-started-guide/video-systems-getting-started-guide-tc72.pdf

Cisco TelePresence System Integrator Package C90

Administration Guide:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/codec-c-series/tc7/administration-guide/
profile-c90-and-codec-c90-administrator-guide-tc72.pdf

API Reference Guide:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/codec-c-series/tc7/api-reference-guide/
codec-c90-api-reference-guide-tc72.pdf?mdfid=283688198

Cisco TelePresence MCU

Administration Guide:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/mcu/admin_guide/
cisco-telepresence-mcu-5300-series-printable-online-help-4-5.pdf

Release Note:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/mcu/release_note/
Cisco-TelePresence-MCU-Software-release-notes-4-5-1-45.pdf

Cisco Telepresence Conductor

Administration Guide:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/conductor/admin_guide/
TelePresence-Conductor-Admin-Guide-XC2-4.pdf

Installation Guide:
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http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/quick-set-sx20/tc7/api-reference-guide/codec-sx20-api-reference-guide-tc72.pdf?mdfid=284091229
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/quick-set-sx20/tc7/api-reference-guide/codec-sx20-api-reference-guide-tc72.pdf?mdfid=284091229
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/sx-series/tc7/administration-guide/sx10-administrator-guide-tc72.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/sx-series/tc7/user-guide/trc6-sx10-user-guide-tc72.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/ex-series/tc7/administration-guide/ex-series-administrator-guide-tc72.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/software/tc7/release_notes/tc-software-release-notes-tc7.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/ex-series/tc7/getting-started-guide/video-systems-getting-started-guide-tc72.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/codec-c-series/tc7/administration-guide/profile-c90-and-codec-c90-administrator-guide-tc72.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/codec-c-series/tc7/administration-guide/profile-c90-and-codec-c90-administrator-guide-tc72.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/codec-c-series/tc7/api-reference-guide/codec-c90-api-reference-guide-tc72.pdf?mdfid=283688198
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/codec-c-series/tc7/api-reference-guide/codec-c90-api-reference-guide-tc72.pdf?mdfid=283688198
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/mcu/admin_guide/cisco-telepresence-mcu-5300-series-printable-online-help-4-5.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/mcu/admin_guide/cisco-telepresence-mcu-5300-series-printable-online-help-4-5.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/mcu/release_note/Cisco-TelePresence-MCU-Software-release-notes-4-5-1-45.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/mcu/release_note/Cisco-TelePresence-MCU-Software-release-notes-4-5-1-45.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/conductor/admin_guide/TelePresence-Conductor-Admin-Guide-XC2-4.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/conductor/admin_guide/TelePresence-Conductor-Admin-Guide-XC2-4.pdf


http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/conductor/install_guide/
TelePresence-Conductor-Virtual-Machine-Install-Guide-XC2-4.pdf

Release Note:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/conductor/release_note/
TelePresence-Conductor-Release-Notes-XC2-4-1.pdf

Cisco Jabber Guest

Administration Guide:

http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/jabber/Guest/10_0/ag/
JABC_BK_J76828F6_00_jabberc-admin-and-api-guide/JABC_BK_J76828F6_00_
jabberc-admin-and-api-guide_chapter_01.html

Installation Guide:

http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/jabber/Guest/10_0/icg/
JABC_BK_J0FC634A_00_jabberc-installation-and-configuration-guide/JABC_BK_J0FC634A_00_
jabberc-installation-and-configuration-guide_chapter_010.html

Cisco TelePresence Server

Release Note:

www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/ts/release_note/
Cisco-TelePresence-Server-Software-Release-Notes-4-0-2-8.pdf

Installation Guide:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/ts/install_guide/Cisco_TelePresence_
Server_7010_Installation_Guide.pdf

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/ts/install_guide/
Cisco-TelePresence-Server-on-Virtual-Machine-Install-Guide-4-0-2-8.pdf

Deployment Guide:

www.cisco.com/en/US/docs/telepresence/infrastructure/ts/deployment_guide/Cisco_TelePresence_Server_
Deployment_Guide.pdf

Cisco Prime Collaboration Provisioning Guide - Standard and Advanced, 10.6

http://www-author.cisco.com/c/en/us/td/docs/net_mgmt/prime/collaboration/10-6/provisioning/Cisco_Prime_
Collaboration_Provisioning_Guide_10_6.pdf

Cisco Prime Collaboration Assurance Advanced Guide 10.6

http://www-author.cisco.com/c/en/us/td/docs/net_mgmt/prime/collaboration/10-6/assurance/advanced/guide/
Cisco_Prime_Collaboration_Assurance_Guide_Advanced_10_6.pdf

Cisco Prime Collaboration Analytics Guide 10.6

http://www-author.cisco.com/c/en/us/td/docs/net_mgmt/prime/collaboration/10-6/analytics/guide/Cisco_
Prime_Collaboration_Analytics_Guide_10-6.pdf

Release Notes for Cisco Prime collaboration Deployment 10.5(1)

http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/cucm/rel_notes/10_5_1/
CUCM_BK_P139675A_00_pcd-rns-1051/CUCM_BK_P139675A_00_pcd-rns-1051_chapter_01.html

Cisco Prime Collaboration Deployment Administration Guide Release 10.5(1)
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http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/cucm/pcdadmin/10_5_1/
CUCM_BK_U35347D2_00_pcd-administration-guide-1051/CUCM_BK_U35347D2_00_
ucmap-administration-guide-1051_chapter_01.html

Troubleshooting Cisco Prime Collaboration Deployment

http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/cucm/pcdadmin/10_5_1/
CUCM_BK_U35347D2_00_pcd-administration-guide-1051/CUCM_BK_U35347D2_00_
ucmap-administration-guide-1051_chapter_0100.html

Release Notes for Cisco Unified Communications Manager Release 10.5(1)

http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/cucm/rel_notes/10_5_1/
CUCM_BK_CE15D2A0_00_cucm-release-notes-1051/CUCM_BK_CE15D2A0_00_cucm-release-notes-1051_
chapter_00.html
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